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Important!
Please read this licence agreement before opening the disk 
seal!

Copyright
This manual and software described herein are copyrighted © 
1992–1999 by Emagic Soft- und Hardware GmbH (EMAGIC) 
with all rights reserved. Under copyright laws this manual, 
protection-key and software may not be duplicated in whole or 
in part without the written consent of EMAGIC, except in the 
normal use of the software or to make a back-up copy of the 
original disk.

Limited Warranty
Except to the extent prohibited by applicable law, all implied 
warranties made by EMAGIC in connection with this manual 
and software are limited in duration to ninety (90) days or mini-
mum guarantee period in your state or country from the date of 
original purchase, and no warranties, whether express or 
implied, shall apply to this product after said period. This 
warranty is not transferable – it applies only to the original 
purchaser of the software.

EMAGIC makes no warranty, either express or implied, with 
respect to this software, its quality, performance, merchantabil-
ity or fitness for a particular purpose. As a result, this software is 
sold »as is«, and you, the purchaser, are assuming the entire risk 
as to quality and performance.

In no event will EMAGIC be liable for direct, indirect, special, 
incidental or consequential damages resulting from any defect 
in the software or documentation. Some states do not allow the 
exclusion or limitation of implied warranties or liability for inci-
dental or consequential damages, so the above limitation or 

exclusion may not apply to you.



Licence Agreement
Carefully read all the terms and conditions of this licence 
agreement prior to using this package. Use of all or any portion 
of this package indicates your agreement to the following terms 
and conditions.

EMAGIC grants you, the purchaser, a non-exclusive license to 
use the software in this package (the »software«), under the 
terms and conditions stated in this agreement.

You may:

1. use the software on a single machine.

2. make one copy of the software solely for back-up purposes.

You may not:

1. make copies of the user manual or the software in whole or
in part except as expressly provided for in this agreement.

2. make alterations or modifications to the software or any
copy, or otherwise attempt to discover the source code of
the software.

3. sub-license, lease, lend, rent or grant other rights in all or
any copy to others.

4. make verbal or media translation of the user manual.

5. make telecommunication data transmission of the soft-
ware.

Term

This agreement is effective until terminated. You may termi-
nate it at any time by destroying the software together with all 
copies in any form. It will also terminate if you fail to comply 
with any term or condition in this agreement.



Owner´s Manual 
Authors: Peter Gorges, Jan-Friedrich Conrad, Ronald 

Bias, Thorsten Adam

Translation: Bernie Hurst, Matt Bell, Ruthven Martinus

Editing: Jeff Bohnhoff, Robert Hunt, Joel Heppting, 
David Dvorin, David Freeman, Uwe G. Hoenig

Layout: Fabian Schmid, Ronald Bias, Thorsten Adam

© 1999 by E
Address: Emagic Inc.

13348 Grass Valley Ave.
Building C, Suite 100
Grass Valley, CA 95945
USA

Tel: +530 477 1051

Fax: +530 477 1052

Net: http://www.emagic.de

eMail: info@emagicusa.com
All Rights Reserved. All Trademarks are the property of their respective owners.





1

2

3

4

5

6

7

8

9

10

11

12

13

14

Gl

Ix

17

18

Gl

Ix
Chapter 1 Features

Chapter 2 Getting Started

Chapter 3 Tutorial

Chapter 4 Using MicroLogic Fun

Chapter 5 Transport Functions

Chapter 6 Arrange Window

Chapter 7 Mixer

Chapter 8 The Event List

Chapter 9 The Matrix Editor

Chapter 10 The Score Editor

Chapter 11 Wave Player

Chapter 12 Video and MIDI Files

Chapter 13 Use of Key Commands and Mouse, Settings

Chapter 14 Menu Reference

Glossary

Index
Owner’s Manual 
Version 4.0 – English 7

C



Emagic
MicroLogic Fun 8



1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

Gl

Ix
Table of Contents

Chapter 1 Features

1.1 Multitrack Recorder . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
1.2 Flexible Input . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
1.3 Automatic Notation . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
1.4 GM Supported . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
1.5 Wave Player  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  18
1.6 Multimedia  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
1.7 Graphical Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
1.8 About this Manual . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20

The Tutorial Chapter  . . . . . . . . . . . . . . . . . . . . . . . . . . 20

Chapter 2 Getting Started

2.1 Windows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
Getting Started With MicroLogic Fun . . . . . . . . . . . . . . 21

Selecting the MIDI Out Port in the Program . . . . . . 21
Testing the MIDI Connection . . . . . . . . . . . . . . . . . 22
Test the MIDI Out  . . . . . . . . . . . . . . . . . . . . . . . . . 22
MicroLogic Fun and Multitasking . . . . . . . . . . . . . . 23
Launching MicroLogic Fun . . . . . . . . . . . . . . . . . . . 23
Launch MicroLogic Fun Automatically . . . . . . . . . . 24

2.2 Macintosh  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
Launching MicroLogic Fun . . . . . . . . . . . . . . . . . . . 24
Choose MIDI Connection  . . . . . . . . . . . . . . . . . . . 24
MIDI Time Piece  . . . . . . . . . . . . . . . . . . . . . . . . . . 25
Testing the MIDI Connection . . . . . . . . . . . . . . . . . 26
Test the MIDI-Out . . . . . . . . . . . . . . . . . . . . . . . . . 26
Autoload Song  . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
Start MicroLogic Fun automatically  . . . . . . . . . . . . 27

2.3 MacOS/Win: Differences  . . . . . . . . . . . . . . . . . . . . . . . 28
Keyboard and Mouse  . . . . . . . . . . . . . . . . . . . . . . 28
Key Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
Exchanging Songs Between Mac and PC . . . . . . . . 29
Menu Bars  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

Chapter 3 Tutorial
5
Owner’s Manual 
Version 4.0 – English 

B

C

3.1 Adapting the Tutorial Song  . . . . . . . . . . . . . . . . . . . . . 31
Load the Tutorial Song  . . . . . . . . . . . . . . . . . . . . . 31
General MIDI Tone Generator . . . . . . . . . . . . . . . . 32



Table of Contents

Non GM, Multi-Timbral Tone Generators  . . . . . . . 32
Sounds and MIDI Channels . . . . . . . . . . . . . . . . . . 33
Drum Kit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

Starting the Song . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
3.2 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
3.3 Tracks and Sequences  . . . . . . . . . . . . . . . . . . . . . . . . . 35

Information Track and Instruments . . . . . . . . . . . . . . . . 36
3.4 Transport Functions  . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

Start Song Positions  . . . . . . . . . . . . . . . . . . . . . . . 37
Display Current Song Position . . . . . . . . . . . . . . . . 38
Zoom a Window Excerpt . . . . . . . . . . . . . . . . . . . . 38
Cycle Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
Selection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
Quantize . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
Loops  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
The Toolbox  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
Mouse Arrow  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
Undo  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
Copies of Sequences . . . . . . . . . . . . . . . . . . . . . . . 43
Scissors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44
Transposition  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44
Your First Recording  . . . . . . . . . . . . . . . . . . . . . . . 45
Let’s Record! . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
Saving the Song  . . . . . . . . . . . . . . . . . . . . . . . . . . 47

3.5 Event List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
3.6 Matrix Editor  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
3.7 Score Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51

Display Parameter Box . . . . . . . . . . . . . . . . . . . . . . 52
Style  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
Text  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

Print . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
Now It’s Your Turn … . . . . . . . . . . . . . . . . . . . . . . 53

Chapter 4 Using MicroLogic Fun

4.1 Conventions of this Manual . . . . . . . . . . . . . . . . . . . . . 55
4.2 The Mouse . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56
6
Emagic
MicroLogic Fun 

Basic functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56
Mouse Input  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56

Checkboxes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56
Pull-down Menus  . . . . . . . . . . . . . . . . . . . . . . . . . 56



1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

Gl

Ix
Table of Contents

Mouse as Slider . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
Using the Mouse for In/Decrementing . . . . . . . . . . 57
Numerical Input  . . . . . . . . . . . . . . . . . . . . . . . . . . 57
Text Input . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58

Tools and the Toolbox  . . . . . . . . . . . . . . . . . . . . . . . . . 59
Effective Range of the Tools  . . . . . . . . . . . . . . . . . 59
Selecting Tools  . . . . . . . . . . . . . . . . . . . . . . . . . . . 59
Info Line  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59
The Tools  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60

4.3 Window Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62
Working with Windows . . . . . . . . . . . . . . . . . . . . . . . . 62

Opening and closing Windows  . . . . . . . . . . . . . . . 62
Setting Window Size . . . . . . . . . . . . . . . . . . . . . . . 63
Selecting the Working Area . . . . . . . . . . . . . . . . . . 63
X/Y Element  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64
Page Scrolling . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64
Zooming . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64
Zooming Selectively . . . . . . . . . . . . . . . . . . . . . . . . 64
Adjusting the Size of the Window Elements  . . . . . 65
Menus  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
Key Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . 66
Menu Options with “…” in their Title . . . . . . . . . . 66
Dialog Boxes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66
Window Types  . . . . . . . . . . . . . . . . . . . . . . . . . . . 66

Relationships Between Windows  . . . . . . . . . . . . . . . . . 67
Catch  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
Link . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67

4.4 Selection Techniques  . . . . . . . . . . . . . . . . . . . . . . . . . . 68
Selecting Individual Objects . . . . . . . . . . . . . . . . . . 68
Selecting Several Objects . . . . . . . . . . . . . . . . . . . . 68

4.5 Edit Operations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69
Undo  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69

The Clipboard  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
Cut . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
Copy . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
Paste . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
Clear . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71

4.6 General Functions of the Editors  . . . . . . . . . . . . . . . . . 71
7
Owner’s Manual 
Version 4.0 – English 

B

C

Control Output via MIDI  . . . . . . . . . . . . . . . . . . . . 71
Automatic Scroll Functions  . . . . . . . . . . . . . . . . . . 71
Deleting Events . . . . . . . . . . . . . . . . . . . . . . . . . . . 71



Table of Contents

Changing Display Levels in Score . . . . . . . . . . . . . . 72
4.7 Key Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72

Special Keys  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73
Key Commands Window . . . . . . . . . . . . . . . . . . . . . . . 73

Assigning a Function to a Key . . . . . . . . . . . . . . . . 74
Deleting Assignments  . . . . . . . . . . . . . . . . . . . . . . 74
Checking the Function of a Key . . . . . . . . . . . . . . . 74
Filtering the Display . . . . . . . . . . . . . . . . . . . . . . . . 75
Finding Key Commands  . . . . . . . . . . . . . . . . . . . . 75

4.8 Song Administration  . . . . . . . . . . . . . . . . . . . . . . . . . . 75
New Song  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76

Autoload Song  . . . . . . . . . . . . . . . . . . . . . . . . . . . 76
Creating a new Song  . . . . . . . . . . . . . . . . . . . . . . 76
Opening Default Song . . . . . . . . . . . . . . . . . . . . . . 76

Loading a Song  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76
Checking/Repairing Songs  . . . . . . . . . . . . . . . . . . . . . . 77
Saving Songs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77
Closing a Song . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77
Quitting the Program… . . . . . . . . . . . . . . . . . . . . . . . . 77

Chapter 5 Transport Functions

5.1 Transport Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79
Display Options  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79

Indicator Options  . . . . . . . . . . . . . . . . . . . . . . . . . 79
Position Slider . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80
Smaller/Larger . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80

Parameter Fields and Indicators  . . . . . . . . . . . . . . . . . . 80
Position Indicators . . . . . . . . . . . . . . . . . . . . . . . . . 80
Position Markers (Locators)  . . . . . . . . . . . . . . . . . . 81
Skip Cycle . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81
Tempo  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82
Free Memory . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82
End of Song  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84

Transport Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . 84
Mode-Buttons  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86

Cycle (Repeat Mode) . . . . . . . . . . . . . . . . . . . . . . . 86
8
Emagic
MicroLogic Fun 

5.2 Bar Ruler  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87
Setting the Song Beginning and End . . . . . . . . . . . 88

5.3 Cycle Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90
Cycle Bars . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90



1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

Gl

Ix
Table of Contents

Chapter 6 Arrange Window

6.1 Structure of the Arrange Window  . . . . . . . . . . . . . . . . 93
Tools  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94

6.2 Tracks  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94
Adjusting the Sound of a Track . . . . . . . . . . . . . . . 96
Selecting an Icon . . . . . . . . . . . . . . . . . . . . . . . . . . 97

6.3 Arranging Sequences . . . . . . . . . . . . . . . . . . . . . . . . . . 99
What is a Sequence? . . . . . . . . . . . . . . . . . . . . . . . 99
Creating an Empty Sequence  . . . . . . . . . . . . . . . . 99
Shifting Sequences in Time  . . . . . . . . . . . . . . . . . . 99
Copying Sequences . . . . . . . . . . . . . . . . . . . . . . . . 99
Moving/Copying onto another Track . . . . . . . . . . 100
Changing the Length of a Sequence . . . . . . . . . . 100
…Using a Finer Grid  . . . . . . . . . . . . . . . . . . . . . . 101
Dividing Sequences . . . . . . . . . . . . . . . . . . . . . . . 101
Merging Sequences . . . . . . . . . . . . . . . . . . . . . . . 102
Muting Sequences  . . . . . . . . . . . . . . . . . . . . . . . 103
Soloing Sequences  . . . . . . . . . . . . . . . . . . . . . . . 103
Naming a Sequence  . . . . . . . . . . . . . . . . . . . . . . 103
Inserting Events . . . . . . . . . . . . . . . . . . . . . . . . . . 104

6.4 Sequence Parameters . . . . . . . . . . . . . . . . . . . . . . . . . 104
Quantize . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105
Loop . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105
Transpose . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106
Velocity . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107
Delay  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107

6.5 Quantization  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108
Setting the Quantization Value  . . . . . . . . . . . . . . 108
Quantization: Operation  . . . . . . . . . . . . . . . . . . . 108

The Different Types of Quantization . . . . . . . . . . . . . . 109
No Quantizing . . . . . . . . . . . . . . . . . . . . . . . . . . . 109
Standard Quantization  . . . . . . . . . . . . . . . . . . . . 109
Quantization to Odd Tuplets . . . . . . . . . . . . . . . . 110
Swing Quantization . . . . . . . . . . . . . . . . . . . . . . . 110
Mixed Quantization . . . . . . . . . . . . . . . . . . . . . . . 110

6.6 Reset Functions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 111
For Hanging notes—Panic Function . . . . . . . . . . . 111
9
Owner’s Manual 
Version 4.0 – English 

B

C

Maximum Volume . . . . . . . . . . . . . . . . . . . . . . . . 111



Table of Contents

Chapter 7 Mixer

7.1 An Adaptive Track Mixer  . . . . . . . . . . . . . . . . . . . . . . 113
Resetting Parameters . . . . . . . . . . . . . . . . . . . . . . . . . 114

7.2 The Channel Strips . . . . . . . . . . . . . . . . . . . . . . . . . . . 114
Switching Sound Programs  . . . . . . . . . . . . . . . . . 115
Controller . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116
Choosing Other Controllers . . . . . . . . . . . . . . . . . 116
Controller Numbers of the Mixer Controls . . . . . . 117
Extended GM, GS and XG Functions . . . . . . . . . . 118

7.3 Mixer Automation  . . . . . . . . . . . . . . . . . . . . . . . . . . . 119

Chapter 8 The Event List

Opening the Event List  . . . . . . . . . . . . . . . . . . . . 121
Structure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 121

Display . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 122
8.1 Operation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123

Scrolling  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123
Selection Techniques . . . . . . . . . . . . . . . . . . . . . . 123
Special Selection Functions  . . . . . . . . . . . . . . . . . 123

8.2 Event Editing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 124
Adding Events . . . . . . . . . . . . . . . . . . . . . . . . . . . 124
Duplicating Events . . . . . . . . . . . . . . . . . . . . . . . . 124
Moving Events  . . . . . . . . . . . . . . . . . . . . . . . . . . 125
Altering Values  . . . . . . . . . . . . . . . . . . . . . . . . . . 125
Altering the Values of Several Events . . . . . . . . . . 125
Numerical Value Input . . . . . . . . . . . . . . . . . . . . . 126

8.3 Event List Structure  . . . . . . . . . . . . . . . . . . . . . . . . . . 126
Position . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 126
Status . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127
Cha . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127
Num, Val . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127
Length/Info . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127

8.4 Event Type Structure  . . . . . . . . . . . . . . . . . . . . . . . . . 128
Note Events . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128
Program Change Events  . . . . . . . . . . . . . . . . . . . 129
Pitch Bend Events  . . . . . . . . . . . . . . . . . . . . . . . . 130
10
Emagic
MicroLogic Fun 

Control Change Events . . . . . . . . . . . . . . . . . . . . 130
Aftertouch Events . . . . . . . . . . . . . . . . . . . . . . . . 131
Poly Pressure Events  . . . . . . . . . . . . . . . . . . . . . . 131



1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

Gl

Ix
Table of Contents

Chapter 9 The Matrix Editor

Opening the Matrix Editor . . . . . . . . . . . . . . . . . . 133
9.1 Display . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 134

Position . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 134
Velocity . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 134

9.2 Editing Notes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 135
Creating Notes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 135

Duplicating Notes  . . . . . . . . . . . . . . . . . . . . . . . . 135
Moving Notes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 135

Setting a finer Grid  . . . . . . . . . . . . . . . . . . . . . . . 135
Copying Notes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 136

Altering Lengths  . . . . . . . . . . . . . . . . . . . . . . . . . 136
Altering the Lengths of Several Notes 
Simultaneously  . . . . . . . . . . . . . . . . . . . . . . . . . . 136
Making Notes the Same Length  . . . . . . . . . . . . . 136
Altering the Velocity  . . . . . . . . . . . . . . . . . . . . . . 137

Deleting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 137
Selection Techniques  . . . . . . . . . . . . . . . . . . . . . . . . . 137
Quick selection of Event Editor . . . . . . . . . . . . . . . . . . 138

Chapter 10 The Score Editor

Opening the Score Edit Window  . . . . . . . . . . . . . . . . 139
10.1 General Appearance of the Score Edit Window  . . . . . 140

Important Elements of the Score Edit Window  . . 140
View Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 140
Moving the Borders between the Different Areas  141
Parameter Boxes . . . . . . . . . . . . . . . . . . . . . . . . . 141
The Main Working Area  . . . . . . . . . . . . . . . . . . . 141

10.2 MicroLogic’s Notation Concept  . . . . . . . . . . . . . . . . . 142
Staff Display in Relation to Position and
Length of Sequences in the Arrange Window  . . . . . . 143
MicroLogic’s Basic Elements for Score Display  . . . . . . 144

The Display Parameter Box  . . . . . . . . . . . . . . . . . 144
Score Styles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 144

Input Methods in the Score Edit Window . . . . . . . . . . 144
10.3 MIDI Real Time Recording in the Score Window . . . . . 145
11
Owner’s Manual 
Version 4.0 – English 

B

C

10.4 Mouse Input  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 146
Input . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 146
MIDI Channel and Velocity of Inserted Notes . . . . 146



Table of Contents

Insert Quantization  . . . . . . . . . . . . . . . . . . . . . . . 147
10.5 The Partbox—Inserting Notes . . . . . . . . . . . . . . . . . . . 147

Ties  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 148
Allowing Diatonic Input Only . . . . . . . . . . . . . . . . 148

Triplets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 148
Automatic Rest Display  . . . . . . . . . . . . . . . . . . . . . . . 149
Key Signatures and Key Signature Changes  . . . . . . . . 149
Time Signatures and Time Signature Changes  . . . . . . 150

10.6 Text: Input and Display . . . . . . . . . . . . . . . . . . . . . . . . 151
Text Appearance  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 151
Text Input  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 151
Editing Text  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 152

Copying Text Objects  . . . . . . . . . . . . . . . . . . . . . 152
10.7 Move, Copy and Paste in the Score Edit Window . . . . 152

Moving/Copying with the Mouse  . . . . . . . . . . . . 153
Move/Copy with Cut, Copy & Paste 
via the Clipboard . . . . . . . . . . . . . . . . . . . . . . . . . 154

10.8 Editing Notes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 155
Changes in the Event Parameter Box  . . . . . . . . . . . . . 155

Notes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 155
Text  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 155

Changing Several Selected Objects Simultaneously in 
the Event Parameter Box  . . . . . . . . . . . . . . . . . . . . . . 156
Deleting Objects in the Score Window . . . . . . . . . . . . 156

10.9 The Display Parameter Box . . . . . . . . . . . . . . . . . . . . . 157
Different Settings within the Same Staff  . . . . . . . 157
Default Settings for New Sequences  . . . . . . . . . . 157
Changing the Settings for 
Several Sequences Simultaneously . . . . . . . . . . . . 158
Rhythmic Interpretation of Sequences . . . . . . . . . 158

The Parameters in the Display Parameter Box . . . . . . . 159
10.10 Score Styles  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 161

Assigning Score Styles to Sequences  . . . . . . . . . . 162
Distance between Staves  . . . . . . . . . . . . . . . . . . . . . . 162
Using the Multi-Stave Score Style “Piano”  . . . . . . . . . 162

10.11 Display Levels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 163
Changing between Single Sequence and 
Full Score Display  . . . . . . . . . . . . . . . . . . . . . . . . 163
12
Emagic
MicroLogic Fun 

Muted Sequences or Tracks in the Score Display  . 164



1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

Gl

Ix
Table of Contents

10.12 Adapting MIDI Sequences for Score Printout  . . . . . . . 164
10.13 Printout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 166

Chapter 11 Wave Player

11.1 Basics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 167
Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 167

11.2 The Wave Player Window  . . . . . . . . . . . . . . . . . . . . . 168
Wave Player Parameters  . . . . . . . . . . . . . . . . . . . 169
Deleting Wave Files . . . . . . . . . . . . . . . . . . . . . . . 170

11.3 Wave Player in the Arrange Window  . . . . . . . . . . . . . 171
Wave Player and the Editors . . . . . . . . . . . . . . . . . . . . 171

Important  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 172

Chapter 12 Video and MIDI Files

12.1 Playing Digital Video Files . . . . . . . . . . . . . . . . . . . . . . 173
Video on Windows PC . . . . . . . . . . . . . . . . . . . . . . . . 173
Video on a Macintosh  . . . . . . . . . . . . . . . . . . . . . . . . 173

Transport Functions of the Scroll Bar . . . . . . . . . . 174
Transport Functions of the Position Pointer  . . . . . 175

12.2 MIDI Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 176
Preparing a Song for MIDI File Conversion . . . . . . 176
Saving the Song as a MIDI File . . . . . . . . . . . . . . . 176
Saving Individual Sequences as a MIDI File . . . . . . 176
Saving Songs as SMF Format 0  . . . . . . . . . . . . . . 177
Importing MIDI Files  . . . . . . . . . . . . . . . . . . . . . . 177

12.3 Transfer Songs onto other Devices or Computers . . . . 177

Chapter 13 Use of Key Commands and Mouse, Settings

13.1 Keyboard Command Symbols  . . . . . . . . . . . . . . . . . . 179
13.2 Key Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 180
13.3 Using the Mouse  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 180
13.4 Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 181

Song Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 181
13
Owner’s Manual 
Version 4.0 – English 

B

C

Global Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . 182
Initializing the Preferences… . . . . . . . . . . . . . . . . 183



Table of Contents

Chapter 14 Menu Reference

14.1 Apple Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 185
14.2 File Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 185
14.3 Edit Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 185
14.4 Track Menu in the Arrange Window  . . . . . . . . . . . . . 186
14.5 Options Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 186

Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 186
Tempo . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 186
Others . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 186
Send to MIDI  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 187
In the Score Window . . . . . . . . . . . . . . . . . . . . . . . . . 187

14.6 View Menu in the Sore Editor  . . . . . . . . . . . . . . . . . . 187
14.7 Windows Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 188
14.8 Help Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 188

Glossary  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  189

Index . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  197
14
Emagic
MicroLogic Fun 



1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

Gl

Ix
Chapter 1

Features

MicroLogic Fun is a MIDI sequencer, and a notation system 
that is easy to learn and operate. MicroLogic Fun transforms 
your computer into a MIDI recording studio. You can create 
songs and arrange them on your computer screen, and then 
print out musical notation. MicroLogic Fun thus combines the 
most important functions that you would expect from a 
modern, powerful audio sequencer, with an intuitive and 
clearly arranged user interface.

1.1 Multitrack Recorder
One of the main components of MicroLogic Fun is the MIDI 
multitrack recorder. You record ecord multiple tracks, as though 
you were in a professional studio, and as you record the next 
15
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one, listen to the tracks that you just recorded.

MicroLogic Fun offers you many ways to alter and refine your 
recorded material at a later time. You can move the tracks 



Chapter 1
Features

around in the Arrange window, give the MIDI tracks a different 
sound, or divide them into blocks (sequences). You can cut, 
copy, move, transpose, or correct (quantize) rhythmically.

The three editor windows give you complete control of your 
recordings. Whether you are changing the length, or dynamic 
strength of a single note in the Event editor, or entering entire 
scores in the Score editor—it’s all easy and fast with MicroLogic 
Fun.

1.2 Flexible Input
There are several ways of entering notes into MicroLogic Fun. 
Everything is available, from real-time recording to manual 
note entry; the possibilities are endless.

You can use MicroLogic Fun simply to record real-time MIDI 
performances, or as a conventional notation system by input-
ting your scores on the screen with the mouse. 

MicroLogic Fun offers you every possibility; you decide which 
ones to use. You may control the program either with the mouse 
or the computer keyboard; all functions can be carried out using 
the mouse, and the majority can be adapted to meet your needs 
via keyboard commands, which can be programmed as desired.
16
Emagic
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1.3 Automatic Notation

If you prefer working in musical notation to piano roll, or event 
list editing, you can edit your songs in the Score editor. There, 
you can view your sequences as conventional musical notation. 
You can insert, move, or transpose notes easily using the mouse. 
MicroLogic Fun offers a range of functions with which you can 
adapt the appearance of the score to your liking, from the notes 
themselves, to the size of your windows.

Of course you can also print out your songs.You can also create 
a PostScript file, and continue to edit the scores which were 
created in MicroLogic Fun, with word-processing or layout 
programs.
17
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1.4 GM Supported

If you use a GM-compatible tone generator connected to your 
computer, you can control its functions remotely from the 
Mixer window. Selecting sounds, controlling the volume, or 
adding chorus or reverb etc. is as easy as can be. MicroLogic 
Fun also supports the GS- (Roland), or the XG standard 
(Yamaha). With these devices, more sound and effect parame-
ters can be remote-controlled, for example, the filter frequency.

The Mixer thus becomes your virtual mixing console on screen, 
allowing you to automate your GM device from MicroLogic 
Fun.

1.5 Wave Player
18
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required. You can even control the gating of these files in real 
time with your MIDI controller. This allows you to use Micro-
logic Fun much like a sampler.

1.6 Multimedia
MicroLogic Fun can load and play digital videos in FunI format 
(Windows) or QuickTime format (Macintosh). The picture 
runs synchronously with MicroLogic’s song position. You can 
add music to commercials, or videos of your vacation, without 
using a video recorder. Sounds or jingles start concurrently with 
the frame.

1.7 Graphical Interface
MicroLogic Fun features a clearly structured graphical user 
interface. All operations can be done quickly and directly, using 
the mouse.

You can open the windows, and place them anywhere on the 
screen. You can adjust all elements in the windows as you like; 
the windows can be enlarged or reduced. To make the most of 
your screen, you can open as many windows simultaneously as 
you want. Next to the track list in the Arrange window, for 
example, you can simultaneously open an Event list and Score 
editor for the same material. 

As MicroLogic Fun plays the song for you, the notes e.g. are 
displayed in the Score Window. Whatever you hear, you see at 
the same time. If there is a wrong note, just fix it, while Micro-
Logic Fun continues to run. It does not get any easier than this.

MicroLogic Fun’s menus are well organized and make sure that 
you only see the functions that you may need. This way, the 
19
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menu lists remain orderly, and you can find whatever function 
you need faster.
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1.8 About this Manual
• The headings in this manual are arranged according to the 

names of the functions in the program. This way, you can 
quickly find specific functions in the table of contents.

• Located in the appendix of this manual is an index, in which 
you can look up keywords.

• The Menu List, found in the appendix, offers an overview of 
all menu items.

• The glossary explains the meaning of specialized terms. If 
you do not find a term there, you can look it up in the index, 
and read about it in the corresponding section of the manual.

The Tutorial Chapter
If you want to familiarize yourself quickly with a specific topic 
(e.g., Arrange window, Event editor, note editing), we recom-
mend that you work through the corresponding section in 
Chapter 3 Tutorial. The tutorial is arranged by self-contained 
topics. You will find the appropriate Tutorial Song on Micro-
Logic’s CD. It takes less than half an hour to work through each 
section. You can then work through the corresponding pages of 
that chapter, to familiarize yourself with the details.
20
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Chapter 2

Getting Started

2.1 Windows

Getting Started With MicroLogic Fun
Double-click the MicroLogic Fun icon, or select MicroLogic 
Fun from Start>Programs>Emagic>MicroLogic Fun, in the Start 
Menu, to launch the program. Your MIDI interfaces and your 
sound cards are recognized at startup, and all internal connec-
tions and settings are automatically established. If you have 
installed several MIDI cards in your computer, you can use any 
of them.

Each time MicroLogic Fun starts up, it searches for installed 
MIDI interfaces so that a new card is automatically available 
the next time MicroLogic Fun starts up. 

After a short time, you will see an empty Arrange window, and 
the main menu bar.

Selecting the MIDI Out Port in the Program
You can select the MIDI port for each track separately. To do so, 
select the desired track, and go to the Instrument parameter 
box, located just below the Toolbox, on the left side of the 
Arrange window. Click-hold in the field just below the “Chan-
nel” assignment field. You will see a flip menu listing all the 
MIDI out ports available on your system. Select the one you 
want, and release the mouse button.
21
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Testing the MIDI Connection
You should then test to make sure that the connections 
between MicroLogic Fun and your MIDI system are working 
smoothly.

First, test to see if your MIDI keyboard transmits.

• Open the Transport Window by choosing “Open Transport 
Window” in the window menu or press “F11”.

• You can see the MIDI monitor in the upper right-hand 
corner of the Transport window.

• If there is no activity, the display will show “No In/ No Out”.

• Now play a couple of notes on your MIDI keyboard.

• In place of “No In”, the received events should now be 
displayed.

• If this is not the case, test the following:

• Is the MIDI-Out connection of the keyboard connected 
correctly with the MIDI-In of your computer?

• Is the cable working properly?

Test the MIDI Out
Now test to see if MicroLogic Fun is sending MIDI events to 
your tone generators.

• Call up File> Open, and select the Tutorial Song (TUTO-
RIAL.LSO) from the file selection box. 

• Set the MIDI out port for each of the tracks, as described 
above.

• Click on the PLAY button in the Transport Window or press 
0 on the numeric keypad of the computer.
22
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• If this is not the case, test 

• whether you are using a good MIDI cable.

• whether you connected the MIDI-In of your tone generator 
to the MIDI-Out of the interface.

File Extensions
MicroLogic Fun can load or save files in both its own native file 
format, or as Standard MIDI files, for use with other programs. 
You can recognize the type of file from the following exten-
sions:

MicroLogic Fun and Multitasking
MicroLogic Fun can be operated in conjunction with other 
MIDI programs. If you switch over to another program, Micro-
Logic Fun continues to run in the background. For this to work, 
your MIDI interface must use a multi client driver. If you have 
any questions about this, contact the manufacturer of your 
interface for information.

Launching MicroLogic Fun
The installation program automatically creates a program group 
“MicroLogic Fun” under Programs>Emagic, in the Start Menu. 
Here you will find MicroLogic Fun itself, and the de-installa-

Type of File Extension Description Created from

Song ∗ .LSO Song File MicroLogic Fun when the 
menu field “Save” is 
called up in the file menu

Standard 
MIDI File

∗ .MID Song file in the 
standard MIDI 
file format

external sequencers can 
be imported into Micro-
Logic Fun or from Micro-
Logic Fun with Export
23
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Launch MicroLogic Fun Automatically
If you add MicroLogic Fun to the program group “Startup” 
from the Start Menu, then MicroLogic Fun starts up automati-
cally when Windows is launched. Create a shortcut to Micro-
Logic Fun in this folder by dragging the “MicroLogic Fun 
4.0.exe” icon from the “C:\Program Files\emagic\MicroLogic 
Fun 4.0” folder to the “C:\Windows\Start Menu\Startup” 
folder. This will not move, or copy the program file, but will 
create a “shortcut” to it in the new location. You may also drag 
the prgram to the Desktop instead, if you prefer to launch from 
there.

You have now correctly installed MicroLogic Fun, and have set 
it up to connect with your MIDI system. Everything is now 
ready for you to work through the tutorial. This series of exer-
cises will help you to become acquainted with MicroLogic Fun.

2.2 Macintosh

Launching MicroLogic Fun
This is how you usually start up MicroLogic Fun:

1. Double-click the program’s icon, or

2. Click on the program’s icon and choose File> Open, or 
press Co.

As long as you are working through the manual, we recommend 
that you start MicroLogic Fun directly with the Tutorial Song.

3. Double-click the Tutorial Song icon.

MicroLogic Fun will launch with the Tutorial Song loaded. 

Choose MIDI Connection
24
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• In the Option Menu, call up Settings > MIDI Interface 
Communication…

The Global Preferences dialog box appears.
Serial Prefs

Parameter for the MIDI interface ports

You can activate one of three ports here:

• Choose the USB, the modem port or the printer port.

When you have chosen one port, MicroLogic Fun automati-
cally turns off the other ports.

MicroLogic Fun tests automatically to see whether a MIDI 
interface is connected to the specified port and is operable. If 
no MIDI interface is recognized, a dialog box appears.

Starting up without MIDI interface: If you want to test Micro-
Logic Fun “dry”—that is without MIDI interface and tone 
generator—simply disable all ports by choosing “off.”

MIDI Time Piece
MicroLogic Fun directly supports the “MIDI Time Piece” 
(MTP) interface from the manufacturer “Mark Of The 
Unicorn”, as well as MTP-compatible interfaces:

• Enable the options “Check For MTP” and “Fast Speed” in 
Global Preferences.

Unlike LOGIC, MicroLogic Fun cannot separately address the 
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different MIDI Outputs of MTP compatible interfaces.
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The “Fast Speed” mode can be switched off—for instance with 
longer SySex transmissions, if you have any problems with 
MIDI Communications.

Testing the MIDI Connection
You should now make sure that the connection between Micro-
Logic Fun and your MIDI system is working properly.

1. Launch MicroLogic Fun.

First, test to see if your MIDI keyboard transmits.

2. Open the Transport Window by selecting Open Transport 
in the window menu, or press C7

You can see the MIDI indicator in the upper right-hand corner 
of the Transport Window.

If there is no activity, the display will show “No In/ No Out”.

3. Now play a couple of notes on your MIDI keyboard.

In place of “No In”, the received events should now be 
displayed.

If this is not the case, test the following:

4. Is the MIDI-Out connection of the keyboard connected 
correctly with the MIDI-In of your computer?

• Is the cable working properly?

• Did you choose the correct port in Global Preferences?

Test the MIDI-Out
Now test to see if MicroLogic Fun is sending MIDI events to 
your tone generators.

1. Choose File> Open, and select the tutorial song in the file-
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selection box.

It is loaded and displayed on the screen.
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2. Click on the PLAY button in the Transport Window, or 
press 0 on the computer’s numeric keypad.

The tutorial will run, and the second line of the MIDI indicator 
should show the sent events.

If this is not the case, see if you have enabled the modem port 
or the printer port in Global Preferences. If you have not, 
enable the port to which your MIDI interface is connected.

Autoload Song
You can select a song with which MicroLogic Fun is automati-
cally loaded. This song can contain your own preferred song 
settings and window layouts.

Proceed as follows:

1. Create a new song.

2. Adjust the song settings according to your preferences.

3. Save the song with the file name “Autoload” (quotes 
excluded).

To save the song, select “Save” in the file menu and enter 
“Autoload” in the dialog box.

You can also create an alias for any song, and start MicroLogic 
Fun directly by double-clicking the alias.

Start MicroLogic Fun automatically
You can have MicroLogic Fun open automatically every time 
your Macintosh starts up. If you want, you can also have a song 
start automatically.

Proceed as follows:

1. Create an alias of MicroLogic Fun, or the desired song.
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2. Drag the alias with your mouse into the folder “Startup 
Items”, in the system folder.
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MicroLogic Fun will be started up automatically the next time 
you turn your system on.

MicroLogic Fun is now properly installed and configured for 
your system.

2.3 MacOS/Win: Differences 
MicroLogic Fun for Macintosh and for Windows is basically the 
same. The controls for both versions are practically identical. 
However, because of some differences between the operating 
systems, there are some slight variations in MicroLogic Fun 
between the two platforms.

When you first look at it, you will notice that we have used two 
symbols to identify the Macintosh and Windows versions:

• This symbol identifies a function that is only on Windows.

• This symbol characterizes a function that is only on Macin-
tosh.

Keyboard and Mouse
Unlike the Macintosh mouse, a Windows mouse has a right 
mouse button. Also, the position of some special keys is slightly 
different between the systems.

There is a table with explanations for the symbols used in this 
book for hot keys. This is located in the section, Hot Key 
Symbols.

TM
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Look at the table and note which keys and/or mouse functions 
for Windows are replaced and how.
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Key Commands
The predefined function codes for menu items are, as usual, 
displayed directly behind the menu item. In addition, you can 
define your own function codes for almost all of the MicroLogic 
Fun functions. These are also displayed in the menus.

Exchanging Songs Between Mac and PC
Unlike Windows, Macintosh does not use file extensions. You 
can, however, transfer songs back and forth between Macintosh 
and Windows versions without any problem. When you are 
transferring a song from a Macintosh to a Windows version, it is 
important that you add the file extensions, which are discussed 
above in the section named File Extensions. You can do this 
either on the Macintosh or on the PC, when you are finished.

Songs created with MicroLogic Fun for Windows can be 
opened in MicroLogic Fun for Macintosh under “Import.”

Menu Bars
The menu bars of MicroLogic Fun for Windows and Micro-
Logic Fun for Macintosh are similar. While the Macintosh 
version has local menus in the different windows, the main 

Function MicroLogic Fun 
Windows

MicroLogic Fun 
Macintosh

Multiple selection S + click S + click

Mouse copy func-
tions

ç hold down O hold down

Using tools right mouse button C and mouse

Specific mouse func-
tions

‚ + mouse
ç + mouse
A + mouse

S + mouse
C + mouse
O + mouse
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menu of the Windows version changes accordingly.
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Tutorial

This chapter introduces you to the features of MicroLogic Fun 
by using examples. It touches upon all of MicroLogic Fun’s 
important functions. You will learn, for instance, how to arrange 
a song, record a sequence, or prepare your arrangement for 
printing.

In order to follow the examples you should:

• install MicroLogic Fun

• have a General MIDI tone generator or an equivalent multi-
timbral device connected to your computer’s MIDI inter-
face.

3.1 Adapting the Tutorial Song
As you work through this chapter and the next, use the 
provided tutorial song. This song is configured for general 
MIDI tone generators. Of course, you will not have any prob-
lems using the song with tone generators that do not follow the 
GM specification. The only difference when using a non-GM 
device, is that you will have to set the sounds and the MIDI 
channels manually the first time you run the song, and you may 
have to transpose some tracks. If this is necessary, be sure to 
save your changes, so that you don’t have to redo your edits.

Load the Tutorial Song
You can start the Tutorial Song by
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• double-clicking the “Tutorial” song icon in the MicroLogic 
folder, or
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• starting MicroLogic Fun, call up File> Open, and choose the 
Tutorial Song.

You should now be looking at the following screen:

Arrangement window with tutorial song

General MIDI Tone Generator
The program change, volume, and pan settings for this song are 
optimized for GM tone generators, and are transmitted to your 
device via MIDI. This happens automatically, if you play the 
song from the beginning. These settings are found in a separate 
sequence at the beginning of the song. Since delays can occur 
with some synthesizers when they receive program change 
data, you should then mute this sequence.

To mute the program changes, select the mute tool from the 
toolbox, and use it to click on the sequence named “GM Set-
Up”. The sequence is now shown reversed, and a small circle is 
now in front of the name.

Non GM, Multi-Timbral Tone Generators
If you do not have a, you need to consider the following points: 
One prerequisite is, for example, that the sounds listed in the 
table are available. If necessary, find similar sounds in your own 
device.In addition, the drum kit’s note assignemt needs to 
match that of the GM drum map(previously Roland drum 
32
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map), otherwise, the percussion passages will be reproduced 
with the wrong drum sounds. Adjust the appropriate reception 
channels in your multi-timbral synthesizer, and assign the 
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listed sounds specified in the table. If you need to rearrange 
your Drum kit, consider the percussion instruments listed in 
the table, as well.

Sounds and MIDI Channels

Drum Kit
Here is a list of percussion instruments used by the tutorial 
song, and their locations. (C3 = No. 60).

MIDI 
Ch.

Function Sound Possible Name Vol Pan

1 chord combination 
piano/E piano

Electric Grand, LA 
Grand

110 0

2 bass normal E bass Pick Bass, Rock 
Bass, E Bass

127  0

3 accents muted E guitar Mute Guitar, Slap 
Guitar

 127 R

4 melody long dying 
away melodic 
sound

Synthbell 100 0

5 carpet string section Slow Strings, Pad 90 0

6 accents wind section Brass Section 80 L

7 solo flute-like solo 
sound

Stream, div. 
“Solo”

120 0

10 drums GM-compati-
ble drum set

GM Kit  110 0

Note Instrument

C1 Kick

D1 Snare (normal)

E1 Snare (hi)

F1 Tom lo
33
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F#1 HHT closed

G1 Tom mid
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Since transposition and relative volume are only automatically 
correct with GM sounds, you should let the song run through a 
couple of times, and see how it sounds with your instrument, 
after you have assigned compatible sounds. Go ahead and try 
opening Window > Mixer and use the faders to set the volume, 
if needed.

Starting the Song
You probably want to listen to the Tutorial Song first. Just push 
≠ on the numeric keyboard. To jump back to the beginning of 
the song, push ‰, on the numeric keypad, twice.

3.2 Overview
After you open the tutorial song, you will see the following 
components on the screen. This example is on a Macintosh:

G#1 HHT closed 
short

A1 Tom hi

A#1 HHT open

C#2 Crash

D#2 Ride

E2 Ride Bell

Note Instrument
34
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3.3 Tracks and Sequences
To start with, MicroLogic Fun offers the usual elements found 
in a Windows or Macintosh program—the main menu bar, and 

1 2 3 4 5

6

7
8

9

1 Catch Button This is where you control
the Catch function of MicroLogic Fun. With
Catch turned on, the screen follows the song
position.
2 Main menu bar  This is where you find
global functions, e.g. for saving and loading
songs or for opening various windows.
3 Bar ruler The bar ruler displays
MicroLogic’s time axis for you; here you can
set markers with the mouse, or jump to any
desired place in a song.
4 Arrange area, with sequences A track
may contain any number of sequences.
Sequences contain the actual data, such as
notes, controller data, etc. The data can be
edited in a variety of ways.
5 Zoom buttons If you click on the
telescope buttons, you can alter the
magnification factor of the window’s
contents and thus adapt to your screen.

6 Transport window The transport

desired point of the screen and is variable in
size. A “slider” permits rapid approach from
far removed song positions.
7 Track column  It is in the track column
that you determine the MIDI channel for
each track. It is likewise here that you can
swap tracks, insert them or delete them.
8 Toolbox You can select a particular tool
from this box in order to be able to edit
sequences, notes or other data in a variety of
ways.
9 Sequence parameter box The
sequence parameter box is where
quantization, transposition and other
aspects of the playback for a sequence can
be non-destructively edited.
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various windows that you can open and close, move and adjust 
to size. After you load a song, you should see the Arrange 
window, as seen above. This is where you record and arrange 
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your songs. Like a multitrack tape machine, MicroLogic Fun 
also works on the basis of tracks. You can see and access the 
tracks in the Arrange window.

Narrow objects known as “sequences” are found on the tracks. 
A sequence represents an individual recording, or “take”. Each 
time you record, a sequence will be created in the track you 
recorded to. The sequence is like a container, so to speak, 
which contains the actual MIDI data. This data can be notes as 
well as control data, program changes, or even sysex for your 
MIDI tone generators.

Tracks with sequences

You can see that with MicroLogic Fun, there are many more 
possibilities than with a traditional tape machine.

Information Track and Instruments
Take a closer look at the “track plan”.

On track 1, you can see the sequences “A intro”, “B groove”, 
and subsequent entries. “No Output” is displayed in the track 
column of track 1. This is a “dummy track”, which does not 
contain any notes. The sequences on this track are only mark-
ers for the various song parts and, for the time being, are empty. 
As you continue to work through this section, you will learn 
about other advantages to using an information track in your 
own songs..

Instruments for the tutorial song are found on the remainder of 
the tracks: piano on track 2, bass on track 3, guitar on track 4, 
and so forth.
36
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The MIDI channel for each track is visible in the track column. 
In addition, an icon is displayed there for each track. This 
shows which instrument is in use.
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3.4 Transport Functions
The second, smaller window, which MicroLogic Fun shows 
after loading the song, is the Floating Transport window. It is 
laid out like the control surface of a tape machine, and is used 
for operating the Play and Record functions. In addition, you can 
change the tempo settings and engage Cycle.

Let’s start the song. Instead of clicking the Play button, you can 
also press = on your numeric keypad.

You can hear that the song is not completely arranged, and still 
contains some inconsistencies. As you continue to work 
through this chapter, you will finish arranging the song, add a 
few details, and correct any mistakes. 

In this section, you will learn to start and limit passages, and 
listen to places in the song—in short, to “navigate” in the song.

• Try out the buttons in the upper row of the transport field. 
You already are familiar with functions from tape machines 
or cassette recorders.

Start Song Positions
There are several ways to jump to specific song positions.

In the upper field of the Arrange window, you can see the bar 
ruler.

• Click at various places in the lower field of this ruler; you 
immediately jump to that position. At the same time, a gray 
line appears. This is the song position line (SPL)—in the 
most generalsense, it is comparable with the position of the 
37
User Guide 
Version 4.0 – English 

B

C

tape on a traditional recording device.
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• Engage Play. Now click on the bar ruler, and hold the left 
mouse button. You can move to any position, and listen by 
moving the song position line.

If you know to which location you would like to go, you can 
enter this position directly with the “locators”. To the right and 
next to the transport buttons, MicroLogic Fun shows the 
current song position, in both absolute time and as musical 
measures.

• Click on the song position indicator, and hold the mouse 
button. Place the song position at “17 1 1 1” and start play-
back. MicroLogic Fun now plays starting at measure 17.

Display Current Song Position
If you manually enter song positions, the window view that you 
see will not necessarily correspond to what you hear. You can, 
however, guarantee that these two things will always match.

• Click on the catch button on the upper left in the transport 
field, and the window excerpt follows the song position line 
again.

The window viewwill update, as soon as the song position line 
leaves the visible field, only if the catch function has been 
enabled:

Zoom a Window Excerpt
You can view the entire song in the window by using the two 
telescope buttons on the upper right edge of the window:

Click on the left half of the horizontal zoom button until you 
can see all of the sequences in the window.

Cycle Mode
38
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In cycle mode, you can cause a section of the song to repeat for 
as long as Play is engaged, in order to edit a sequence, for 
instance, or record new tracks in a specific section of the song. 
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Two “locators” can be used for this. These are position markers 
that mark the left and right boundary of a loop. They are found 
directly to the right of the bottom row of transport control 
buttons.

First, turn on the cycle mode. To do this, click on the cycle 
button in the Transport window. It is now displayed blue.

Pay attention to the cycle bars in the measure ruler:

You can move this by grabbing it in the middle. The right and 
left boarders can be changed bygrabbing one of the bottom 
corners of the bar, and moving it. When Cycle is engaged, 
pressing Stop twice will take the SPL to the beginning of the 
cycle zone, rather than the beginning of the song..

Selection
Let’s become more familiar with the selection options. In order 
to edit objects in MicroLogic Fun—be it sequences or notes—
we have to first select them. All functions and operations are 
carried out only on those items that are highlighted or 
“selected”.

• Click on a sequence. The sequence will highlight, indicating 
it is selected. Let’s go one step further by selecting several 
sequences.

• Hold S down, and click on Anwältin: second sequence. 
This is additionally selected. 

• While pressing the S button, click on the gray area, keep 
the mouse button pressed and drag a “lasso” over some other 
sequences.
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• The selection is now reversed—all sequences except for those 
previously selected are now selected.
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Try out the selection functions with other sequences. You are 
now familiar with the most essential MicroLogic Fun tech-
niques. In 4.4 Selecting Objects, you can learn more about the 
selection functions.

Quantize
Quantizing is the rhythmic correction of notes, by means of a 
grid. MicroLogic Fun thereby moves all of the notes exactly to 
their correct grid positions. We will test this by using the 
“Groove Real-time” sequence as an example. The timing in 
this sequence is slightly off, so you will use quantization to 
correct it.

You can hear this most clearly by enabling the Metronome.

• To do this, click on the metronome button in the Transport 
window. It is on the lower right. This is how to enable the 
metronome.

MicroLogic Fun now sends a metronome note on channel 10 to 
your GM tone generator. Solo the drum sequence, as described 
above. You can now hear that the groove is not completely 
clean.

• In the Sequence parameter box, click-hold in the line Qua. 
From the resulting flip menu, select the setting 16D Swing, 
and release the mouse button. The quantizesetting is now 
displayed in the Sequence parameter box. If you play the 
sequence now, it sounds rhythmically perfect.

• Go ahead and try out other quantize values, for example 16, 
24, or 7-tuplet, in order to hear the effects of quantizing

Look at the quantize settings of the various song parts. You will 
notice that the swing factors—characterized by the alphabetic 
character—are chosen differently. The groove factor can there-
fore be varied so that choruses sound like they have more swing 
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Loops
Loops are automatic repetitions of a sequence. The loop func-
tion enables you to repeat a passage as many times as you wish, 
without having to copy it.

Let’s add a cabasa to the tutorial song. This cabasa is only in the 
chorus and in section C, but is no longer in the grove section. A 
sequence by the name of cabasa is already on track 10; however, 
it is still muted.

• Click on the sequence with the mute tool. The sequence is 
unmuted, and selected.

Now turn the loop in the Sequence Parameter box to ON. You 
should now see the following screen:

This sequence will now be repeated until the end of the song. 
Of course, we want to stop it before then.

This is how it works: a loop is repeated until it comes across 
another sequence on this track. To “turn off” the cabasa at the 
desired place, place an empty sequence at the beginning of 
section C.

Select the pencil tool, click in the cabasa track at position 25 1 
1 1. MicroLogic Fun inserts a new, empty sequence. The 
screen should now look like this:

The cabasa will stop playing at measure 25.

Finally, we will copy the new cabasa part to the groove section.

While pressing the S key, click on the cabasa sequence, and 
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the “stop” sequence. They have now both been selected.

In the Windows version, press the ç key. In the Mac version 
press the O key. Click on the cabasa sequence, and drag the 
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entire section to measure 33, while keeping the modifier key 
pressed. The entire passage, including the stop sequence, will 
be copied, and you’re done.

The Toolbox
In the toolbox, you may select the desired editing tool, by click-
ing on it with the mouse. In the Windows version, you may 
select a second tool with the right mouse button.

Mouse Arrow
Using the mouse arrow—the standard tool—you can move 
sequences onto other tracks, or to other positions in the Arrange 
window.

Let’s insert a B part in front of the groove section of the Tutorial 
song. Half way through the section, we will transpose the B 
section by a semitone. To do this, the groove part must first be 
moved back eight measures:

• Press the mouse button and rubber band select all of the 
groove section sequences. Grab them, and drag them eight 
measures to the right. The position display in front of the 
information line serves as a reference point. The information 
line should read “41 1 1 1” when you release the mouse 
button.

The arrange area should look something like this:
42
Emagic
MicroLogic Fun 



1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

Gl

Ix
Transport Functions

Undo
Did you make a mistake, like not selecting all of the sequences, 
or did you move them to the wrong place?

If so, this is a good time to become acquainted with one of the 
most important functions in MicroLogic Fun: “undo”. With the 
“undo” function, you can always undo the last editing step.

• Select Edit> Undo. The sequences will be reset to their orig-
inal positions. You can now put them where you want.

Copies of Sequences
We will now copy the section “B theme” to the empty area 
created when we moved the “groove” section..

Rubber band select the sequences of the “B groove” section. 
Press ç (Windows) or O (MacOS) and click-hold on one of 
the selected sequences. Move the mouse to the right. A copy of 
all of the selected sequences is now dragged with the mouse 
pointer. Set these to measure “33 1 1 1”, where they will fill the 
space left by moving the “groove” section. The newly created 
sequences will have the names of the originals, with the text 
“*copied” appended to the end of the name. You decide 
whether or not this extension should appear in the sequence’s 
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name by going to the Options > Settings > Global Preferences 
… Place an X in fthe checkbox to the left of the line “Add ’Last 
Edit Function’ to Sequence Name”, if you want a description 
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of edit operations to edited sequences. If not, remove the X 
from the box.

Scissors
Now, let’s cut the sequence we just copied in half, using the 
scissors tool. By doing this, we will then be able to transpose the 
second half of the section, while leaving the first half in the 
original key.

• Rubber band select the sequences that were just copied.

• Select the Scissors tool by clicking the scissors symbol in the 
toolbox. The mouse pointer is now displayed as ascissors 
within the Arrange area.

Click on one of the selected sequences, and hold the mouse 
button down. If you hold the mouse button down, and move 
the mouse left or right, you can adjust the exact edit position by 
means of the information line. Choose the position “37 1 1 1”, 
which is measure number 37. When you release the mouse 
button, the sequences are cut. Now, you can transpose the 
second half of the section.

Rubber band select measures 33 to 49, to select the correspond-
ing passages.

Transposition
Look at the parameter Transpose in the Sequence Parameter box. 
Itcontains an aserisk (*). This means that the selected 
sequences already show different transposition values. Don’t 
worry, the sequence parameters always work relatively; there-
fore, the transposition differences are maintained.

• Grab the asterisk in the transpose line, and move the mouse 
upward until the value “+ 2” is displayed.
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• Release the mouse button. The passage has now been trans-
posed up a whole tone.
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Place the song position line to measure 37 and listen to the 
result.

It does not sound particularly good, we still need to do some 
fine-tuning.

The percussion sounds somewhat strange at first. This is 
because you unknowingly transposed the percussion 
sequences, causing the drum note placement to shift. You will 
have to undo the transposition for the percussion tracks. To do 
so, selected the drum sequnces, and drag the “+2” transpose 
setting down, until the line is empty. This indicates no transpo-
sition.

Also, the bass in the copied B-section is only a loop that was not 
transposed, because it is merely a pointer on the real sequence, 
which was not affected by the edit. Therefore, we will have to 
copy the the original bass sequence to that location and trans-
pose it.

Your First Recording
The final exercise in the Arrange window is to make your first 
recording. To make it fun, you can play a solo over the C-
section. There is already a flute solo there, this, however can 
certainly be replaced by a better solo. Since you may not play 
the solo perfectly on the first try, we’ll set MicroLogic Fun so 
that you can record several “takes” from which you may select 
your favorite.

Step One: Delete the old solo.

• Select the eraser from the toolbox and click on the sequence 
“Flute”. It will be deleted.

Now you can preset the cycle and record parameters. You will-
probably want a bit of lead in, before the solo starts, to get ready 
to play. You therefore need to extend the cycle to be longer than 
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the actual recording, that is from 23 1 1 1 to 33 1 1 1. This gives 
you two extra measures before section C, which starts at 
measure 25.
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If you would like to hear the metronome via MIDI:

• Open the Options > Settings > Recording Settings window.

Enable MIDI click. The metronome is sent on channel 10—the 
drum channel.

• Confirm by clicking OK.

Let’s Record!
• Click in the track list on track 8—the one with the small flute 

icon. This selects it as the recording track. You can now play 
the flute sound from your MIDI keyboard.

• You can select other tracks to try them out—MicroLogic Fun 
automatically addresses the right instrument 
(MIDITHRU). Finally, switch back to track 8.

• For practice, you can now simply start play by pressing 0 on 
the numeric keypad, or by clicking on Play. If the solo in E 
major is difficult for you, transpose the “MIDITHRU” 
simply by transposing -4 to C major. “MIDITHRU” always 
appears in place of a sequence name in the Sequence para-
meter box, when you click on an empty space in the Arrange 
window. Any settings you make to the Sequence parameter 
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box now will be applied to any subsequently recorded 
sequences. 
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• When you are confident enough to record the solo, begin the 
recording by clicking * on the numeric keypad, or by 
pressing Record.

The count-in of one measure, starts, then the cycle zone will 
play repeatedly and MicroLogic Fun will record. You can play 
your solo now.

• Let MicroLogic Fun continue running. After reaching the 
right cycle point (measure 33), the SPL will jump back to the 
left cycle point (measure 23). At measure 25, the recording 
continues and you can record some more notes if you like. 
Press the Stop button when you’re done.

Saving the Song
Here’s how to save the tutorial song, with your new solo:

• Choose File> Save As…, and enter a new name for the song 
to be saved as, for instance, “Tutsolo”. When using 
Windows, MicroLogic Fun automatically assigns the exten-
sion “. LSO”.

Load the initial tutorial song for further excercises.

3.5 Event List
In the event list, you can see all MIDI events of a sequence 
displayed as an alphanumeric list.

• Open the Event List for the sequence, “flute”, by double-
clicking with the right mouse button (Windows), or by 
holding O down (Macintosh), on the sequence.
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The status column displays what type of event it is. Besides the 
notes, the sequence contains other types of events. You can 
view only certain types of events by using the filter buttons for 
various types of events.

Click on each of the buttons, except for the one showing a 
slider at the bottom of its range, so that they are displayed in 
dark gray.

All that is left in the event list is the control change events.

• When finished, enable the view for all of the types of events 
again. As you click on each button, the events of that type 
will re-appear in the list.

We will now insert two program changes in the solo, in order to 
change from a flute sound for the solo in the first half,to a 
synthesizer sound for the second half..

The solo begins at measure 25. First, we place the program 
change for the flute at measure 25.

• Set the song position line to 25 1 1 1 in the Arrange window 
or the transport window. In this way, you determine the posi-
tion for the event to be inserted.

• Select the Pencil tool, and use it to click on the program 
change symbol. (In the Windows version, you may simply 
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click with the right mouse button on the Program change 
button in the Event List).
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A program change is inserted at position 25. 

The program number is in the VAL column. Set this to 73 on a 
GM tone generator. If you are not using a GM tone generator, 
find a program change that can choose a flute sound.

Now, we will inset a second program change:

• Put the song position line to position 29 1 1 1, and click on 
the 88 symbol again.

Choose value 87 with GM tone generators, or a program change 
that selects a synthesizer solo sound.

• Switch to the arrow tool again. Filter the view for all event 
types, except for the program change events.

Your event list should look like the following:
Graphik

If you play the solo now, the second half will have a different 
sound. The next time it plays through, the program change at 
the beginning of the solo, switches again to the flute sound.

3.6 Matrix Editor
The Matrix editor can be compared to an Arrange window for 
notes. Unlike the Arrange w indow, notes in the form of bars are 
shown, instead of sequences.
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This picture shows the Matrix window for the sequence 
“Strings C”.

• Open the Matrix editor by holding the ç button 
(Windows) or the O button (Macintosh), and double-
clicking the sequence “Strings C”.

You can see a keyboard along the left edge of the Matrix 
window. By using this keyboard, you can see the pitch of the 
notes in the display. A chord is represented by a group of over-
lapping bars. You can easily recognize that the note lengths of 
the second chord are unequal. Also, there is a wrong note in the 
4th chord.

Look at this sequence in the Event List as well, by choosing 
Windows > Open Event List. These inconsistencies are not so 
easily recognizable. Close the event list window again.

• Selectnotes from the first chord by rubber band selecting it.

• Now, grab the lower right corner one of the selected notes, 
and drag it to measure 26, so that the end of the bar connects 
with the beginning of the next chord.

Any edit to the length of one note, will affect all other selected 
notes equally in the Matrix editor.

• Repeat the process, to lengthen each chord so that it comes 
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up to the beginning of the next. This will create a legato 
effect on playback. Choose a larger zoom level to better be 
able to edit the events.
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The wrong note should now be deleted.

• Select the eraser from the toolbox, and use it to click the 
short note at position 28 1 1 1. The note will disappear.

You are now done editing the strings sequence. Practically 
every sequence in the tutorial song contains slight incongru-
ities, which you can easily repair in the Matrix editor. Select 
one or two more sequences and edit them as you did with the 
String part.

You will probably notice a big difference when optimizing the 
lengths of bass sequences.

3.7 Score Editor
Note events can be represented as notation, and can be edited 
in the Score editor. You can simply use the Score editor, as well 
as the other editors, to correct MIDI events. You can also print 
the notes here.

• Open the Score editor for the sequence “Bass theme”, by 
double-clicking on it.

The representation of notes is indeed “mathematically correct 
“, however, it’s currently barely readable—transposition, key, 
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and a lot more must be edited. Let’s go ahead and shape this 
sequence so that it is ready to print.
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Display Parameter Box
Click the check box in the left parameter area next to the term 
“Bass theme”. This opens the Display Parameter Box.

Style
The Display Parameter Box contains two functions that you 
can use effectively to correct the representation of notes. One 
of these is the style. There are 3 preset styles for the most 
commonly used transposition of display.

From the Flip menu “Style” select the style “Bass”. The score 
looks better immediately:

Text
For printing purposes, you may want to name the note system. 
Of course MicroLogic Fun allows you to input text in the Score 
editor.

• Select the text tool from the toolbox and click onto the field 
above the clef. A text input box opens. Type “Bass” here, 
and press R. The text will appear above the notation 
system; you can move the text in small increments with the 
mouse.

Yoiu can change the appearance of the text by using Options> 
Score Font.

Print
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If you have connected and installed a printer onto your 
computer, then you can immediately print the displayed page. 
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In the File menu, choose the menu option Print, and confirm 
by clicking OK.

In a few minutes, you should be holding a printout of the page 
in your hands.

Now It’s Your Turn …
If you have worked through the tutorial up to this point, then 
you know the most important functions of MicroLogic Fun, 
and already have a good overview of its operation, and wide 
range of functions.

The tutorial song contains useful output material for your own 
experiments, h which you can build on. We recommend that 
you take some time to work in depth with the tutorial song.

• Record more tracks (e.g. percussion).

• Replace existing tracks with your own recordings, e.g. piano, 
bass, drums.

• Look for mistakes in the sequences, and remove them by 
using the various editors.

• Use the Score editor to printout smaller sections of the song.
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Chapter 4

Using MicroLogic Fun

This chapter summarizes MicroLogic’s general operating func-
tions. But first, a quick word about this manual.

4.1 Conventions of this Manual

Menu Functions

Menu functions are written in this font: Function.

For functions which can be reached via hierarchical menus, the 
different menu levels are described as follows: Menu > Menu 
entry > Function.

Key Commands

When a function can be operated by a key command of the 
same name, you will see this symbol at the side of the text. If 
names differ, or if a function is only available as a key 
command, its name will be printed like this: Key Command.

Options and Parameters

The options you can set from the Preferences, and the param-
eters in dialog boxes are printed like this: Parameters.

Different parameter values are printed like this: Parameter 
value.

Detailed Explanations

& Sometimes, detailed explanations will be given for things which you don’t necessarily 
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need to know about to understand how to use MicroLogic. These are printed in this 
smaller font.
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4.2 The Mouse

Basic functions
Unless stated otherwise, the left mouse button is the one you 
should use whenever “the mouse button” is mentioned.

Clicking

Place the mouse pointer on the object (button, input field, etc.) 
and press the mouse button once.

Double-clicking

The same as clicking on an object, but you press the mouse 
button twice, in quick succession. You can set the appropriate 
time-span for this in the System Controls.

Grabbing or Click-holding

The same as clicking on an object, but you keep the mouse 
button held down.

Moving or Dragging

Grab the object and move the mouse (click-holding) to the 
desired position.

Mouse Input

Checkboxes
Checkboxes are square boxes which become “checked” when 
you click them to activate an option (or function). Click them 
again to remove the “check” and deactivate the option.
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Pull-down Menus
Pull-down menus open when you grab certain input fields or 
buttons. You make a selection within the menu by highlighting 
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the desired item and releasing the button. If you want to choose 
an item which is outside the visible section:

• move the mouse over the top or bottom edge of the menu; 
the further you move it, the faster you will scroll through the 
menu.

• on MacOS: hold down the S key as you do this. You can 
then let go of the mouse button and use the scroll bar on the 
right of the pull-down menu to scroll through it. When the 
highlight reaches the entry you want, release the S key

• on Windows: click using the right mouse button. You can 
then let go of both mouse buttons.

Mouse as Slider
You can set practically all the numerical parameters, (even note 
values or names) by grabbing the parameter value and moving 
the mouse up or down. If the parameter is made up of several 
separate numbers (e.g. song position), you can adjust each indi-
vidually.

Using the Mouse for In/Decrementing
All the parameter values which can be set using the mouse as a 
slider (and even some of the flip menu parameters) may also be 
increased or decreased in single units by 

• on MacOS: clicking on the top or bottom half of the value 
while holding down the ç key.

• on Windows: clicking with the left or right mouse buttons 
while holding down the A key.

Numerical Input
Double-clicking on a numerical parameter value opens an 
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input field. The previous value will be highlighted, to allow it 
to be overwritten by a new entry. You can also use the mouse to 
make a partial selection in an input field so that only the high-
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lighted part is overwritten. As long as the input field is open, all 
the keys may be used for inputting data only, and may not be 
used for key commands.

… by arithmetic

At any time, you can enter numbers by typing in an arithmetical 
operation, e.g. “+2” or “-5”, which then simply changes the 
current value by that amount.

… as ASCII-symbols

You can also input numbers as ASCII symbols: just put a ̀  or " in 
front of it, and the ASCII code will be input as a number. For 
example:

"! gives 33
"a gives 97

This function is particularly useful for entering text in SysEx 
strings.

Text Input
You input text names in the same way as numbers, but you only 
have to click the name fields once to allow input.

Numbered Names

As you might expect, you can give any number of selected 
objects the same name. If the name ends in a number, the 
number will automatically be incremented by 1 for each object. 
This allows you to name all the sequences on one track quickly.

Disabling automatic numbering

To turn off the automatic numbering, place a space after the 
number at the end of the name. All the selected objects will 
then end in the same number.
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Tools and the Toolbox
MicroLogic allows recorded data to be handled graphically. 
This means that you don’t have to carry out operations by 
inputting commands via number tables, but rather by manipu-
lating graphic “objects”.

When editing objects graphically, you always have two tools 
available at the mouse pointer position: one is already active, 
the other is activated by the right mouse button (Windows) or 
by holding down the C key (MacOS).

You change the currently active tool by clicking on the toolbox. 
The mouse pointer then adopts the shape of the tool you click 
on, so that you can tell what its function is by looking at the 
mouse cursor: the Eraser is used for deleting, the Scissors for 
cutting and the Glue tool for merging objects. To assign a tool to 
the right mouse button (C key on MacOS), click on the 
desired tool in the Toolbox, with the right mouse button (C 
key depressed on MacOS).

Effective Range of the Tools
• Tools are effective only in the working area of the window 

they were selected from (you can define individual tools for 
each opened window).

• A tool basically affects the objects you click on. If the clicked 
object is already selected, the tool operates on all other 
selected objects as well.

Selecting Tools
You select the tool you want to use by clicking on it in the tool-
box, either with the left or the right mouse button.

Info Line
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When operating many of the tools, an info line appears in the 
window for as long as the mouse button is held down. This info X
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line provides useful feedback about the type of operation you 
are performing.

During operations involving arrange objects, the line will look 
something like this:

From left to right, the Infoline displays: operation, mouse (or 
arrange object) position, arrange object name, track number, 
and length of the arrange object.

During operations involving events, the line looks something 
like this:

From left to right, the Infoline displays: operation, mouse (or 
event) position, event type, event MIDI channel, first data byte 
(i.e. the pitch for notes), second data byte (i.e. velocity for 
notes), and for notes: length of the note.

The Tools

Pointer

The Pointer is the default tool. The mouse cursor also takes on 
this shape outside the working area when you are selecting 
from a menu or inputting a value. Within the working area the 
Pointer is used for selecting (by clicking on objects), moving 
(by grabbing and dragging), copying (by holding down the O 
(Mac), or ç (Windows) key and dragging) and editing lengths 
(by grabbing the bottom right corner and dragging). Grabbing 
and dragging anywhere in the background allows you to 
“rubber band” multiple objects.

Pencil
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The Pencil is used to add new objects. You can also select, drag, 
and alter the length of objects.
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Eraser

The Eraser deletes clicked objects. When you click on a 
selected object all of the currently selected objects are deleted 
(as if you had used the B key). 

Text Tool

The Text tool is used to name arrange objects or add text to a 
musical score.

Scissors

The Scissors are used to split arrange objects, e.g. before copy-
ing or moving individual sections.

Glue Tool

The Glue tool is the opposite of the scissors: all selected objects 
are merged into a single object, which is given the name and 
track position of the first of the objects on the time axis.

Solo Tool

Grabbing with the Solo tool allows you to listen to only selected 
objects during playback. Moving the mouse vertically also trig-
gers any events the cursor touches, even when the sequencer is 
stopped.

Mute Tool

Clicking on an object with the Mute tool stops it from playing 
and places a dot in front of its name, to indicate that it is muted. 
You can unmute it by clicking it again with the tool. If multiple 
objects are selected, the setting of the object you’ve clicked on 
applies to all selected objects.

Zoom Tool

The Zoom tool allows you to zoom in on a section by “rubber-
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banding” it, right up to the maximum possible window size. To 
revert to normal size, single-click on the background with the 
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tool. You can also access this function via other tools by holding 
down the ç (Mac) or A (Windows) key.

Velocity Tool

In the Matrix editor, you can use the V tool to change the veloc-
ity of notes.

4.3 Window Functions
The basic functions of the MicroLogic windows are the same as 
those in other Macintosh, and Windows application programs. 
However, the display options in MicroLogic’s windows are far 
more extensive.

In MicroLogic, you can open different combinations of 
windows (even several of the same type) and adjust each one 
individually. All open windows in a song are constantly 
updated. This means that the windows update to follow the 
song position. Also, any alterations that you make in one 
window immediately update the display of all the other 
windows you are working with.

Working with Windows

Opening and closing Windows
All MicroLogic windows can be opened via the Windows main 
menu. After each menu item you are given the relevant key 
command, which allows you to open the window without using 
the mouse. You can open as many of the same type of window 
as you like.

Every time you use the Windows menu have a quick look at the 
key commands—that way you will soon memorize them. You 
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1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

Gl

Ix

TM

TM
Window Functions

You close windows by clicking on the close symbol in the top 
left (Mac, key command: Cw) or right (Windows, key 
command: A£) of the windows. 

If you hold down the O key as you click, all the windows of the 
active song will be closed.

Setting Window Size
You adjust window size by pulling the lower right-hand corner 
of the window, as with any window in the Finder.

As is usual for Windows, you can change window size by posi-
tioning the mouse over a Window edge, or corner and pulling.

Maximizing window size

The windows maximize button, in the upper right corner of the 
window, toggles the window between its maximum size, and 
the size it was before you clicked on the button (Windows > 
Zoom Window).

Selecting the Working Area

Scroll Bars

The scroll bars are situated along the right and bottom edges of 
a window, if you can only see one section of the working area in 
either the vertical or horizontal dimension.

You can move the visible section by clicking the arrows or grab-
bing and dragging the scroll slider. There are two things to keep 
in mind: 

• The size of the scroll slider in relation to the size of the entire
scroll bar corresponds to the size of the visible section in re-
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lation to the overall size of the window,
• the visible section changes as you move the scroll slider.
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X/Y Element
The X/Y element is situated at the bottom left corner of the 
window. By grabbing and dragging it you can move the horizon-
tal and vertical window section, as if you were dragging both 
scroll bars simultaneously.

Page Scrolling
Use the key commands Page Up, -Down, -Left and -Right to scroll 
one page up, down, left or right, as if you had clicked in the grey 
region above / below the vertical scroll bar, or to the left / right 
of the horizontal scroll bar. 

The key commands Page Top, -Bottom, -Left most and -Right most 
take the visible section of the working area to the top, bottom, 
left or right, just as if you had grabbed one of the scroll sliders, 
and moved it to one of its extreme positions.

Zooming
The telescope-shaped zoom symbols in a window are used to 
zoom in and out of the working area display. Clicking the 
smaller side of the telescope symbol reduces the size of the 
objects in the display, allowing you to see more objects in the 
same space (zoom out). Clicking the larger side enlarges the 
objects in the display (zoom in). In some windows, only one 
telescope is available, and this then handles both horizontal and 
vertical zooming simultaneously.

While “zooming”, the top left selected object is kept in the 
visible region, whenever possible.

Zooming Selectively

Zooming In On One Section of the Screen
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To enlarge a section of the screen to the size of the whole 
window, use the Zoom tool to “rubber band” the section you 
want. You can do this more than once.
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Reverting to the Previous Zoom Setting

Click on the background with the Zoom tool. This will return 
the zoom to the previous setting. If you have used the Zoom 
tool multiple times, then each click on the background will take 
the zoom back one step, until you reach the original zoom 
setting for the window.

You can call up the Zoom tool functions with any other tool 
(other than the pencil) by holding down the ç (Mac) or A 
(Windows) key. The pointer will display the previous tool, until 
you press the mouse button. As long as the button is pressed, it 
will display the Zoom tool.

Adjusting the Size of the Window Elements
If you move the mouse over the top left corner of the Arrange 
area, the mouse pointer turns into a crosshair. By dragging it, 
you can now adjust the size of the bar ruler, Arrange area, and 
Track list. You can also adjust the window elements in the Score 
and Matrix Editors using the same method.

Menus
On Windows, MicroLogic offers many different menu options, 
depending on which window is currently active. MicroLogic 
follows the standard Windows convention of offering a Main 
program window that contains any other local windows. All 
menu items are displayed along the top of the Main window, 
and the available menu items will change, depending on which 
local window is currently active.

On Macintosh, most of the functions are not found in the main 
menus, but appear as local menus. These are always in the 
menu bars of the MicroLogic windows where they are required.
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Key Commands
Some menu functions can be accessed via keystrokes or combi-
nations of keystrokes. The keys (or combinations thereof) are 
shown on-screen next to the menu entries.

Please note that you may assign practically any function to any 
key you like using the Key Commands window.

Menu Options with “…” in their Title
Three periods, like this: …, next to the menu function title 
indicate that the entry does not activate a function immedi-
ately, but instead opens a dialog box.

Dialog Boxes
In Dialog boxes, you can hit the highlighted button by pressing 
the R key, or by clicking with the mouse.

As is typical in Windows, you can toggle from button to button 
with the JK cursor keys.

Window Types
You can open as many windows as you want, including several 
of the same type. Even though the contents of all the windows 
are constantly updated, only one of the windows ever has the 
status of being the “top”, or “active” window. This is the 
window which is in the foreground when several normal 
windows are overlapping.

The active window can be recognized by its fully-shaded title 
bar. The main distinguishing characteristic of this window is 
that key commands only affect this window, and not any of the 
others. 

The only “floating” window offered by MicroLogic Fun is the 
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Transport window. This window will never be obscured by 
another window, even if you click on a window behind the float-
ing Transport. 
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Relationships Between Windows
The two buttons at the top left of a window (shown here), 
determine its relationship to the song position (Catch), or to 
other windows (Link).

Catch
The Catch function means that the visible section of a window 
follows the song position as the song plays. 

If the button with the walking man on it is lit (i.e. if it is blue), 
the window’s display follows the song position as the song 
plays. If the button is not lit, the display does not update, even 
when the song position line moves past the right edge of the 
visible portion of the window.

Automatic Catch Disabling

If you move the visible section manually, Catch is automatically 
switched off, so that the new section you have chosen doesn’t 
then disappear, as the display is updated to the song position 
line.

Autocatch

The function Enable Catch when Sequencer starts (Options > 
Settings > Global Preferences…) always enables Catch mode 
whenever you press play or pause.

Link
Clicking on the link button activates Link mode. This means 
that the window always shows the contents of the object 
selected. Selecting a different sequence in the Arrange window 
will cause the display of the linked editor to switch to that 
sequence.
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4.4 Selection Techniques
Whenever you want to carry out a function on one or more 
objects, you have to select the object(s) first. This applies to 
arrange objects and individual events alike. Selected objects 
are either highlighted, or will flash (in the Score editor).

The selection status of an object applies to all windows. An 
object selected in one window will also be selected in all other 
windows that display that object. Changing the top window 
doesn’t affect the selection (as long as you don’t click on the 
background, which deselects everything. Be sure to click on 
the window’s title bar).

Selecting Individual Objects
Individual objects may be selected by clicking on them, and 
deselected by clicking in the background, or by selecting 
another object.

Selecting Alphabetically

The T key selects the next alphabetical object. In the Arrange 
window pressing any letter key selects the first object whose 
name begins with this letter, providing there is no Key 
command assigned to this key.

Selecting Several Objects
To select several non-contiguous objects, hold down S as you 
click them. As you click on subsequent objects, the previous 
selections are retained. This also works with horizontal or 
rubber band selection.

Horizontal Selection

To select all objects in a track, click on the track name in the 
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Track list. In the same way, you can select all notes of a certain 
pitch in the Matrix editor by clicking the relevant key on the 
screen keyboard.
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Edit Operations

In Cycle mode, the above selects only the events within the 
Cycle zone.

“Rubber-Banding”

To select adjacent objects, click on the background and drag a 
“rubber band” over them.

All objects touched, or enclosed by the rubber band will be 
selected.

Toggling the Selection Status

When you make any selection (including by rubber band or 
horizontal selection), holding down the S key at the same 
time will reverse the selection status of the objects (Toggle Selec-
tion).

Selecting All Objects

To select all objects, select Edit > Select All.

Deselecting All Objects

You can deselect all objects by clicking on the background or 
using the key command Deselect All.

4.5 Edit Operations
The edit menus for MicroLogic’s various windows all take the 
same form. The first item is Undo. Below Undo are the typical 
clipboard functions(Cut, Copy, Paste) and at the bottom the 
selection command Select All.

Undo
Undo allows you to reverse the previous edit. In Options > 
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Settings > Global Preferences, you can disable the warning 
message that normally appears when you activate Undo, by 
checking the Disable safety alert for Undo box.
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The key command for Undo is Cz (Mac) or çz 
(Windows).

The Clipboard
The clipboard is an invisible area of memory into which you cut 
or copy selected objects, so that you can paste them to a differ-
ent position.

The clipboard is independent of any particular song, which 
means you can use it to exchange objects between songs.

Cut
All selected objects are removed from their current position and 
placed in the clipboard. The previous contents of the clipboard 
are overwritten in the process (Cx (Mac) √x (Windows)).

Copy
A copy of all selected objects is placed on the clipboard. The 
selected objects are also left in place. Here too, the previous 
contents of the clipboard are overwritten (Cc (Mac) √c 
(Windows)).

Paste
All objects from the clipboard are copied to the top window. 
The clipboard is not erased in the process (Cv (Mac) √v 
(Windows)).

The contents of the clipboard are added at the current song 
position (if they are events or arrange objects). The song posi-
tion is incremented by the length of the pasted objects.

In the Arrange window, the contents of the clipboard are pasted 
to the selected track. If events are pasted in the Arrange 
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window, either a new sequence is created for them, or the 
events are added to a selected sequence.

Any objects that existed previously are unchanged.
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General Functions of the Editors

Clear
With Edit > Clear any selected objects are erased. Clear has no 
effect on the clipboard and is the same as pressing the B key.

4.6 General Functions of the 
Editors

Control Output via MIDI
Switching on the MIDI Out button causes MIDI events to be 
output when they are added, selected, or edited. This allows 
you to audibly monitor every edit, whether you are scrolling 
through the Event List (automatic selection) or transposing a 
note.

Automatic Scroll Functions

… scrolling to the Song position

The button with the walking man on it activates the Catch 
function, which means that the window view will always show 
the current song position.

… scrolling to the selected event

The key command Scroll to Selection allows you to automatically 
move the window, so that the first of the currently-selected 
events is visible.

Deleting Events
The basic techniques are the same as for deleting sequences:

• the B (delete) or ∂ key deletes all selected events,
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• the Eraser also deletes all selected events, and any events 
that you click with it (whether previously selected or not).
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Changing Display Levels in Score
In the Score Editor, double-clicking on the background takes 
you to a higher display level. Unlike the other editors, in the 
Score Editor individual events can also be edited in higher 
display levels. Double-clicking on a staff (at an empty point) 
takes you back to a lower display level.

Don’t worry if all this sounds a bit confusing. In fact, the whole 
process of changing levels is much easier to grasp if you simply 
try it yourself. Read first, then experiment with the various 
editors in one of the Tutorial songs.

4.7 Key Commands
You can activate all MicroLogic’s functions via key commands. 
The Key Commands window is where you assign key 
commands to the keys.

Whenever this manual mentions a key command, this refers to 
a command which can be called up by a keystroke. This allows 
you to completely customize MicroLogic to suit your own 
working style.

If any function described in this manual is also available via a 
key command with the same name you will see this symbol.

Your personal key assignments are stored (together with the 
settings of the Preferences pages) in a file called 

• “Logic Preferences” in your Macintosh’s System folder (in 
the Preferences folder, to be precise). 

• “Logic.PRF” in your PC’s Windows folder

You should:

• make a backup of this file at another location on your hard 
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disk;

• make a floppy disk backup of it in case you need to use a 
MicroLogic system on another computer.
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When you install updates to your version of MicroLogic, your 
personal key commands will remain unaltered.

Special Keys
Some keys have special functions:

• The modifier keys S, ç, and A (Windows), or ç, O, 
and C (Mac) can only be used in conjunction with other 
keys.

• The backspace key (D) has the fixed function “delete 
selected objects”. It can only be assigned a function in 
conjunction with the modifier keys.

• The + and _ keys increase or decrease any selected para-
meter value in single units. However, they can be assigned 
different functions which overwrite this function.

Key Commands Window
The Key Commands window can be opened by selecting 
Options > Settings > Key Commands.

All the available key commands are listed on the right side. 
They are grouped according to the following categories:
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• Global commands
• Functions affecting all windows (various windows)
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• Functions affecting Arrange Window and all Editor windows
(Arrange various sequence Editors)

• Functions for the Arrange window
• Functions for the Score Editor (Score window)
• Functions for the Event List Editor (Event window)

A symbol in front of the description of the function indicates 
that the function is only available as a key command. To the left 
you can see the currently assigned key.

Assigning a Function to a Key
• Click the Learn Key button.
• Select the desired function with the mouse.
• Press the desired key, if necessary together with the desired

modifier key(s) (S, ç, and A, or ç, O, and C).
• If you want to make another assignment, repeat steps 2 and

3.
• Deactivate Learn Key!

Deleting Assignments
• Click on Learn Key.
• Use the mouse to select the function whose keyyou want to

delete.
• Press D.
• To erase more assignments, repeat the second and third

steps.
• Deactivate the Learn Key button.

Checking the Function of a Key
Deactivate Learn Key, and press the key whose function you 
want to check. The function will be automatically selected, and 
displayed in the middle of the window.
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Filtering the Display 
You can use the Hide Used and Hide Unused buttons to hide all 
the used, or unused key commands.

All the other Key Commands window functions remain avail-
able for you to use.

Finding Key Commands
Due to the large number of possible key commands, it can 
sometimes be difficult to find a particular one. For this reason, 
MicroLogic offers a Find function, which lets you search for a 
key command by typing in its name (or a part thereof).

Simply click in the white space to the right of the Find: button 
and enter the string of characters you’re searching for. The 
window will display only those key commands containing that 
character string (plus the selected command, even if it doesn’t 
contain that string) if you then click find or return R.

The Key Commands window remains active, even in Find 
mode; you don’t have to leave this mode to continue making 
assignments.

The Find function is not case-sensitive, it makes no distiction 
between upper, and lower case characters.

The Hide Unused and Hide Used buttons work in combination 
with Find. This means you must switch off both in order to see 
all the commands that fit the search criteria, regardless of the 
commands’ current assignment.

The Find: button switches Find mode off and on. The button is 
automatically activated if a string of characters is entered.

4.8 Song Administration
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All events, other objects and settings (apart from the Prefer-
ences and key commands) are components of a song. Songs are 
handled in the File menu.
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New Song
When you first launch MicroLogic, it opens a preset standard 
song. After just a short time, you will have learned how to make 
your own adjustments to the song settings, and will no doubt 
want to keep these settings for use in future songs. The best 
way to do this is to set up your own “default song”, and save it 
in the same folder as the MicroLogic program, calling it “Auto-
load”.

Autoload Song
If there is a song in the MicroLogic folder called “Autoload”, 
MicroLogic will automatically load it when it is booted up. 
When you’re ready to start work on a new song, simply save the 
Autoload somewhere else under a new name using File > Save 
as… and begin. This file can then form the basis for your new 
song.

Creating a new Song
If you select File > New, MicroLogic checks to see if an “Auto-
load” song is available and opens it automatically if it is. If not, 
a new default song is created. If an “Autoload” song is available, 
you will be asked if another copy of the Autoload song should 
be made (to avoid accidentally erasing it) or if a completely new 
default song should be created.

Opening Default Song
If you hold down the O (Mac) or ç key (Windows) while 
selecting File > New, a new default song called “Untitled” will 
be opened. 

Loading a Song
76
Emagic
MicroLogic Fun 

You use File > Open to bring up a typical file selection box. X
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Checking/Repairing Songs
If you double-click on the display on the Transport which 
shows the remaining number of free events, the memory will 
be reconfigured. At the same time, the current song will be 
checked for any signs of damage, structural problems and 
unused blocks.

If any unused blocks are found—which normally shouldn’t 
happen—you will be able to remove these, and repair the song.

Saving Songs
When you select File > Save the current song will be saved with 
its current name intact.

If you don’t wish to overwrite the last version of this song saved 
under this name (which is what will happen if you just use File 
> Save, try using File > Save As…. Here, you can enter a new 
name for the song (and select a new directory or even create a 
new folder). The next time you save using straight Save, the 
new name and file path will be used.

Closing a Song
File > Close closes the currently active song. If you have made 
any changes since the last time you saved, MicroLogic will ask 
you if the song should be re-saved before closing, to preserve 
the changes you have made.

Quitting the Program…
Choose File > Quit to leave the program. If you have not yet 
saved your last changes, you will be asked if you want to do so 
before quitting (press R to save).
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Transport Functions

5.1 Transport Window

The Transport window is a small, floating window in Micro-
Logic, which contains the controls for operating the playback, 
cycle, and other transport functions. The Transport window is 
called a “floating window”, because it cannot be obscured by 
other windows, it is always on top.

Display Options
You can open the transport window, if it has been closed, by 
selecting Windows > Open Transport or çC7.

Indicator Options
If you click-hold on the small downward pointing arrow on the 
lower right-hand side of the Transport window, a flip menu will 
appear, allowing you to change its layout. 

Legend
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Here, you can switch on a description of the buttons and 
display fields. We recommend that you take advantage of this, 
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especially in the beginning. This way, you will be able to learn 
the ropes more quickly, and avoid errors. 

Position Slider
You use this option to activate the “position-slider” on the 
bottom edge of the transport window. 

The position slider represents the entire length of the song. 
With this you can jump to any position in the song almost 
immediately, albeit not very accurately. Click on the slider and 
hold down the mouse button. When you move the mouse hori-
zontally, the slider will move accordingly. The gray bar tells you 
where you are in the song, relative to the entire song length. 
The position indicators and the song position line (see below) 
are also influenced by this.

Smaller/Larger
The Transport window can be displayed in different sizes, 
which you select using smaller/larger. When you start Micro-
Logic, the Transport field will be opened at its smallest display 
size. The parameter Size also allows a direct selection.

Parameter Fields and Indicators

Position Indicators
The position indicators in the Transport window show you the 
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current song position in two different formats. 

The lower portion displays Measure Position, in measures, beats, 
diplay format units and clock ticks. How it is divided depends 
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on the time signature, and the Display Format value, which you 
can also set in the Transport window (see below). Normally, the 
four fields would be (from left to right): measure, quarter notes, 
sixteenth notes, ticks. 

A tick is the smallest possible subdivision of a measure in which 
a sequencer can divide the time axis. In MicroLogic a tick is 
1⁄3840 of a note.

Clicking the small gray square button to the right of the indica-
tors sets these to zero. 

Position Markers (Locators)
MicroLogic allows you to define two locator points. This is 
analogous to the locator points that can be found on some tape 
recorders. They make it possible to automatically go to, or play 
certain passages. The locator points, below the position display, 
are the cycle locators. With these, you can define a part of the 
song to be continuously repeated by MicroLogic in cycle mode.

Skip Cycle
When you are playing the song you can skip a passage, which is 
useful for trying out the musical effect of various transitions. 
Drag out the skip cycle region from right to left in the bar ruler.

If there is already a (normal) cycle region just move the left 
locator after the right locator. The skip region is shown as a very 
thin strip at the top edge of the bar ruler.

When the SPL reaches the right locator it skips to the left loca-
tor (i.e. the “right” and “left” locators swap positions).

Skip cycle is a quick way of leaving out a passage in an Arrange-
ment, without having to physically delete it from all the tracks, 
make a backup, etc. You can also use it when editing, to leave 
out those parts of the song which you don’t want to be affected 
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Tempo
The song tempo is shown in beats per minute (bpm). You can 
set the tempo in increments of 1/10000th of a beat, anywhere 
from 0.5 to 9999 bpm. The song tempo is then set for the entire 
song. 

You can make changes to the tempo during the song (ritar-
dando, accelerando), using the tempo list.

Tempo List

In the tempo list, you can insert and edit changes in tempo.

You can enter a tempo event at anyposition. The tempo list 
controls the song tempo, and the current tempo is always 
displayed in the transport window. 

Here’s how to open the tempo list:

• Select Options> Tempo > Tempo List from the menu. 

Here’s how you insert a new tempo event: 

1. Set the song position (SPL or transport window) at which 
you want to insert the event. 

2. Click on the Create button in the tempo list window, or
click on an existing tempo event with the pencil.

Tempo events in the tempo list can be edited or deleted, just as 
they would in the event list (see chapter 6.)
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Free Memory
This indicator informs you of remaining available memory, 
measured in events. If MicroLogic warns that there is too little 
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memory for a certain operation, you can optimize the memory 
automatically. 

Double-click the Free Memory Field. A dialog box will appear 
asking if you want to reorganize the memory. If you confirm 
this, your computer’s RAM will be reconfigured, creating addi-
tional space for data. 

Time Signature and Display Format
Here you can set the time signature for your song, by grabbing 
the numerator or denominator, and sliding the mouse to set the 
desired value. The time signature change will take effect at the 
current song position. This way, you can insert time signature 
changes in your songs, by simply moving the SPL to the 
desired position, and changing the time signatire display in the 
Transport. The new time signature will appear in the bar ruler, 
and will remain in effect until you insert another at a later point.

Beneath the time signature field, you will find another subdivi-
sion, which gives the Display Format value for the song. 

MicroLogic uses this Display Format value: 

• as the third field in the position display for the locators and 
the event list.

• for subdividing the bar ruler (see below).

• as a MIDI-metronome division value.

• as step size for the moving of notes in the Score editor.

MIDI Indicator
The MIDI indicator field gives you a real time diaplay of MIDI 
events MicroLogic is currently receiving or sending. This is 
useful to test the connections between MicroLogic and your 
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MIDI equipment. 

This field also allows you to send a MIDI reset command. 
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MIDI Reset

With the MIDI Reset, you can switch off stuck notes.

• Click in the MIDI indicator field in the Transport window. 

• MicroLogic will send a simple MIDI Reset. If this does not 
help, try a “Full Panic”:

• Double-click the MIDI Indicator.

The field will display“Full Panic,” and MicroLogic will send a 
Note-Off event for every single note on each of the sixteen 
MIDI channels.

End of Song 
The small field on the lower right-hand edge of the Transport 
field shows the End of Song position. Among other things, the 
scale of the vertical scroll bar, and that of the song bar size 
themselves by this. In order to change the End of Song posi-
tion, click-hold on the current value, and scrub the mouse up or 
down. You can also set the End of Song marker in the bar ruler 
with the mouse (see below). 

Transport Functions
The following functions serve to control MicroLogic’s move-
ment and status, and are similar to the transport functions of a 
tape machine. In this sense, you can operate MicroLogic 
exactly as you would a cassette deck, or a studio tape 
machine—but more easily, of course, and without waiting for 
the tape to rewind. 

Instead of using the buttons, you can also use the keys of the 
numeric keypad, described below. This is especially practical if 
you want to playa MIDI keyboard at the same time. 
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Record
Click this button to start recording from the current position. 
The recording will begin after the count-in (see the section: 
Song Settings, pp. 4–92 ff.)xref. 

Default key: *

Pause/Continue
stops the recording or playback until you click on the button 
again.

Default key: ;

Play
starts playback at the current song position. 

Default key: ‰

Stop
stops the playback. To continue from the same place, use the 
play function again. 

Default key: =

Fast Forward and Rewind
With these two buttons you can move forward or backwards in 
the song. You can influence the shuttle speed with the mouse. 
Click on the fast-forward button, and hold down the mouse 
button, and MicroLogic shuttles at a faster speed. The further 
you move the mouse to the right, the faster the MicroLogic will 
shuttle. The rewind function works in a similar manner, except, 
of course that you would move the mouse to the left, to increase 
the shuttle speed. 
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Mode-Buttons
The mode-buttons, unlike the transport buttons, do not trigger 
any actions, but rather put MicroLogic into a certain mode. 
Clicking on one of these activates it, and it remains activated 
until you click on it again. 

Cycle (Repeat Mode)
You can repeat a section of your song by using the cycle func-
tion (repeat mode). This is discussed in more detail in the 
section: Cycle Mode, pp. 5–113 ff. xref

Metronome
This button allows you to turn the metronome on and off sepa-
rately for playback and record. The play or record status is 
remembered when you activate the metronome. 

1. Click briefly on the button to turn the metronome on or 
off.

You can also access the recording and metronome settings 
directly from the metronome button:

2. Click-hold on the metronome button. 

A flip menu will open.

3. Select the option you want.

Setting the MIDI Metronome

You can select which note numbers and MIDI channels the 
MIDI metronome will use.

Here’s how you set the MIDI Click:

Select Options > Settings > Metronome Settings, and activate 
the option MIDI Click.
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Select the Port you wish the metronime to send to. Click-hold 
the Port parameter, to open a flip menu. Under Bar, set the 
parameters for the note that the metronome will send on beat 
one of each measure. You may also set a velocity for the note. 
Under Beat, set the note and velocity you want for the other 
beats in each measure. 

1. Click on the bar and beat buttons to activate them.

2. Click on the record button in the transport window or 
press * on the numeric keypad. 

MicroLogic will begin recording. You will hear the metronome 
clicks from your MIDI sound module. 

3. Here is a review of the parameters that you can set for the 
MIDI Metronome:. 

Cha MIDI channel.

Note Note and, with it, the drum instrument (e.g. 
Cowbell, Woodblock).

Vel Velocity value. Usually, you will set the velocity 
for the Bar a bit higher than the Beat, to accent 
the downbeat of each measure.

5.2 Bar Ruler

You will find the bar ruler in all MicroLogic Fun windows, 
except for the Event list. The bar ruler helps you visually locate 
the position of sequences (Arrange window), note bars (Matrix 
editor) and notes (Score editor).

The bar ruler is not just a visual display. You can carry out the 
following functions on it with the mouse: 
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• Move to different positions in the Song (Song Position 
Line);

• Set start and end points for Cycle Locators.

The subdivision of the ruler is displayed according to the time 
signature values in the Transport window. When you change 
these, MicroLogic reacts immediately by changing the settings 
in the bar ruler. 

EXAMPLE: Set the time signature in the Tutorial-Song to 2⁄4 or 
8⁄4, and note the changes in the bar ruler. When finished, set the 
value back to what it was.

As with other displayed elements, the bar ruler is influenced by 
the horizontal zoom factor. If you set locators, or want to change 
the song beginning or end, you can set the scale of the ruler as 
needed. 

Setting the Song Beginning and End
As with sequences, a song has defined beginning and end 
points. These two markers are represented in the bar ruler by 
two rectangles, which can be moved with the mouse. 

Beginning of Song
Normally the song will begin at position “1 1 1 1.” You can, 
however, alter this, perhaps to insert a program change, or an 
upbeat before the beginning of the song. 

Grab the start of song marker with your mouse, and drag it to 
the left. The bar ruler will move correspondingly to the right, 
and the information line will show you the new beginning of 
the song. Release the mouse button at the desired position. 

End of Song
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A MicroLogic Fun song can be practically limitless in length. 
Normally MicroLogic Fun sets the song length to 200 
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measures. This is automaticallyextended, however, as soon as 
an object goes past this position. You can manually set the end 
of song to any position you like. Bring the end marker into view, 
by either moving the horizontal scroll bar to the right, or 
making the horizontal zoom factor smaller, until the marker is 
visible. Grab the marker, and drag it to the desired position. 

If possible, set the song end marker to the actual end of the 
song. That way the horizontal scroll bar will be scaled accord-
ingly, and its range limited to the length of the song. 

Song-Position Line
The song position line is a vertical line inside the window 
(Arrange window, Matrix and Score editors), which displays the 
current position of the song. You can move to any position in the 
song with the song position line. 

The song position line in MicroLogic is somewhat similar to 
the recording head of a tape machine. 

Jump to a Certain Position
Click on the position you want in the lower third of the bar 
ruler, to move the song position line to that point. 

Shuttling
Holding down the mouse button in the lower third portion of 
the measure ruler allows you to move the song position line 
back and forth in the song. If, in doing so, you move the song 
position line past the visible section of the window, the view 
will shift.

Start and Stop
By double-clicking in the lower third of the bar ruler, you can 
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start or stop the playback from that position. 

You can also choose between a thin or wide song position line. Tip
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5.3 Cycle Mode
In the cycle mode, you can isolate a passage of the song to be 
repeated. 

You may want to have a passage played repeatedly so that you 
can: 

• edit events within the cycle zone

• practice a section for recording

• Record multiple takes

You can activate the cycle mode (repeat function) by:

• clicking on the cycle button in the Transport

• configuring a cycle bar in the bar ruler, by clicking in the 
upper portion of the bar ruler

Setting Cycle Locators 
The area to be played in cycle mode is defined by the cycle 
locators.

Their values are shown in the Transport window, and can be set 
there. See the section Position Indicators, pg 5-101.

Cycle Bars
When the cycle button is activated, you will see not only the 
cycle locators in the Transport window, but also a white bar in 
the bar ruler, that encompasses the cycle zone.

You can move the bar by grabbing it in the middle. To change 
the bar’s start or end position, grab the bar on the lower left or 
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right corner, and drag the edge to the desired spot. This way, 
the left position can even overlap the right, or vice versa. By 
holding down the S key, you can set both borders as you like 
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by clicking. This way you can also move the visible window 
section to set particularly long cylce zones. 

You can delete the cycle bar by moving one of the bar’s borders 
to meet the other. This will deactivate cycle mode.
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Arrange Window

6.1 Structure of the Arrange 
Window

The Arrange window is the heart of MicroLogic Fun. Study it 
closely because it is the view of the program that you will see 
most often when you’re working with the program. 

It appears in the first screenset whenever you start MicroLogic. 
You can also open it with Windows > Open Arrange.

The arrange area 1 is where all MIDI information is recorded 
on horizontal “tracks”. Individual MIDI or audio recordings are 
called “sequences”, and are displayed as beams. Above the 
arrange area is the bar ruler which displays position information 
2.

To the left of the arrange area is the Track list 3. This is where 
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you determine which “instrument” should play the MIDI 
information on each track. You can make various settings for the 
instruments in the instrument parameter box 4 in the lower left 
corner.
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Because the sequences are arranged graphically, you can also 
use specialized mouse tools from the tool box 5 to help you 
perform different operations.

The sequence parameter box 6 is where you set the playback 
parameters for the individual sequences such as transposition 
and quantization.

In the upper left corner 7 is the Catch button.

Tools
Like other windows the Arrange window also provides a tool-
box for you to use.

Please refer to chapter 4. 

6.2 Tracks
As a reminder: A song is composed of any number of tracks, to 
each of which one of the available MIDI channels can be 
assigned. On every track there can be any number of 
sequences, which are played on the track’s MIDI channel. 

Track List
In the Track list each track is numbered from top to bottom. 
During playback a small “level indicator” appears over the 
track number. This indicates the velocity of the recorded notes, 
and beocomes red when a maximum velocity value is played. 
The little “c” stands for Controller command.

You can move the sequences, delete them, or move them to 
another track. Tracks, and sequences on tracks can be freely 
moved around, making this, which is much more flexible than 
working with a tape recorder.
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Tracks can also be created, deleted or rearranged.
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These functions will be described in more detail, in the follow-
ing sections.

Assigning a MIDI Channel
For every track you can set whichever of the 16 MIDI channels 
you want. All of the sequences (and their contents) on the track 
will be sent on the set channel. The track setting for channel 
will override the individual channel settings for the MIDI 
events within the track. MIDI port and channel can be set here:

In addition to the sixteen MIDI channels, there is a special 
setting: 

All In this case, the track does not have a particular 
MIDI channel setting. Instead, each event is 
sent on its recorded MIDI channel. Use this 
possibility when, for example, events with 
different MIDI channels (such as drums, piano, 
bass) are combined on one track. 

You can easily change the MIDI channel of an event in the 
event list. 

With All selected, click on the channel column of the track and 
hold down the mouse button. A flip menu will appear from 
which you can select any of the other track instruments or No 
Output.

No Output The MIDI events of the track in question are 
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not sent; the entire track is muted. You can use 
the “No Output” option to temporarily put a 
track on the back burner.
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Adjusting the Sound of a Track
The Prg, Vol and Pan parameters transmit program changes, 
volume controllers (#7) and pan controllers (#10) respectively.

If there is no check in the respective box the default value is 
used. The corresponding value is only transmitted if you place 
a check in the box (by clicking it). If there is already a check in 
the box, any value alterations you make are transmitted imme-
diately.

A program change may be selected on the right, via a flip menu; 
volume and panning are set using the mouse as a slider. 

To the left of the program number, there is an extra parameter 
which is used for Bank Select. If your sound source can receive 
Bank Select messages (MIDI controller #0 or #32—check in 
your synth manual for format details), you can switch between 
different banks, each containing a maximum of 128 sounds. 

As many devices cannot receive these messages, you can deac-
tivate this parameter.

Recording Program Changes, Volume or Pan controllers

Any of the types of events that can be transmitted by checking 
the right square in the instrument parameter box can also be 
stored when in record mode. For example, in record-pause 
mode, you can store program changes at specific positions in the 
following way:

• Remove the “x” in the box next to Prg (or Vol, or Pan);
• Click on Pause, then Record;
• Move the Song Position line to the place you want;
• Choose the sound (program) you want (or the volume/pan

setting you want);
• Click on the box next to Prg (or Vol, or Pan). Each selected

event will be sent and recorded.
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Click on Stop to exit Record mode.
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Selecting an Icon
Every MIDI channel can be assigned an icon of your choice. 
Normally you will call up a particular sound for each MIDI 
channel. In this case, use an icon that represents the sound or 
the “instrument”. Although the icon has no direct effect on 
what you will hear, it will help you keep track of the sounds you 
are using for each track of your song. 

EXAMPLE: If you assign a drum icon to MIDI channel 10, 
then you can tell at a glance which tracks have drum sounds. 

To select an icon, click-hold on the current one. A flip menu 
will appear, from which you may select another icon. 

Most of the icons represent particular musical instruments. You 
can see how the appropriate icons have been used in the Tuto-
rial-Song. 

Creating a track
To create a new track, click on the track number you want and, 
choose Track > Create MIDI Track in the menu. MicroLogic 
Fun produces an empty track at the position you have selected 
and pushes the following tracks down accordingly.

Appending a New Track
You can append a new track to the end of the track list by 
double clicking on the free space directly below the track list. 

Moving a Track
A track can be moved to any other position in the track column. 
Just grab the track number, and drag it to the position you want. 
MicroLogic Fun will automatically reorganize the tracks, and 
move the following tracks accordingly. 
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Two neighboring tracks can be switched in this way. Tip



Chapter 6
Arrange Window

Deleting a Track
To delete a track, select the track in the track column and 
choose Track > Delete Track in the local menu of the Arrange 
window. If there are sequences on this track, MicroLogic Fun 
will ask you via dialogue box if these should be deleted, as well. 

Selecting all Sequences in a Track
If the cycle mode is not active, then click on the track you want 
in the track column. All sequences of this track will be selected, 
and are available for further operations. 

Selecting Sequences within the Cycle Locator 
Use the cycle function if you want to select sequences which 
are only within a certain span of time. To do this, mark the 
appropriate cycle area in the bar ruler, and click on the track you 
want in the track column. Now, only those sequences within 
the cycle area on the track are selected.

Deleting the Contentsof a Track
If you choose a track and press ∂ (Windows) or D (Macin-
tosh), all the sequences on this track will be deleted. The track 
itself, however, will remain. 

You can also delete sequences within a certain section of time 
by marking it off with the cycle locators (see above). 

Muting Tracks
In MicroLogic Fun you can mute tracks completely, without 
first having to select all of the objects in the track.The Mute 
Button can be found, just to the right of the track number. Press 
this button, and the track will be muted. Click the button again, 
to unmute the track.
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6.3 Arranging Sequences

What is a Sequence?
A sequence is basically a container that holds MIDI data, such 
as note events or controller messages. A segment of music 
contained in a sequence can be manipulated as a whole. In the 
Arrange window, a sequence is represented as a horizontal bar 
in a track. 

Creating an Empty Sequence
To create an empty sequence—perhaps to manually insert 
notes in the Score or Event List editors with the mouse, click 
on the position you want, in the Arrange window with the 
pencil tool(see below).

Shifting Sequences in Time
To shift a sequence or sequences in time, grab it somewhere in 
the middle, and drag it to the position you want. If you go past 
the currently visible section of the Arrange window, Micro-
Logic Fun will automatically scroll to the window section you 
want. 

Instead of this, you can also move sequences to the clipboard 
using Edit > Cut, and then move them to another position with 
Edit > Paste. 

The paste position is determined by the placement of the song 
position line. 

Copying Sequences
To copy a sequence, move it (see above) while holding down 
the ç (Windows) or the O (Macintosh) key. This will create 
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a copy at the new location, while leaving the original at its start-
ing position.
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Instead of this, you can also copy sequences to the clipboard 
using Edit > Copy, and then move them into another position 
with Edit > Paste. 

Make sure you set the song position line to the target position 
first, and then highlight the target track. The sequences will be 
inserted into the track, starting at the song position. 

Moving/Copying onto another Track
Sequences cannot just be moved in time, but also to other 
tracks. Grab the sequence, and move it onto the track you want. 
To do this, use the help line that appears in the local menu bar 
while moving, to make sure that the position in time does not 
change. Of course, you can use the described cut, copy and 
paste functions to move or copy sequences to another track.

Changing the Length of a Sequence
You can adjust the start and end points of a sequence, thereby 
also changing its length. To do this, grab the lower right-hand or 
left-hand corner with the mouse, and move the mouse in the 
direction you want. 

Be aware that the start point of a sequence can’t be later than 
the first MIDI event of the sequence. If you do not need certain 
events at the beginning of the sequence anymore, then remove 
this piece with the scissors. 

The end point can be moved as far as you want to the left, as 
long as it is not before the song start and the first MIDI event. 

… of Multiple Selection …

You can change the length of multiple objects in the same way. 
The length will be changed by the same absolute value.
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… to the same absolute length

If you want to make all selected sequences the same absolute 
length—even if they had different original lengths—simply 
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hold OS (Mac) or çS (Windows) while changing the 
length (just as in the Matrix editor or the Event List).

…Using a Finer Grid
All these operations (moving/copying, lengthening/shortening) 
snap to the bar or beat grid (depending on the current resolu-
tion of the bar ruler and the setting of the zoom function). 
However, there are two ways of reducing the grid:

Touch an object first.

Display Format values as grid scale:
ç (Mac) or A (Windows) + operation.

No grid (ticks as grid scale):
çS (Mac) or AS (Windows) + operation.

Hold these keys during the particular operation.

Let’s say you want to shorten a sequence in a 4/4 bar so that the 
“4” is played but not the “4 and” of the last bar. Enlarge the 
screen display until you can see quarter notes in the bar ruler. 
Now grab the bottom right corner of the object and move the 
mouse to the left until the sequence is shortened by one quar-
ter note. Then press (and hold) ç or A and move the mouse 
carefully to the right until the sequence has become one divi-
sion longer. While you are doing this, the info line shows the 
track number followed by the current length of the object in 
bars, beats, divisions and ticks. The three right-hand numbers 
should be “3 1 0”.

Dividing Sequences
Select the scissors. Now click the desired sequence(s) and keep 
the mouse button held down. The info line shows the current 
position of the mouse. When you release the mouse button, all 
selected objects are cut at the relevant position. The grid is 
101
User Guide 
Version 4.0 – English 

B

C

based on the Display Format value. This value is displayed and 
may be altered on the Transport window, just below the Time 
Signature indicator.
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If any notes overlap other notes by more than a 1/16 note, a 
dialog will appear on-screen:

KEEP (default) leaves all notes unaltered. The sequence is cut 
as usual, but when you do this, you can end up with notes in the 
left-hand half that are much longer than the sequence now is. 

SHORTEN truncates all overlapping notes, so that they end at the 
point where the sequence was divided.

SPLIT divides overlapping notes across the two sequences 
created when a cut is made; two separate notes are created, with 
the same pitch and velocity, and the same total length as the 
original note.

…multiple Division with the Scissors

If you hold down the O key (Mac) or ç key (Windows) while 
cutting an object with the scissor tool, the selected sequence 
will be cut into several pieces, whose lengths are determined by 
the length of the first segment.

For example: To divide a 16-bar sequence into 8 2-bar 
sequences, cut the sequence at the start of bar 3 while holding 
down the O or ç key.

Merging Sequences
You can merge two or more selected sequences in a track into a 
single sequence by clicking on one of them with the glue tool.
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Muting Sequences
Often when you are arranging, you will want to test musical 
ideas out by muting certain objects. This is what the Mute tool 
is for.

You can mute individual or selected objects by clicking on them 
with the Mute tool. They are then displayed with a dot before 
the object name. Clicking a muted object reverses this state 
(unmuting).

You can perform the same function using the Mute Sequences key 
command.

Soloing Sequences
The Solo tool enables you to solo individual or selected objects 
by clicking them, and holding down the mouse button. You can 
also scrub the object by horizontally moving the mouse. If 
MicroLogic is in play mode, solo playback starts as soon as you 
stop scrubbing. Release the mouse button to end solo listening.

Naming a Sequence
One sequence: click the sequence with the Text tool, and a text 
input box appears. Enter the name and press R, or click 
another object, or the background.

The same applies if you are entering the name in the sequence 
parameter box.

Multiple Naming…

Select a group of sequences (e.g. with the rubber band) and 
click one of them with the text tool. A text input box appears 
where you can name the sequence. All sequences are given the 
same name.
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…with incrementing Numbers

If you end the name of the sequence with a number, then all 
selected sequences are given the same name, with increasing 
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numbers. They are numbered according to the time position of 
the sequences. If you want to give all the sequences the same 
number at the end, just add a space after the number.

The above also applies if you enter the name via the top line in 
the sequence parameter box, instead of using the text tool.

Inserting Events
MIDI events can be added directly to the selected track on the 
Arrange window, at the current song position, from one of the 
edit windows via the clipboard.

This function allows you to insert MIDI events—e. g. from the 
Matrix editor—directly into the Arrange window. MicroLogic 
checks as it does this that you have selected a sequence, and 
then adds the data to that sequence. If you have not selected 
any sequences, MicroLogic will create a new sequence on the 
selected track.

6.4 Sequence Parameters
The Sequence Parameter box displays the parameters Quantize, 
Loop, Transposie, Velocity and Delay for the currently selected 
sequences. 

If you select several sequences which have different play 
parameters, then the corresponding parameter(s) will be 
marked with a * 
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You can preset parameters for newly recorded sequences, by 
clicking on the background of the Arrange window. The 
Sequence parameter box will display the label MIDI THRU, 



1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

Gl

Ix
Sequence Parameters

instead of a sequence name. Any settings now made in the 
parameter box will affect incoming data in real time, and will be 
applied to all subsequent recordings.

An example: Let’s assume you want to play in the entire 
rhythm accompaniment, including: drums, bass, piano, and 
guitar for a refrain. You already know that all the sequences you 
will record will have the quantize value “16C Swing”, and the 
transpose value “+3”. Also, the velocity will be raised by a value 
of 10. Click on a free space in the arrangement field, so that no 
more sequences are selected. 

In the Sequence Parameter box, you will now find the entry 
MIDI THRU, instead of a sequence name. Now set the values 
and record something. All of the newly recorded sequences will 
have these settings, and the settings will be heard in real time, 
as you record. 

Quantize
Here you can select a quantization grid for individual 
sequences, and use it to correct the timing of your MIDI 
recordings. 

More on this can be found in the section Quantization, pp. 6 – 
136.xref

Loop
With the loop function, a sequence can be continuously 
repeated. The frequency of the repetition corresponds to the 
sequence length, so a sequence that is two measures long, will 
repeat every two measures. 

You can activate the loop function for selected sequences by 
setting the parameter for Loop to On. 
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Use the loop function when certain passages are to be repeated 
exactly. Loops do not require any memory. 

Another advantage is that any changes made to the original 
sequence automatically affecrt all its loops. 

& Please be careful not to confuse “Loop” with “Cycle”. “Cycle” repeats an entire 
piece of a song, including corresponding jumps in position. “Loop”, on the other 
hand, continuously repeats individual sequences. The song plays from beginning to 
end. 

Stopping Loops

Normally the loop will repeat until the end of the song. 
However, you can stop the loop at any time by placing another 
sequence in the track at the position where you wish to stop the 
loop. 

To do this, simply insert an empty sequence at the spot where 
the loop should be stopped. You may also copy or record a 
sequence at the point where the loop is to be stopped.

Transpose
With the Transpose sequence parameter, you can transpose 
sequences in half tone increments. The possible range is ± 99. 

The value-12 corresponds to a transposition of one octave 
lower. If you want to transpose an entire section of song, select 
all of the sequences for the section, and transpose these to the 
desired value. This procedure is very practical, if you want to 
try out different pitches in order to match the vocal range of a 
singer. 

You can transpose the entire song by selecting Edit > Select All, 
and then changing the transposition value for every sequence 
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If no sequence has been selected, then Transpose will influ-
ence the parwert
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settings, which will affect all subsequent recordings, and what 
you hear when you play into MicroLogic Fun. 

& With drum tracks, transposing influences the triggered drum notes, usually causing 
the wrong sounds to be triggered. For this reason, you should leave out the drum 
tracks when transposing an entire section of a song. 

Velocity
With the Velocity paramete,r you can increase or decrease the 
velocity value of selected sequences. The value range goes 
from -99 to +99. 

Please note that you cannot go above or below the possible 
values of 0-127, as defined in MIDI. If, for example, the notes 
in a sequence have velocity values between 100 and 120, then 
the setting +60 will only have the effect of raising everything to 
the possible maximum of 127. 

If no sequence is selected, Velocity will influence the -MIDI 
THRU-setting.

Delay
With the Delay parameter, you can move selected sequences by 
small increments, forward or backward in time. The measuring 
units here are clock ticks, which represent a 3840th fraction of a 
measure in MicroLogic Fun. If you set a negative value, the 
affected sequence will be moved ahead, a positive value will 
cause the sequence to play later.

You can use the Delay parameter to correct the timing of sounds 
that have a slow attack, such as string sounds. A negative delay 
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will move the sequence forward, so that the peak of the sound 
occurs at the correct position.
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& It is recommended you avoid larger values for delay. Remember that the sequences 
can also be directly moved in smaller increments (ex. sixteenth).

6.5 Quantization
Quantization is the automatic correction of rhythmic positions, 
using a grid. Quantizing realigns the normal variations in real-
time recordings into perfectly aligned note positions. Quantiz-
ing is especially important when playing several tracks 
together, because otherwise, the variations can conflict with 
one another, and make the feel of the song unsteady, or ragged. 

Quantizing pushes every note to the next closest grid value. 

EXAMPLE: You are playing a passage, with which the eighth 
notes are the smallest note values. If you choose the setting “1⁄8-
Note “ as the quantize value, all of the notes will be moved to 
precise eighth note positions. 

Even with quantization, a certain level of precision while 
recording is necessary. The maximum rhythmic error for a note 
cannot be greater than half the quantize value chosen. Other-
wise, the note will be moved to the wrong position. This 
means, for example, that with a quantization of 1⁄16, the variance 
must be smaller than 1⁄32. 

Setting the Quantization Value
To select the quantization factor you want, click-hold the 
sequence parameter Qua. A flip menu will open, with the vari-
ous quantization values. Select the desired value, and release 
the mouse.The value will be displayed in the parameter box. 

Quantization: Operation 
Any quantization value can be replaced with another, at any 
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time. To switch off quantization altogether, select the off 
(3840) setting.
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Your original data will remain as you recorded it, even after you 
quantize, as long as you do not use the Fix Quantize func-
tion(see below). Because, like all the other sequence parame-
ters, quantization is a non destructive, real time parameter, you 
can experiment as much as you like, without any fear of losing 
the feel of your original performance. 

MicroLogic Fun quantizes notes exclusively. Controller events 
like sustain pedal, mod wheel, etc will remain unquantized. 

As with the other sequence parameters, quantizing only affects 
the selected sequences. If you want different quantization 
values for a sequence,perhaps because even and triplet note 
values occur equally—cut the sequence into different pieces, 
which you can quantize separately. 

The Different Types of Quantization
MicroLogic Fun provides various types of quantization. These 
will be described in greater detail in the next section. 

No Quantizing
With the setting off (3840), you choose the finest degree of 
timing resolution in MicroLogic Fun. Your sequences will be 
played back exactly as you performed them. 

Standard Quantization
With the settings 1⁄1-note to 1⁄96-note you select quantization with 
a regular grid. The denominator of the fraction describes the 
value as the number of notes in a 4/4 measure. If this value is 
divisible by 3, then it is triplet quantization. A few examples of 
this:

1⁄4-Note divides the measure into four parts; this is quarter note 
quantization.
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1⁄12-Note divides the measure into twelve parts; these are three 
notes per quarter, so eighth note triplets.
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1⁄32-Note divides the measure into thirty-two parts; eight per 
quarter note which is thrty-second note quantization. 

Quantization to Odd Tuplets
This type of quantization subdivides the note value into an odd 
number of parts. Strictly speaking, a triplet is already such an 
uneven subdivision. The additional settings of 5, 7, and 9 are 
available. These settings are seldom needed for conventional 
music.

Swing Quantization
A swing feel is produced when the even numbered sub divi-
sions of the beat are played a little bit late. MicroLogic Fun 
provides quantization options that will produce a swing feel.

With an even eight-part rhythm every second beat is on 50% of 
the range of a quarter, a triplet at 66%, a sixteenth at 75%. With 
swing rhythms, these borders are fluid; all values between 50% 
and 75% are possible. This is commonly known as the swing 
factor. 

MicroLogic Fun offers six swing gradations, which experience 
shows are optimal, for both eight and sixteen part grooves. The 
settings are 8A to 8F or 16A to 16F. 

PRACTICE: Select all of the sequences in the “B groove” part 
in the Tutorial-Song. These are currently quantized with 16C 
swing. Now choose the settings 16A, 16B, 16C, 16D, 16E, and 
16F one after the other. Each subsequent setting will make the 
sequnce play with an increasingly stronger swing factor. The 
higher settings, like 16F, may be too strong. You will learn 
through experience. 

Mixed Quantization
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MicroLogic Fun has three different mixed quantizing settings. 
These contain a combination of even and triplet values. 

16 & 24 Sixteenths with sixteen-note triplets



1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

Gl

Ix
Tip
Reset Functions

16 & 12 Sixteenths with eight-note triplets

8 & 12 Eighths with eight-note triplets

These quantization settings require a much higher degree of 
accuracy in the original performance.

6.6 Reset Functions
To switch off stuck notes, click on the MIDI monitor in the 
Transport window, or hit “STOP” twice in rapid succession.

For Hanging notes—Panic Function
If the notes continue to sound, then your sound sources may 
not be able to respond to “All Notes Off” messages. If this 
happens, try the following:

Double-click on the MIDI Monitor in the Transport window. 
Separate Note Off messages will now be sent for every note on 
all channels of every MIDI port. That should do the trick.

Maximum Volume
If you select Options > Send to MIDI>Maximum Volume, Micro-
Logic Fun will send a controller 7 message, with a maximum 
value of 127, on all MIDI channels. This function is useful for 
switching all MIDI instruments back to their maximum 
volume at any time. 

& Regulating the volume with the Controller 7 should not be confused with a conven-
tional volume change. Here—independent from your amplifier and mixer—the 
internal volume, controlled through MIDI is set to its maximum value. 

Resetting the Controllers
With Options > Send to MIDI> Reset Controllers, “neutral” 
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controller data is sent to all sound modules. Use this when a 
controller is stuck, or left in the wrong state, causing the tone 
generator to sound differently than it should.. 
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This can happen when, for example, you push pause in the 
middle of a song and then start up again at another spot, or 
when you make the song position line jump to another position 
by clicking on it in the bar ruler. 
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Chapter 7

Mixer

7.1 An Adaptive Track Mixer
MicroLogic creates a mixer based on all tracks which are 
assigned to the track list of the Arrange window. It contains as 
many channels as there are tracks. These are laid out in the 
same order as in the Arrange window. To open the adaptive 
mixer select Windows > Open Mixer.

On the left is the parameter display. Selected tracks are 
outlined in red. The number at the bottom of the channel is the 
track number. The graphic layout of the program names and 
bank select commands is labeled clearly. You can adjust the size 
of the display vertically and horizontally.

The channel strips of the Mixer behave as a remote control for 
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the mixing functions of your MIDI sound module.
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Resetting Parameters
Clicking a parameter while holding O (Mac) or ç (PC) resets 
the parameter to a standard value. This is 100 with volume 
faders or 64 (center) with pan.

7.2 The Channel Strips
These are the parameters of the MIDI channel strips used to 
remotely control the mixing functions of your MIDI sound 
modules, for any MIDI modules that support these functions. 
This is the case with all sound modules or sound cards that 
show the General MIDI, GS- or XG-logos, as well as with the 
vast majority of more recent multi-timbral MIDI sound gener-
ators with integrated effect processors.

• 2 effect sends or

• 3 other types of Controller- or NRPN-messages;

• 128 pre-set patch locations for GM standard sounds

• Bank select commands 

• pan

• volume (with the fader).

Try the following:

• Open the Tutorial Song and start playback.

A piano can be heard on Channel 1.

• Move Fader 1 (click and drag the mouse).

The piano will become either softer or louder as the Fader is 
moved.
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mouse back and forth.
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The value changes according to the vertical position of the 
mouse.

Technically, “Control Change” produces MIDI events. These 
are processed by all MIDI tone generators, but only GM tone 
generators are guaranteed to react to these MIDI events in the 
way intended, if at all.

How a tone generator (not supported by the GM standard) 
responds to the GM mixer will depend on the MIDI tone-
generator. Most MIDI devices, whether GM or not, use stan-
dard controller assignments, such as CC#7 for volume, etc. The 
main discrepancy with most non GM devices is in program 
sounds. Non GM devices will not store sounds in the same 
order. For example, a non GM device may store an Organ sound 
in the first program location, rather than a Piano sound, as 
defined by GM.

Switching Sound Programs

Bank Select Messages

If your sound source “understands” bank select events, you can 
choose the bank number for each of the 16 MIDI channels. 
Please remember that not all synthesizers support bank select 
events.

The GM/GS/XG mixer sends bank select events in the stan-
dard format. A bank is a group of up to 128 sound programs. You 
can call up a specific sound program inside a bank via the 
Program flip menu. For GS and XG sound modules there is an 
inverted viewing method: within a sound program (reached via 
a MIDI program change command) you can use the bank select 
command to select among several versions of the sound program 
(though not 128 versions).
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Program

The Program flip menu is where you can choose a sound in the 
GM sound module by name. Each channel has its own flip 
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menu. The top row is for choosing programs for odd-numbered 
MIDI channels (1, 3, 5 … 15) and the bottom row is for even-
numbered channels (2, 4 … 16).

To choose the sound for a MIDI channel:

• Click the sound name, keeping the mouse button held
down.

A flip menu opens containing all the GM sound names.

• Choose a sound from the menu and release the mouse but-
ton.

MicroLogic selects the sound in the GM sound module.

Controller
You can send any controller data to control different parameters 
of your sound source, with each of the upper two rows of knobs. 
First, here’s a description of the predefined functions:

Reverb

This knob controls the reverb. The further you turn the knob, 
the louder the effect signal becomes (in other words, more 
signal from the channel is fed into the effect processor).

Chorus Depth

This knob controls the depth of the chorus effect. The further 
you turn the knob, the stronger the effect becomes.

Choosing Other Controllers
If you click-hold the text box at the left edge of the mixer the 
controller list opens. Here you can choose the controller that 
you want to send with the adjacent row of knobs.

In the controller list, all controllers are listed by name, if the 
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number. All controllers between 1 and 120 are accessible. Also 
accessible: Some so-called “NRPN“ messages (Non Regis-



1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

Gl

Ix

Note
The Channel Strips

tered Parameter Numbers), with functions for certain synthe-
sizers as described by their name.

Controller Numbers of the Mixer Controls
These functions are always available:

Before a sound module can react to the events in the GM 
Mixer, it must be configured to receive the relevant controllers 
(see “Ctrl. no.” column). For details refer to the sound 
module’s manual. 

Sometimes a module’s response to controllers can be disabled 
globally (e.g. MIDI-Menu, “Receive Control Change”. Switch 
this to “Enable”).

These functions can be controlled in GS and XG synthesizers:

Name Symbol Description MIDI Event Ctrl.#.

Program Flip 
menu

Sound in GM modules Program 
Change

—

Bank Value 
box

Sound Bank selection depending on Bank 
Select message

Volume Fader Volume Volume 7

Mute Button Volume: 
Mute: button in
Fader: button out

Volume
0
Fader value

9

Pan Fader Stereo panning Pan 10

Name Description MIDI Event Ctrl. #

Resonance Filter resonance (Q) Resonance 71

Cutoff Filter frequency (Fc) Cutoff 74

Attack Attack time of the envelope 
generator

Attack Time 73

Release Release time of the envelope Release Time 72
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generator

Reverb Reverb depth Effect Depth 91
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Please remember: Many synthesizers cannot react to these 
controllers. Please refer to their manuals for confirmation.

Extended GM, GS and XG Functions
In addition to the GM Standard, there are extended standards 
set up by Roland (GS) and Yamaha (XG). In GS and XG mode 
you can choose different effect programs, as well as controlling 
the level of the reverb and chorus effects.

• Click-hold “GM” on the right side of the Mixer window. A 
flip menu appears.

• Choose the extended standard (GS or XG).

Depending on your choice, the controllers for the extended 
effect then appear.

• Choose the desired reverb or chorus effect from the flip 

Chorus Chorus effect depth Chorus Depth 93

Phaser Phasing effect depth Phaser 95

Modula-
tion

like Modulation Wheel (often 
Vibrato)

Modulation 1

Breath like Breath Controller Breath Con-
troller

2

Foot Con-
trol

like Foot Control Pedal Foot Control-
ler

4

Porta-
mento

Portamento time (pitch glide 
between notes)

Porta Time 5

Tremolo Tremolo effect (volume mod-
ulation)

Tremolo 
Depth

92

Detune Pitch deviation between the 
oscillators

Detune 94

Name Description MIDI Event Ctrl. #
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• Program the desired reverb or delay time under “Time” by 
holding down the mouse button, and setting the value.
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7.3 Mixer Automation
The term “Mixer Automation” implies the capability of record-
ing and playing back movements of the faders, knobs, and 
buttons.

Fader movements—just as with MIDI events—are recorded 
on a track. This track will consist of a sequence with corre-
sponding MIDI events from the respective fader or knob. After 
being recorded, these events can be edited, just like any other 
MIDI sequence.

The different channel tracks in the mixer create events with 
different MIDI channels. When automation data is recorded—
from the adaptive mixer, the automation data is recorded to the 
corresponding track in the Arrange window.

Example: Let’s say you have three tracks: a bass track, a piano 
track (both MIDI tracks), and an audio drum loop on an audio 
track in the Arrange window. Click on the Record button in the 
Transport window, and then move any fader or knob on the 
mixer, and automation data will be recorded. If the fader for the 
piano channel on the mixer is moved, MicroLogic Fun auto-
matically creates a new sequence on the piano track in the 
Arrange window. Move the volume fader for the drum loop, and 
a new sequence is written to the corresponding track in the 
Arrange window. During the recording process, it is possible to 
jump back and forth between the mixer channels. The mixer 
assigns automation data to the correct track automatically.

Mixer Automation:

• Select Windows>Open Mixer in the main menu bar.

• Click on “Record” in the Transport window.

Move the the faders, knobs, or buttons on the mixer.
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Chapter 8

The Event List

The Event List displays MIDI data in the form of a “list”, 
combining all the data-editing functions of the other editors, 
(except for graphic operations, and the expressive options 
offered by the Score Editor).

The Event List is used whenever you need to make precise 
alterations to recorded MIDI data, and the graphic display of 
the other editors is not suited to the task. It is the only editor 
which gives you access to all recorded event data. You can also 
filter the view, allowing you to edit only specific event types.

Opening the Event List
To open the Event List and view the contents of the selected 
sequence, select Windows > Open Event List, or use a key 
command (Open Event Editor…).

Structure

1

2
34
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The standard buttons are supplemented by two scroll arrows 1 
to help you move through the list. The event type buttons 
below them 2 allow you to filter specific event types from the 
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display, and access or add them (by clicking on them with the 
right mouse button (Windows), or while holding down the C 
key (Mac)). The structure of the actual list display 3 is 
described on page 126. If the Catch function is switched on, the 
arrow-shaped position marker 4 will always point to the current 
event.

Display
The event type buttons allow you to “filter” the display to 
remove individual event types from the Event List, so that you 
can view only the specific types of events you are interested in. 
Click the desired button with any tool (except the pencil).

If a button is grayed out, that event type will not be displayed.

All the functions affect only the events displayed, so non-
displayed events are protected from any alterations you make.

Here is a short overview. For more detailed information on the 
individual event types see page 128.

The note symbol stands for note events.

The symbol with the two digit, seven-segment display stands 
for program change events.

The control wheel symbol with a marker in the center (pitch 
bend wheel) stands for pitch bend events.

The control wheel symbol with a marker at the bottom (modu-
lation wheel) stands for all control change events.

The single weight symbol stands for aftertouch events (channel 
pressure).

The multiple weights symbol stands for polyphonic key pressure 
events (polyphonic aftertouch).
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Operation

8.1 Operation

Scrolling
Clicking either of the scroll arrows moves the display up or 
down by one event. The event at the position marker is always 
selected (so the existing selection changes as you scroll). The 
scrolling speed can be varied as you scroll, by vertically moving 
the mouse. The key command Scroll to Next/Previous Event is 
also available from the Event window, and has the same end 
result.

Remember that if the MIDI Out button is switched on, every 
newly selected event will be played. This means you can scroll 
through the list and audibly monitor the events as you go.

If you want to keep the selected event where it is, use the usual 
scroll bar functions.

Selection Techniques
When selecting events with the mouse, you should click near 
the status column to avoid any unintentional parameter alter-
ations.

You can use any of the standard selection techniques here: indi-
vidual selection by clicking on objects, multiple selection by 
rubber banding, or both of these (without altering the previous 
selection), in conjunction with the S key.

Any events which you remove from the display by clicking on 
the event type buttons are immediately deselected. This 
ensures that all the functions affect only the displayed (and 
selected) events.

Special Selection Functions
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Some selection commands can also be utilized in the Event 
List by selecting an item with the mouse while holding down 
additional modifier keys.
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1. If you click on an event while holding down the O (Mac)
or ç (Windows) key, you select all events between the
last event that was selected and the current one.

2. If you hold down the ç(Mac) or A (Windows) key and
select an event, all similar events will also be selected.

3. If you select an event while holding down the çO
(Mac) or A ç (Windows) keys, all identical events will be
selected.

The table shows what counts as similar or equal:

8.2 Event Editing

Adding Events
To add an event, click on the desired event type button with 
the pencil (or with any other tool while holding down the right 
mouse button (Windows) or the C key (Mac)). The event is 
then added at the current song position, and is automatically 
selected.

Duplicating Events
To duplicate an existing event (for example, so you can alter the 
parameter value of the copy) click on the original event with 
the pencil. An input box appears—this is where you enter the 
position for the newly-duplicated event. If you just hit R, the 
duplicate will appear at the same place as the original.

Object Similar Identical

Controller Event Controller# equal,
any data byte

Controller# and data 
byte (control value) 
equal

Note Event Note equal, any octave Note and octave equal
124
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Pasting from the Clipboard

When adding events using the clipboard’s Paste function, a 
position input box will appear, allowing you to type in the posi-
tion of the first event. Once again, if you confirm by just press-
ing R, the original position of the event is retained. The rela-
tive positions are also always maintained.

This means that the events are not added at the song position, 
as in the graphical editors. 

Moving Events
To move an event in time, alter its position indicator. As soon as 
you alter its position, the list is automatically sorted, even 
though the currently selected event remains the same.

Altering Values
Event positions or parameter values can be altered in the usual 
way by using the mouse like a slider (grabbing and dragging), or 
via text input (just double-click on the parameter value).

You cannot alter the type of events using this method, however. 
To alter the event type, you must either open a transform 
window or add an event of the desired type, and then delete the 
original event.

Altering the Values of Several Events
If a parameter of a selected event is altered, it will affect the 
same parameter in all selected events.

Relative Value Alteration

When you alter parameter values in a multiple selection, the 
relative differences between the parameter values remain 
unchanged. The parameter values that you grab or double-click 
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on can therefore only be altered until the value of one of the 
selected events has reached its maximum or minimum value.
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Flexible Relative Value Alteration

If you want to continue altering a parameter value in a multiple 
selection (even if one of the values in the selection has reached 
its maximum or minimum), hold down the O (Mac) or ç 
(Windows) key while you move the mouse, or press R to 
confirm a numerical input.

Absolute Value Alteration

If you want to set a parameter to the same value for all selected 
events, hold down the S and O (Mac) or S and ç 
(Windows) keys while you use the mouse as a slider, or press 
R to confirm a numerical input.

Numerical Value Input
If you want to directly input a number, double-click the rele-
vant parameter.

8.3 Event List Structure
The individual columns in the list have the following mean-
ings:

Position
126
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The position of the events in the song; for note events this 
means the beginning of the note. The units represent bars, 
beats, divisions, and ticks.
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Counting begins at 1 for each unit (first bar, first beat, first divi-
sion, first tick: 1 1 1 1), and continues until it is carried over to 
the next largest unit.

Numerical inputs start from the left (which means you can 
enter just the bar number if you want). The units can be sepa-
rated by either spaces, dots, or commas.

Status
This is where you can see the event type, as specified by the 
status byte of a MIDI message. You cannot directly edit this 
parameter.

Cha
The MIDI channel used to record an event.

Remember that during playback this MIDI channel will be 
replaced by the Cha parameter of the playback instrument. The 
event is only output to the recorded MIDI channel when the 
Cha parameter is set to All.

Num, Val
These columns contain event data bytes. Their meaning 
depends on the event type:

Status Num Val

Note Pitch Velocity

Control Controller number Value

Pitch LSB MSB

C-Press (not used) Value

P-Press Pitch Value

Program Bank Select Program number
127
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With controller events, this column shows the controller name.
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With pitch bend events, a 14-bit value is displayed here, which 
is composed of the first (Num) and second (Val) Data bytes 
combined. This value can be edited directly from here.

With notes, the length is displayed here.

Here too, the units are bars, beats, divisions, and ticks. For the 
sake of clarity, when the length begins with one or more zeros, 
the “_” symbol is used instead. The minimum length is 1 tick 
(_ _ _ 1) not 0 ticks, because it makes no sense to simulta-
neously switch a note on and off.

Numerical input starts on the right, working to the left—and 
you can enter just ticks if you want. The units can be separated 
by either spaces, dots, or commas.

8.4 Event Type Structure

Note Events

Num

MIDI note number (note #). The range is from C-2 (note #: 0) 
to G8 (note #: 127). Middle C is note # 60 and in MIDI termi-
nology is called C3.

On some keyboards/synth modules (notably those made by 
Korg and Roland), the note range is C-1 (#0) to G9 (#127). In 
these cases middle C is called C4.

Val

Velocity of a note from 1-127. The value 0 carries the note off 
message, and thus is not available.

Length/Info

Length of the note. Although MIDI can only transfer note on or 
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cally. The note off message is generated automatically during 
playback.

Program Change Events
Program change events can be transmitted to connected MIDI 
devices to call up different patches. These may be sounds in a 
synthesizer, programs in an effect unit, or snapshots in an auto-
mated mixing desk.

Val

A program number between 0 and 127.

Some manufacturers (e.g. Yamaha) number the programs in 
their devices from 1 to 128, not 0 to 127. In this case, you have 
to subtract 1 from the program number given in the device 
itself.

Other manufacturers use various methods of dividing into 
groups (or banks) and sounds. The most common is dividing 
into 8 groups of 8 sounds, each numbered 1 to 8. These devices 
respond to program numbers 0—63 by calling up storage loca-
tions 11-88. The instruction manuals for these devices should 
contain conversion tables to assist you.

Num

Bank select. Normally you will see this symbol, which means 
no bank select will be sent. If you assign a number between 0 
and 62, a bank select event is sent before the program change 
event. This allows you to address different sound banks (e.g. 
preset, internal, card) inside your synthesizer. The synthesizer 
must be able to recognize controller 32 as bank select, but 
unfortunately this standard is not yet widely used. If you have 
any problems with bank select, check your synthesizer’s 
manual to see whether, and how it responds to bank select 
commands.
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Pitch Bend Events
Pitch bend events are used to continuously vary the pitch. 
They are usually generated by a self-centering pitchbend 
wheel, or a joystick on your keyboard.

Num

Fine pitch bend division (LSB). Many keyboards just transmit 
the value 0. If the pitch bend wheel has an 8-bit resolution, you 
will see the value 0 or 64 here.

Val

The effective pitch value (MSB) of 0-127. The value 64 corre-
sponds to the center (no pitch bend) position of the wheel.

Length/Info

The 14-bit value is displayed in this column as a decimal figure 
ranging from -8192 to 8191. The value in this column may be 
edited in the usual way.

Control Change Events

These event types are used to transfer MIDI controllers (e.g. 
modulation, sustain, volume and pan).

Num

The number of the controller. All the various MIDI controllers 
(such as the modulation wheel or sustain pedal) have their own 
numbers (#1 or #6,4 respectively). Some other operations are 
also defined, such as volume (#7) or pan (#10).

Controllers that are defined in the MIDI Standard are 
described in the Length/Info field.

Val
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Value of the controller. Continuous controllers have a range of 
0-127. Switch controllers (#64—#90), transfer only two states; 
off (val=0) and on (val anything between 1 and 127).
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Aftertouch Events
Aftertouch (or channel pressure) events are generated by a 
mechanical pressure sensor beneath the keyboard. The result-
ing sound modulation affects all the notes on that particular 
MIDI channel.

Num

This column is empty with aftertouch events, since they have 
only one data byte.

Val

Strength of the pressure on the keyboard (0-127).

Poly Pressure Events
Poly pressure events are generated by mechanical pressure 
sensors beneath each individual key. The resulting sound 
modulation affects only that particular note.

Only a few keyboards currently support this capability.

Num

MIDI note.

Val

Strength of the pressure on the key.
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Chapter 9

The Matrix Editor

The Matrix editor is used to graphically edit note events. Its 
advantage over the other editors is its ability to provide a more 
precise display of the length, position and velocity of the notes. 
The Matrix editor is ideal for fine-tuning the positions and 
lengths of notes.

Opening the Matrix Editor
To open a Matrix editor window showing the contents of the 
selected sequence, double-click the sequence, select Windows 
> Open Matrix Edit or a custom key command (Open Matrix 
Editor).

The parameter field 1 contains the standard buttons and the 
toolbox. As in the Arrange window, there is a bar ruler along the 
top edge 2. To the left of this (just as with the Transport 
window), you can define the sub-division 3. The vertical 
keyboard display4 indicates the pitch of the notes which are 

1

2

4
5

3
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9.1 Display
Only notes are shown in the Matrix editor. The beams (and the 
ways they can be edited) are very similar to the sequences in 
the Arrange window.

Position
You can see the position of a note in the bar ruler. The back-
ground is marked by vertical lines to assist with positioning:

• A straight line at every bar,

• A dashed line at every beat, and

• A dotted line at every division (you can alter the division 
value in the Transport window, or to the left in the parameter 
area).

Velocity
The velocity of a note is shown by a horizontal line in the note. 
The length of the line in relation to the total length of the note 
corresponds to the velocity value of the note (in proportion to 
the maximum value of 127).

In addition, the Matrix editor shows the velocity range of notes 
by using different colors.

This makes it very easy to see at a glance what spread of veloc-
ities are contained in a sequence.

If you change the velocity of MIDI notes with the V tool, you 
will notice that the color of the notes change as you do so.

It may seem obvious, but… please note that this function only 
works with a color monitor.
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9.2 Editing Notes

Creating Notes
To create a note, click with the pencil at the desired point in the 
background.

Duplicating Notes
To copy an existing note to another position or pitch, first click 
the original note with the pencil (near the middle).

Now, any notes which you create by clicking the background 
will have exactly the same length and velocity as the original 
note.

Moving Notes
You can move selected notes by grabbing them (near the 
middle) and dragging them. If you move notes vertically they 
will be transposed, and if you move them horizontally they will 
be moved in time. While you keep the mouse button held 
down, the target position and pitch are shown in the info line.

When you move notes horizontally, they snap to the division 
positions (you can alter the division setting whenever you 
want).

Setting a finer Grid
When moving notes in the Matrix window, you can make fine 
adjustments at a high resolution by holding down the ç (Mac) 
or A (Windows) key as you drag. The exact resolution you will 
achieve depends on the current Zoom setting of the window.

If you hold down the ç+S (Mac) or A+S (Windows) keys, 
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you can move the notes by single ticks (which is the finest time 
resolution possible in a sequencer), completely independently 
of the Zoom setting and the time grid.
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Copying Notes
Hold down the O (Mac) orç (Windows) key as you move the 
notes.

This allows you to copy or move notes between two Matrix 
Editor windows, even if the windows belong to different songs.

Of course, you can also copy (Edit > Copy ) or move (Edit > Cut) 
the notes onto the clipboard, and then add them at the current 
song position with the original pitch (choose Edit > Paste).

Altering Lengths
To alter the length of a note, grab it by its bottom right-hand 
corner and drag it to the required length. While you are altering 
the length, the info line will keep you informed of the precise 
length of the note. 

Altering the Lengths of Several Notes 
Simultaneously
You can adjust the lengths of several selected notes at once (e.g. 
a chord) simply by altering the length of one of them. This will 
alter the lengths relatively among the selected notes.

Making Notes the Same Length
If you want to make several selected notes the same length 
hold down OS (Mac) or çS (Windows).

What Tools to Use

When altering note lengths, you can use either the mouse 
136
Emagic
MicroLogic Fun 

pointer or the pencil. However, it is better to use the pointer, 
because you might accidentally draw new notes with the 
pencil.
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With very short or small notes it can sometimes be difficult to 
grab the bottom right corner. In this case, you should use the 
index finger tool which allows you to grab notes anywhere, and 
alter their length.

Altering the Velocity
To alter the velocity value, click on the note with the V tool. 
The info line will then indicate the velocity value of the note 
you have clicked on. 

If you hold down the mouse button, you can alter the velocity 
by vertically moving the mouse. If the MIDI Out function is 
switched on, the note will be output every time you alter the 
velocity.

Altering the Velocity of Several Notes

All selected notes can be altered simultaneously; the differ-
ences in the velocity values will be retained. If the velocity 
value of one of the selected notes reaches an extreme value (0 
or 127) you can’t go any further. However, by simultaneously 
pressing the O (Mac) or A (Windows) key you can carry on 
altering the velocity values until the clicked note reaches an 
extreme value.

To give all the notes the same velocity value, hold down the 
O+S (Mac) or A+S (Windows) keys as you alter the value.

Deleting
You can delete selected notes by pressing the B key, or click-
ing on them with the eraser.

Selection Techniques
In addition to the usual selection options, you can select all 
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notes of the same pitch throughout the whole sequence by 
clicking the corresponding key on the vertical screen keyboard.
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If you hold down the mouse button, you can also draw (rubber- 
band) a pitch range over the screen keyboard and select all the 
notes within it. 

Quick selection of Event Editor 
By double-clicking a note you can open the Event Editor with 
this note selected. 
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Chapter 10

The Score Editor

The Score Edit window basically serves two purposes:

• As a MIDI editor for users who prefer to work with tradi-
tional music notation as an interface for MIDI sequencing. 
Input, editing, copying or deleting of MIDI events and 
changing their musical position can be done directly in the 
Score window. One can also change between different 
display levels. (i.e., view single or multiple parts at once)

• To create score printouts. Although MicroLogic does not 
offer as many score layout options as the Gold and Platinum 
versions, it can still be used to create printouts for basic 
purposes. In addition to notes, text can be inserted.

MIDI sequencing and preparing music for printout are closely 
related in MicroLogic. Recorded MIDI notes immediately are 
displayed in the score. Similarly, notes which are inserted with 
the mouse into the score, or changes to existing notes are 
immediately reflected in the playback of MIDI.

Please keep in mind that all parts of MicroLogic work together. 
Many functions are available in more than one window. 

Opening the Score Edit Window
There are several ways to open the Score window:

• Menu Windows > Open Score (default key command C3
(Mac), or ç3 (Windows).

• To recall an already opened window (which is hidden behind 
other windows), select that window’s name in the main 
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Windows menu, where all currently opened windows are 
listed.
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Several Score windows can be open at once. This can be used 
for example, to display different instruments in separate 
windows, or to have one window with the full score and one 
with a single instrument, or to display just a single sequence.

10.1 General Appearance of the 
Score Edit Window

Important Elements of the Score Edit Window
Here’s an overview of the Score Edit window’s elements and 
their names, as used in this manual. In the parameter column 
along the left hand side (from top to bottom) you can see:

• Buttons for Catch, Link, and MIDI-Out
• Display Parameter Box
• Event Parameter Box
• Toolbox
• Partbox

& Detailed descriptions of these terms can be found later in this chapter. Descriptions 
for Tool Box, Bar Ruler, Zoom symbols, the switches for Catch, Link, and MIDI-Out 
can be found in other chapters, since all these exist in other windows as well. The 
functions found in the other menus are all described in this chapter.

There are a few options for changing the general appearance of 
the Score window. The settings for these options can be found 
in different places:

View Menu 
Here you can activate and deactivate the following display 
options, by selecting the corresponding menu entries:

Toolbox 
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Hides/Shows the Toolbox on the left side of the window. 
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Parameters 

Hides/shows the left column of the Score window (Display 
Parameter Box, Event Parameter Box, Partbox etc.).

White Background 

Switches between a white and yellow background.

Moving the Borders between the Different Areas
You can move the left and upper borders of the main working 
area by positioning the cursor on one of those lines, and drag-
ging them. During these operations, the cursor becomes a tool 
with two or four arrows. There are three possibilities:

• On the left side you can alter the width of the column 
containing the parameters, (thereby mainly changing the 
appearance of the Partbox Groups), and the instrument 
names.

• Along the upper border you can create vertical headroom. 
This is useful mainly when working on parts in linear view, 
which contain very high notes or symbols above high notes, 
that might not be visible otherwise, and therefore could not 
be edited.

• In the upper left corner of the main working area, you can 
change the width of the parameter column, and the height of 
the bar or page ruler.

Parameter Boxes
Both the Display Parameter Box and the Event Parameter Box 
in the parameter column at the left side of the window can be 
reduced to display only their title lines, by clicking on the trian-
gles at their upper left corners.
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The Main Working Area
The appearance of the score display itself display depends on:
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• The settings of the Link and Catch buttons (see page 163).
• Zoom level: There are 11 possible zoom levels. Please note:

These do not affect the printout, but only the screen display.

10.2 MicroLogic’s Notation 
Concept

Recorded sequences automatically are displayed in the Score 
window. If you like the sound of the playback, but not the score 
display, in most cases you can get the desired result by changing 
the display settings in the Display Parameter Box. You can 
further control the display by selecting different fonts, sizes 
and styles for text in the Score window.

If you generally prefer mouse input instead of MIDI real-time 
recording, you must first create empty sequences, using the 
Pencil tool in the Arrange window. These will then be 
displayed as empty staves in the Score window. Rests are 
always displayed automatically in MicroLogic, and don’t need 
to be inserted.

If you want to insert additional notes into a previously recorded 
sequence with the mouse, you can select a rhythmic value for it 
from the Partbox, and drag it to the desired bar and pitch posi-
tion, in any of the visible staves. 

No matter which input method you decide to use, the selected 
display settings will always be applied to the inserted MIDI 
events. This means for example, that a thirty-second note can 
only be displayed if the Qua parameter in the Display Parameter 
Box of the corresponding sequence is 1/32, or shorter. If that 
value is set to1/8, an inserted 32nd note will be displayed as an 
eighth note (but still played back with the length of a 32nd). 
Note that this also is affected by the Interpretation setting in the 
sequence’s Display Parameter Box. However, these settings 
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can be different for each sequence, even if they are on the same 
track. To use different display parameter settings in the same 
staff, just cut the sequence with the Scissors tool in the Arrange 
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window. Now different display settings can be assigned to the 
resulting shorter sequences, although they will still be 
displayed as one uninterrupted staff. MIDI playback will not 
be affected by this procedure.

The printed result always corresponds to what you see in the 
selected Score window.

Staff Display in Relation to Position and
Length of Sequences in the Arrange 
Window
Sequences in the Arrange window represent parts played by 
certain instruments (represented by the tracks), and are 
displayed as staves in the Score window. 

Each of these systems or (in the Arrange window) tracks, can 
consist of an (almost) unlimited number of sequences. If in the 
Arrange window, the sequences on one track directly follow one 
another (with no gaps between them), they are displayed as one 
continuous staff in the score (except in Show Contents mode, 
(Link button activated), where only one sequence at a time will 
be displayed). 

The Display Parameters for each of these sequences can be set 
differently. This allows you to influence the interpretation of 
sequences recorded in real time in a very flexible way, espe-
cially concerning the rhythmic display. If necessary, sequences 
can be divided into several parts with the Scissors tool (in the 
Arrange window), allowing different display parameters to be 
assigned to each resulting part, because each is now an inde-
pendent sequence.
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MicroLogic’s Basic Elements for Score 
Display
The following elements and their parameters form the basic 
concept for the score display in MicroLogic. (Detailed explana-
tions will follow later in this chapter)

The Display Parameter Box 
The parameters in the Display Parameter Box affect the 
display of the selected sequences. They can be different for 
each sequence, whether the sequences are on different tracks, 
or the same track. 

Score Styles 
Score Styles contain a fixed combination of predefined display 
settings: The clef(s) and the display transposition. 

Assigning a different Score Style to a sequence will result in a 
display that reflects the chosen Score Style. Keep in mind that 
the Score Style never affects MIDI playback, it only affects the 
way MicroLogic displays the score. For a list of all available 
styles and further details see page 161.

Input Methods in the Score Edit Window 
There are several methods for the input of notes and symbols in 
the Score window:

• MIDI real time recording

• Mouse input of notes from the Partbox

• Insertion of copied events

Any input and insertion methods can be combined. With all 
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input methods, however, you should keep in mind that MIDI 
playback can also be influenced by the settings in the Sequence 
Parameter Box in the Arrange window (for example the play-
back transposition settings). 
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The second essential thing to keep in mind is, that the score 
display always depends on the chosen display parameter 
settings for each individual sequence.

10.3 MIDI Real Time Recording in 
the Score Window 

Although MIDI real time recording usually is done in the 
Arrange window, you can also start recording directly while 
working in the Score window. You must first select the desired 
destination track in the Arrange window’s track column. In the 
Score window, this can be achieved by clicking on a staff which 
belongs to that track. If there are no sequences on that track 
yet, you will have to switch to the Arrange window for the 
recording, since the track is not yet displayed in the Score.

The score display of newly recorded notes depends on:

1. The score display settings in the Display Parameter Box. 
Please read the corresponding sections in this chapter.

2. The Quantize and Transpose settings in the Arrange window’s 
Sequence Parameter Box: 

MicroLogic creates the score display based on the actual
MIDI data, including any changes caused by these two
playback parameters.
An example: If Transpose in the Sequence Parameter Box is
set to+2, a note that initially (when recorded) was a C will
be played back and displayed as a D. The same applies to
playback quantization. 

& Note: The Score window’s Info Line always shows the original pitch of a note, inde-
pendent from any playback, or display transposition parameters.

Positioning the SPL directly in the Score
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The Song Position Line can be set directly in the score window 
by clicking into a staff at the desired position, while pressing 
the O (Mac), or ç-key (Windows). This function is only 
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available when the sequencer is stopped. The chosen position 
is displayed in the Info Line while the mouse key is pressed.

10.4 Mouse Input
In order to insert notes and text elements with the mouse, there 
has to be a staff into which these objects can be inserted. Each 
staff (even an empty one) is the direct representation of one or 
several sequences. Empty sequences can be created with the 
Pencil tool in the Arrange window, where their length and posi-
tion can also be changed.

These empty sequences are displayed in the Score window as 
empty staves, with automatically displayed rests.

Input
For mouse input, you first have to select a note in the Partbox, 
and then drag it to the desired position in a staff. As a position-
ing aid, you will see an Info Line while you are “holding“ the 
note with the mouse. Now move the mouse with the button 
pressed, until the desired position is shown in the Info Line. 
Release the mouse button. It is especially important to use the 
Info Line to help you find the correct position when you are 
working in a small zoom level. 

MIDI Channel and Velocity of Inserted Notes
The MIDI channel and velocity of notes inserted with the 
mouse are determined by the Insert Defaults settings in the 
Event Parameter Box. These Insert Defaults are visible (and can 
be edited), whenever no object is selected. Click anywhere in 
the working area, except on an object, to display this status. 
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Make sure that “Insert Defaults” is displayed in the top line of 
the Event Parameter Box. 
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Insert Quantization
To make positioning of notes and symbols easier, objects can be 
inserted only at certain bar positions:

• For positioning of notes there is an invisible grid. You can
imagine its resolution as if the whole bar—beginning on
one—were filled with notes of the chosen value. For exam-
ple: In an empty 4/4 measure, half notes can only be inserted
on beats one and three, eighth note triplets only on the first,
second or third eighth note triplet of every beat, and so on.

• Also, all binary and dotted values can be inserted at any po-
sition of an automatically displayed rest, i.e., if there is an
eighth note on one, you can insert a quarter or a dotted quar-
ter note at the second eighth’s position. 

You can, however, move all notes to any desired position by 
editing their numeric bar position in the Event List. For exam-
ple, if you want to insert a half note on “two” in 4/4 time, place 
it on “one” or “three”, and change the position to “two” in the 
Event List.

10.5 The Partbox—Inserting 
Notes

The note values are organized in three sub-groups: Simple 
(binary) rhythmic values, dotted values and triplet values:

& Inserting any of those symbols creates a MIDI note event with exactly the length of 
that value. For display however all these MIDI notes are interpreted by MicroLogic as 
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if they had been recorded in real time. Therefore the Display Parameter Box’ settings 
have to be set in a way that allows the inserted notes to be displayed correctly. Please 
read the page 158
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If you simply want to enter notes with the mouse, without 
using real time recording at all, select the highest possible Qua 
value in the Display Parameter Box.

Ties
Ties cannot be inserted in MicroLogic, but are created and 
displayed automatically, according to the length of the MIDI 
note. The reason: Notes which are displayed as several graphi-
cal notes connected with ties in MicroLogic always represent 
only one MIDI note. To insert such notes you first insert a 
shorter note value, and change its length afterwards in the 
Event Parameter Box or the Event List.

Allowing Diatonic Input Only
Select Options > Diatonic Insert to limit input to notes that are 
diatonically correct for the current key. Notes can still be 
altered chromatically after they have been inserted.

Triplets
Depending on the display quantization chosen, and the partic-
ular situation, MicroLogic usually recognizes and notates regu-
lar triplets correctly. However, this requires a “hybrid“ Qua 
value in the Display Parameter Box (see the page 159). 

After inserting the first note of a group of triplets, you won’t see 
a triplet yet. Insert the second note exactly at the graphic posi-
tion of the rest following the first inserted note, and do the same 
with the third note. Now a complete triplet group will be 
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Automatic Rest Display
Rests are always displayed automatically in MicroLogic, in 
such a way that existing notes and automatic rests together 
always add up to complete bars, according to the given time 
signature.

Key Signatures and Key Signature Changes
The basic key signature of a piece can be set by double-clicking 
into the first staff, between clef and time signature. This opens 
a dialog box where you can set any major or minor key. There is 
also the option in this window to disable the use of double flats 
and sharps.

This method not only works for the first staff, but in all staves. 
However, if the piece contains prior key signature changes, the 
newly inserted key signature only changes the key which is 
active at that particular point up until the next key signature 
change. As with the starting key signature, inserted key signa-
tures affect all sequences, on all levels.

Natural symbols are displayed automatically with the new key 
signature when necessary (e.g. when changing from A flat major 
to F major or A major).

Minor Keys

To choose a minor key, insert the parallel major key first (e.g. 
Ab major for F minor). Then double-click on the key signature. 
In the appearing dialog box, click on the word major. The 
display will change to minor and at the same time to the parallel 
key. This also works the other way around.

Display Transposition Of Key Signatures

Note: Display transposition of key signatures for non-C instru-
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ments is achieved by assigning a corresponding Score Style to 
the desired sequence(s). This will only affect the displayed 
transposition of the selected part(s), not the MIDI output. If 
you insert general key signature changes into your song, Micro-
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Logic will automatically account for this in the displayed key 
signature for non-C Score Styles. For example, if your song 
plays in the key of C Major, a part assigned the Trumpet in Bb 
style will be displyed in the key of D major (but will still play in 
C major). If you insert a key signature of F major at bar 33, the 
displayed key signature will be G major.

Time Signatures and Time Signature 
Changes
Time signature changes can be inserted at the beginning of any 
bar, either by double-clicking the time signature, or by chang-
ing the time signature setting in the Transport window. In the 
latter case, the signature change will be inserted at the begin-
ning of the measure of the current song position

Time signatures and time signature changes are also effective 
globally for all instruments, on all display levels. It is not possi-
ble to insert different time signatures for different instruments 
or tracks. Time signature changes affect only the display, not 
the playback. Note: The tempo indication in the Transport 
window always relates to quarter notes, even if eighth notes are 
chosen as the denominator for the time signature. 

Editing Time Signatures

All time signatures can be edited by double-clicking on them. A 
dialog box opens, where you can insert the desired changes. To 
delete a time signature change, use the Eraser tool or select the 
signature and press B.
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10.6 Text: Input and Display

Text Appearance
The appearance of text (font, size and style) in the score is 
defined in the dialog box which opens when you select the 
menu item Options > Score Font.

In MicroLogic this is a global setting for all text in a song. 

Text Input
To insert text in the score, you have to get the Text tool and click 
at the desired position. A flashing text cursor appears at that 
position. Now you can enter text with the computer keyboard.

Each Text object is saved as a Meta Event within a particular 
sequence, at its inserted bar position. This position can be seen 
in the Info Line, as you insert the text object.

The basic functions for moving the cursor, deleting parts of the 
text etc. are the same as in most word processors. As long as you 
are in text entry mode (indicated by the flashing text cursor), 
you can click on any position in the text to place the cursor 
there. Also, you can select parts of the text by click-dragging 
the mouse, and you may then use the usual cut/copy/paste 
commands. To leave text entry mode press R,or click 
anywhere outside the text.

After this, the newly inserted or edited text object is selected 
(the text flashes), and you can see its parameters in the Event 
Parameter Box:

Staff  determines which staff in the system the Text 
Object is assigned to. 

vert.pos refers to the distance to the top line of that staff.
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hor.pos indicates the horizontal graphic deviation of the 
selected text object from its actual bar position. 
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Editing Text
If you want to edit the contents of text itself, either click on it 
with the Text tool or double-click on it with the Pointer tool, 
which will cause the flashing text cursor to appear again.

Deleting Text Objects

Like all other objects, Text Objects (or selected text inside a 
Text Object) can be deleted by pressing B, as soon as they are 
selected.

Copying Text Objects
Copying whole Text Objects can be done with the usual meth-
ods: 

• The menu or key commands for Copy and Paste.

• Dragging the object with the mouse while holding O (Mac) 
ç (Windows). This, however, only works within the same 
sequence.

Please avoid using fonts which are not TrueType or Postscript 
fonts. These fonts will not print out properly.

10.7 Move, Copy and Paste in the 
Score Edit Window

Moving or copying of complete sequences, or major parts of a 
sequence should generally be done in the Arrange window. 

Still, most of the following described functions in the Score 
window work similarly to MicroLogic’s other editor windows. 
However, it is not possible to copy, or move time or key signa-
ture changes.
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Moving/Copying with the Mouse
You can move/copy by dragging the selected objects (with O 
(Mac), or ç (Windows) for copying). This allows you to move 
or copy any number of notes to other bar positions and/or 
pitches. 

It is important to watch the Info Line, which appears during this 
process. It shows the status (Drag or Copy), the difference from 
the original position (Transpose and Timeshift), and the current 
cursor position (bar position and—for notes—pitch).

Positioning Grid

Movement along the time axis occurs along a quantization grid, 
corresponding to the particular sequence’s chosen display 
quantization (Qua) in the Display Parameter Box. If a hybrid 
quantize value is chosen (i.e.16,24), the grid corresponds to the 
binary value (16 in this example). If note positions are not in 
accordance with this time grid (for example, because they were 
recorded in real time), their relative offset to this grid is still 
kept when moving or copying them. This allows you to move or 
copy unquantized passages within the Score Editor, without 
losing the original time feeling.

Please note: Copying and moving notes with the mouse is only 
possible within the same sequence. 

Moving and Copying Several Objects at Once

To move or copy several objects (notes and symbols), just select 
all desired objects (rubberband or S-click) and drag one of 
them (preferably the first one, or one positioned at exactly the 
beginning of a measure) to its destination position. Again, 
watch the Info Line for exact positioning. The other selected 
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objects will be moved or copied in exact relation to the first one.
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It is also possible to simultaneously move or copy objects which 
are in different sequences/staves. Each event will be moved/
copied to its new position within its original sequence.

Move/Copy with Cut, Copy & Paste 
via the Clipboard
These menu or key command functions work the same way as 
in many other software programs and in the other MicroLogic 
windows.

Please note: Paste inserts the clipboard’s contents (i.e. a note) 
into the selected sequence at the current song position (indicated 
in the Transport window). So, before pasting, you have to set 
the Song Position Line to the desired destination position.

When you copy and paste several objects at once, the first 
object is pasted at the indicated bar position, the others in rela-
tion to it. 

& Note: If you copy the contents of a whole bar which starts with a rest on the first 
beat, the first object is not on one, since automatically displayed rests are not objects, 
and therefore cannot be copied. In this case, you have to set the paste position to 
the position of the first actual object. 

Automatic Insert Quantization

When you Paste (or Paste Multiple) objects from the clipboard, 
the position of the first inserted event is automatically quan-
tized according to the current global display format (in the 
Transport window). If, for example the current bar position is 
4.1.1.37, and the global display format is set to1/16, the pasted 
object will be inserted at position 4.1.1.1. When the clipboard 
contains more than one object, the other objects’ positions are 
not quantized, but their exact relative position from the first 
object is kept.

If you don’t want this (i.e. because you want to keep the 
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unquantized timing of the original preserved) it is better to use 
one of the other methods of copying.
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10.8 Editing Notes

Changes in the Event Parameter Box
In the Event Parameter Box you can edit the following param-
eters (please also note the subsequent explanations about 
changing several selected objects simultaneously):

Notes 
MIDI channel, pitch, velocity and note length.

Text 

Staff: 

Staff number: This parameter is only relevant when you are 
using the Piano Score Style with two staves. It determines 
which staff the textbelongs to. Note: If this value is higher than 
the number of staves in the Score Style, the symbol disappears.

vert.pos / hor.pos 

Precise graphic positioning (see also page 166): 
• vert.pos determines the height/vertical position. Zero in most

cases corresponds to the top line of the staff, positive values
are above it, negative values below it.

• hor.pos determines the horizontal graphical offset from the
object’s bar position. Zero here corresponds to the position of
the left side of a note head at that particular bar position.

Most parameters in the Event Parameter Box can be edited 
using the mouse as a slider (hold down the mouse button while 
moving it up or down). Also, you can double-click on a parame-
ter, which opens an entry field. Here, you insert the desired 
value as a number, or for notes as a pitch, like D#4. You can also 
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insert relative changes into this field, such as +4 to raise all 
selected notes’ pitches by 4 half steps, or to increase a numeri-
cal value of any other parameter by 4.
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Changing Several Selected Objects 
Simultaneously in 
the Event Parameter Box
If several objects are selected, this is indicated in the Event 
Parameter Box’ title line by X Notes/Events/Texts selected. (X 
being the number of selected objects). The terms Notes, and 
Texts are used only if the current selection contains objects of 
that one particular type.

While multiple events are selected, each displayed parameter 
can be edited for all objects at once. “*“ as a value means that 
the selected objects have different values for that particular 
parameter. There are different options for changing these 
values:

Relative Change (Preserving Differences): 

Grab the “*“ with the mouse and use the mouse as a slider. The 
value shown during this process belongs to the first of the 
selected objects. The other objects are altered by the same 
amount. You can also double click the value and insert the 
desired change (a number with a plus or minus in front of it) 
into the resulting entry field (see above).

Absolute Change (All Values Set Equal): 

Press O (Mac), or ç (Windows) during the above described 
procedure: As soon as you move the mouse while holding the 
modifier key, the parameter is set to the same value for all 
selected objects.This way you can set all notes of a chord to the 
same length or velocity, or set all selected text objects to the 
same height (vert.pos).

Deleting Objects in the Score Window
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Here is a short overview of the methods available to delete 
objects in the Score window:

• With the Eraser tool (works for all objects)
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• With B (Backspace) or Edit > Clear, while the corre-
sponding objects are selected (flashing).

& You can only delete events in the Score window which are displayed. If, for example, 
you erase notes from a real time recording in the Score window, MIDI controller 
events or pitchbend data, which were recorded together with those notes, are not 
going to be deleted. In such cases, use the Event List to delete the unwanted events. 
Keep in mind that you may have both the Score Edit and Event List windows open 
at the same time.

10.9 The Display Parameter Box
The settings in the Display Parameter Box can be different for 
every sequence. The displayed settings always refer to the 
sequence(s) currently selected. Those settings do not affect the 
MIDI playback of notes, but only the score display.

Different Settings within the Same Staff
If you cannot seem to find the appropriate display parameters 
for a particular sequence, keep in mind that you can divide each 
sequence using the Scissors tool in the Arrange window. This 
will leave the MIDI playback unaltered, but gives you the 
option to select different display parameters (e.g. display quan-
tization) for each sequence. As long as the resulting sequences 
have no gaps between them in the Arrange window, they will 
still be displayed as a continuous staff.

Default Settings for New Sequences
If a new sequence is created either with the Pencil tool in the 
Arrange window, or through MIDI recording, MicroLogic 
always applies the Default parameters to that sequence. These 
can be seen and edited in the Display Parameter Box, when-
ever no sequence is selected (the title line says Insert Defaults to 
indicate this status). These settings will remain as you set them 
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for the current song, but can be changed anytime. Click on any 
empty spot in the main working area (below or above the score) 
to display the Insert Defaults. You can now edit any of the param-
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eters. (for example, to set Qua to the display quantize setting 
that you will use for most sequences in that song) From that 
point on, all new sequences will adopt these settings, as soon as 
they are created. If Qua is set to default here, the Qua setting of 
newly recorded or created sequences will match the Global 
Format Value in the Transport window (details see below).

Changing the Settings for 
Several Sequences Simultaneously
This is possible, if all desired sequences are selected. In the top 
line of the Score Parameter box, instead of the sequence name, 
you will see an indication of how many sequences are selected 
currently (3 Sequences sel.). If these sequences have differing 
values for any of the parameters, a “*“ will be displayed in the 
corresponding line. If you edit this value, all selected 
sequences will now have the same value for that particular para-
meter.

Rhythmic Interpretation of Sequences
Traditional music notation is an imprecise way of describing the 
musical content in a piece. The actual performance depends 
heavily on the interpretation of the performing musicians. 
Quarter notes for example, hardly ever are held exactly for their 
entire duration.

The rhythmic interpretation of MIDI sequences recorded in 
real time to a click presents a similar problem, especially if one 
considers that MicroLogic records MIDI events with a resolu-
tion of 960 ticks per quarter note. Nobody will play a downbeat 
at the exact time of the click. In some styles of music, it is 
common to even play a bit “laid back”, or behind the beat. So, 
it is important that you have some idea of how the printed 
display of your music should look in comparison with your 
actual performance. This will help you to determine the proper 
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Display Parameter Box settings, which will do much to control 
the display of your music.
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The Parameters in the Display Parameter 
Box

Title Line: Name of the Sequence

The name displayed here is identical to the name of the 
selected sequence in the Arrange window. It can also be edited 
from here. A click on the name opens a text entry field. If more 
than one sequence is selected, this line reads X Sequences 
selected, if nothing is selected, Insert Defaults (the default settings 
for new sequences).

Style 

The Score Style used for the score display of the selected 
sequence. This is selected from a flip menu, which contains all 
available Score Styles for the current song.

& Score Styles have no influence on the rhythmic interpretation and display, but are 
used to control such general display factors as the clef, display transposition and 
number of staves for the sequence. Their features are explained on page 161 .

Qua (Display Quantization)

This parameter determines the shortest note value which can 
be displayed in the corresponding sequence.

The Qua value is chosen from a flip menu which contains the 
available display quantizations. Among these there are binary 
quantizations (displayed as one binary value like 8 or 32), and 
hybrid quantizations (two values combined, a binary and a 
ternary value, i.e. 8,12 or 16,48).

The binary values always correspond to the note value with the 
same denominator, i.e. 32 = thirty-second note etc. Ternary 
values refer to triplet settings. Here is a list of the ternary values 
and their corresponding triplet values:
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“Qua” Setting Corresponding Note Length

3 1/2-note triplets

6 1/4-note triplets
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Automatic Display of Triplets

When a binary display quantization value is used, triplets will 
not be displayed at all. Therefore a “hybrid“ quantization value 
must be chosen for the Qua parameter, to enable the proper 
display of triplets.

Default Setting

Unlike in older versions of MicroLogic, the Qua cannot be set 
to default in already existing sequences. The default option can 
only be used in the Insert Defaults (see above) which determine 
the default settings for newly recorded or created sequences. If 
default is chosen there, the Qua setting of any new sequence 
will depend on the Global Display Value in the Transport 
window. In this case, the Qua value will always be the hybrid 
value which contains the global display value currently set in 
the Transport window plus—in case of a binary global value—
the next higher ternary value or—in case of a ternary global 
value—the binary value which is divided by that particular 
ternary value.

A few examples: A global value of 1/8 will result in an 8,12 Qua 
setting for new sequences, global value 1/12 will become Qua = 
4,12, global value 1/16 will result in Qua = 16,24, 1/24 in 8,24 
and so on.

However, if a particular Qua value has already been set in the 
Insert Defaults (which are displayed in the Display Parameter 
Box whenever no sequence is selected), all new sequences will 
be assigned this value, regardless of the Global Display Value in 

12 1/8-note triplets

24 1/16-note triplets

48 1/32-note triplets

“Qua” Setting Corresponding Note Length
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the Transport window. Any of these values can be changed after 
recording.
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Swing Notation

For regular swing notation 8,12 should be used as the display 
quantize parameter. This enables the display of eighth-note 
triplets, but at the same time displays two uneven notes on one 
beat as regular eighth notes. For swinging sixteenth notes 
(shuffle funk, hiphop etc.) the same principle applies, however, 
in this case Qua would be set to 16,24.

For double-time passages, you have to cut the sequence in the 
Arrange window and assign a correspondingly higher quantize 
value to the new sequence containing the double-time figure.

10.10 Score Styles
Score Styles in MicroLogic are preset formats that could be 
compared to preset text formats in word processing and desk-
top publishing software. In this case, however, it is score display 
attributes that are stored and assigned to sequences. For exam-
ple, see how choosing a style affects the display of the low regis-
ter melody in the sequence shown below:

Better legibility by choosing an appropriate Score Style (right)

Score Styles in MicroLogic include and determine the follow-
ing (fixed) parameters: 

• Clef

• Display transposition

• Number of staves (for the display of one sequence)
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• Vertical distance between staves

& Note: Unlike the “Qua” parameter in the Display Parameter Box, Score Styles do not 
affect the rhythmic display.
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In MicroLogic you will find 3 preset Score Styles. (The Gold 
and Platinum versions provide an unlimited number of user-
definable Score Styles). Here is a complete list, together with 
the parameters of those styles (for details see below):
Graphic

Assigning Score Styles to Sequences
You assign a Score Style to a sequence by selecting the 
sequence, then selecting the desired Score Style from the flip 
menu which appears when you click-hold on the Style Parame-
ter line in the Display Parameter Box.

You can also assign a Score Style to several selected sequences 
at once (see page 158).

Score Style Assignments can be changed anytime.

& Reminder: Sequences on the same track in the Arrange window which directly 
follow each other without gaps between them, are displayed as one continuous 
staff, but still can use different Score Styles.

Distance between Staves
The vertical distance above the staff can be changed directly in 
the score, by dragging the staff up or down at its clef.

Please note: This procedure change the distance settings of the 
corresponding Score Style itself. This means that all sequences 
which use the same Score Style will be affected, which is not 
always what you might want! 

Style Staves Clef Transposition

Bass 1 Bass -

Piano 2 Treble/Bass -

Treble 1 Treble -
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Using the Multi-Stave Score Style “Piano”
If you use the Piano style for a sequence, that sequence will be 
displayed as a two-stave system. The Piano style (second style 
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in the Score Style list) simply distributes the notes according to 
their pitch: All notes below middle C will be written in the 
lower staff (bass clef), middle C and above will be written in the 
upper staff (treble clef). This is also called a split point, since the 
notes are split between the staves at a certain point or pitch.

10.11 Display Levels
In the Score Edit window you can work with the following 
display levels:

Content Linked: Activated by a click on the Link symbol. In this 
mode only the object currently selected in another window is 
displayed in the Score window.

Content Catch: Similar to Content Linked, but Catch is also acti-
vated. Only one sequence is displayed at a time, but if there are 
several sequences on one track, during playback the display 
changes to the next sequence on the same track, according to 
the current bar position.

Not Linked (Link button deactivated): In this mode, Micro-
Logic simply stays at the currently visible display level and 
doesn’t react to sequence selection in other windows. If you 
always want to see the full score in a particular Score window, 
choose this mode, once the full score is displayed (see below).

Changing between Single Sequence and 
Full Score Display
At all display levels, a double click on a sequence/staff will take 
you to the next lower level (into the display of only that partic-
ular sequence). A double click in the empty space below or 
above the staves will bring you up to the next higher level (the 
full score display of all sequences of that song). 
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& Hint: It is possible to work with several open Score windows with different Display 
Levels and/or different Instrument Filter settings.
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Muted Sequences or Tracks in the Score Display
Muted sequences will not be displayed in the Score window, no 
matter what the Display Level or Instrument Filter settings are. 

Sequences on muted Tracks, however, will remain visible, 
although they will not be played back via MIDI.

10.12 Adapting MIDI Sequences 
for Score Printout

If a song’s MIDI sequences have been recorded in real time, 
the Arrange window often looks similar to the picture below. 
Sequences are spread all over the place with gaps in between. 
Sometimes sequences belonging to the same instrument are on 
different tracks. Sometimes Loops are also used:
 

The score printout always corresponds to what is displayed in 
the active Score window. The staves which represent the 
sequences shown above would therefore be spread over the 
pages, with lots of space in between. 
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However, if you want to print out the arrangement shown 
above, you will need continuous staves for each instrument 
(track). This is achieved by changing the length of the 
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sequences in the Arrange window in such a way, that they 
connect with one another on each track. 

& In the Arrange window shown above, there is a looped sequence on a track called 
Real Drums (bottom track). Sequences like these hardly ever are written out in scores, 
so there is also another instrument (Drums) created for the score display. Instruments 
which should not be displayed in the score (like Real Drums, Real Piano, Real Guitar 
in the above example) can be excluded by simply muting their sequences before you 
print your score.

All sequences which are intended to be displayed on the same 
staff, have to be on the same track in the Arrange window. This 
has already been done in the above example.

Next, you have to get rid of the gaps and overlaps between 
sequences, by changing their length. After this procedure, the 
Arrange Window in the example above would look like this:
 

In the Score window, these sequences are now displayed as 
continuous staves (except in content link mode, where only 
single sequences are displayed), since they are now continuous 
in the Arrange window. 

Alternative Method: Merging Sequences

Instead of changing the sequence borders as described above, it 
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is also possible to simply Merge all the sequences of each track, 
thereby creating one long sequence per track. This needs to be 
done in the Arrange Window. Use the Glue tool.
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Please note: Although this method seems to be easier and faster 
than adjusting all the sequence borders as described above, you 
loose the ability to choose different display settings (especially 
display quantization) for the different sections (sequences) of 
each track.

10.13 Printout 
For printing, it is important that you first choose the appropriate 
paper size and format in the menu File > Page Setup…. The 
Score window with the intended print view has to be selected 
as the active window. Then start printing by selecting File > 
Print…, or use the corresponding key command. There will be 
a dialog box which is slightly different from printer to printer. 
Depending on the printer, there may be some additional 
options, such as which pages you would like to print or the 
number of copies. 

The printout always is identical to the display in the Score 
window. However, neither the dashed lines which represent 
page and header margins nor the cursor or the Song Position 
Line will be printed. Those are only visible on the screen.

Printers work with a higher resolution than monitors. There-
fore you should work in high zoom levels when doing layout 
work, such as exact positioning of text elements. It is very easy 
to change back and forth between a normal and extremely 
enlarged view of the display by using the Zoom tool. 
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Wave Player 

11.1 Basics
The MicroLogic Fun Wave Player triggers sound files in the 
.wav format, with MIDI events. 

A prerequisite for using the Wave Player is a Windows-compat-
ible multimedia sound card. Before using the Wave Player, 
make sure that the sound card and the driver are installed prop-
erly and are functioning.

All standard wave files supported by the sound card can be 
played. These must be either on the hard drive of the 
computer, or on a CD-ROM. It is important to remember that 
the MicroLogic Fun Wave Player cannot create an audio 
recording, but can only play existing sound files.

Functions
Up to 128 sound files can be assigned to the Wave Player, each 
one triggered by a MIDI note. The entire sound file can be 
played, or only a part may be played. These can be assigned in 
the Wave Player window. In this window, files can be audibly 
reviewed. The sequencer, or a MIDI keyboard can trigger 
assigned sound files their assigned notes.

The Wave Player offers the following features:

• Supports mono and stereo wav files of any length.

• Supports 8-bit and 16-bit files, and all standard sample rates. 
Quantization (number of bits) and the sample rate will influ-
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ence the sound quality of the files. 16-bit, 44.1 kHz are CD 
quality.
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• Wave files can be called up in real-time, even from a MIDI 
keyboard, or controller.

• The Wave Player is velocity sensitive, which means that the 
volume is dependent on how hard the keys are hit.

• Sound files can only be played one at a time. If two sound 
files overlap in the arrangement, the second will interrupt 
the first as it is being played. All 128 MIDI notes can be 
assigned to 128 different sounds.

• The MIDI controllers for volume (CC#7), and pan (CC#10) 
can be read by the Wave Player. The volume and stereo posi-
tion can be controlled by the corresponding controller 
events.

11.2 The Wave Player Window

The Wave Player Window can be opened from the Arrange 
window by selecting Options > Wave Player…

The Wave Player offers some parameters in the menues 
Initialize and View:

Initialize

• Reset Parameter Values: resets the settings for all sound 
files back to the default values.

• Delete all Assignments: deletes all sound files from the 
Wave Player window. This does not be delete the files from 
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View

Which parameters are to be shown in the Wave Player window 
can be controlled in the View menu. The Wave Display, 
Parameters, File Info, and the Keyboard can all be either 
hidden or shown independently of one another.

As in the other windows, different zoom settings can be manip-
ulated with the telescope symbol.

Wave Player Parameters
The best way to learn about the functions, parameters and 
display options in the Wave Player is to simply enter sound 
files. If the computer does not have any sound files on it, look in 
the Windows folder—any of the Windows system sounds can 
be used.

Here is how to assign a sound file to a MIDI note::

1. Click with the left mouse button on the empty field or on 
a previous entry, to the right of a MIDI note on the 
vertical keyboard display.

2. A standard Windows file selection window will open, from 
which sound files can be chosen. All files with a *.wav 
extension will appear automatically.

3. After a file has been chosen, its name will appear in the 
field to the right of the note name. Other parameters 
appear to the right of the sound file.

4. Clicking on the corresponding key of the keyboard display 
will test the sound file.

If View>Parameters has been activated in the menu, then the 
following fields will appear, from left to right:

Wave Display

• This is the field where the waveform for the sound file is 
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displayed. This image can be used to select a section of the 
sound file. There are three options:
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- Click on the left edge of the wave display, the mouse
pointer will change into a finger pointing to the right.
Dragging the cursor changes the point where playback
will start. Unused portions of the file will be “grayed
out” in the display.

- Click on the middle of the display with the mouse to
move a pre-existing section to the left or the right,
without changing the length of the section. This is very
useful if you have defined a one measure segment in a
longer drum groove, and another section of the same
length is to be used instead.

- Clicking on the right edge of the wave display, the
mouse pointer will change into a finger pointing to the
left. Movinfg the cursor moves the the end point.

Deleting Wave Files
Wave files can also be deleted from the Wave Player Window. 
Simply right click with the mouse on the file name. A dialog 
box will open, giving you the opportunity to either confirm or 
cancel the deletion. This function will not delete the files from 
the hard drive; they will only be removed from the Wave Player 
window.
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11.3 Wave Player in the Arrange 
Window

Sounds that have been assigned in the Wave Player window can 
be used in the Arrange window just like a normal MIDI instru-
ment. In order to better understand the manipulation of 
sequences and MIDI data, read the chapters of this manual that 
cover the Arrange window, the Transport functions, and the 
various editors.

Wave Player sounds are triggered in the Arrange window from a 
track with the name “WAVE”. When this track is selected in 
the Arrange window, the sound that was set in the Wave Player 
can be triggered by its assigned MIDI note. The note may 
come from any MIDI controller, or may be recorded into a 
sequence on the “WAVE” track. Remember that only one 
sound can be played at a time.

MIDI notes can be recorded as sequences, and these 
sequences can be edited, just like sequences on any other 
track. The sequences recorded can be moved or copied. 
Sequence play parameters like quantizing, loop and transpose can 
also be used.

Wave Player and the Editors
MIDI data to be played by the Wave Player can be processed 
by all editors. When clicking on a MIDI note in one of the 
editors, the corresponding sound file will be played, if the 
MIDI Out button in the editor is activated.

The volume of the sound files can be controlled with the veloc-
ity of the trigger note. The controller for Volume (Controller No. 
7,) and Pan (Controller No. 10) can be used to affect playback of 
the sound file.
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Important
• All edits of MIDI data affect only playback of the file(s) 

when triggered by the Wave Player. It is not possible to edit 
the actual audio data with the Wave Player.

• All Wave Player settings are stored in the song. So that all 
sound files can be found again, when a song is loaded, these 
files should not be deleted or moved once assigned to a song. 
It is a good idea to create a special folder for the storage of 
files (.wav files) used by the Wave Player.
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Chapter 12

Video and MIDI Files

12.1 Playing Digital Video Files

Video on Windows PC
MicroLogic Fun can load digital videos in the Windows .AVI or 
MOV format into a song, and play them along with it.

The video will play back synchronously from the beginning of 
the song.

In order to play a video you first need to load it.

1. From the menu bar, select Options > Movie… or Options > 
Movie as Float….

2. In the file selector box, select a Windows video file, and 
confirm with OK.

MicroLogic Fun opens a window for the video, which may be 
placed anywhere on the screen. The first frame of the video 
sequence corresponds to measure “1 1 1 1” of the MicroLogic 
song.

3. Set the Song Position to the beginning, and start the play-
back.

The frames run synchronously to the song. You can jump back 
and forth using the Song Position Line or the Locators at any 
time—the video file follows the Song Position.

Video on a Macintosh
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MicroLogic Fun is able to import digital videos (movies) in 
QuickTime standard format, and play them in sync with the 
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song. You can therefore compose to picture in MicroLogic Fun, 
without a separate video recorder. 

You must have Apple QuickTime™ to play QuickTime movies 
on your Macintosh. This is a system extension that is a part of 
all newer operating system versions.

Opening a QuickTime movie in MicroLogic:

1. From the menu bar, select Options > Movie… or Options > 
Movie as Float….

A dialog box appears in which you can select the QuickTime-
Movie.

2. Select the movie and confirm by clicking OK.

This loads the movie. MicroLogic Fun opens an additional 
movie window in which the video is run.

You can navigate using the Transport in MicroLogic Fun or in 
the movie window. The movie and song will be synced 
together, so that changing position in one will affect the other.

Transport Functions of the Scroll Bar
You can use the scroll bars below the movie field to move back 
and forth in the movie. MicroLogic Fun follows the movie 
running parallel to it.
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• The movie scroll bar allows you to quickly jump to different 
points in the video. Grab it with the mouse and drag it left or 
right.

The button to the left of the scroll bar is a Play/Pause switch:

• Click on the button to start the movie. The button changes 
into a “Pause” symbol. Click the button again to stop the 
movie.

• The buttons to the right of the Scroll bar move the picture 
forward or backward by one frame. Hold the mouse button, 
to fast forward or rewind.

Transport Functions of the Position Pointer

• Position displays the song position by measures.

• SMPTE shows the position in SMPTE format 
(hours:minutes:seconds;frames;bits),

MicroLogic Fun can not be synchronized via SMPTE or MTC, 
it only shows the Song Position in the SMPTE time format. 

• Start Movie shows the point at which the movie will start, 
relative to the song. You can, for example, start the movie 
after an introduction, beginning with Song Position 8.1.1.1.

You may directly enter position in any of the three displays:

1. Click-hold on a display value, and change it value by 
scrolling the mouse.

2. Double click on a display value, and enter the value in the 
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text input box. Separate values for different fields of the 
display with spaces.
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12.2 MIDI Files
MicroLogic Fun can save songs or parts thereof, in standard 
MIDI file format (SMF). Songs in this format can be loaded and 
played by almost all current sequencers, and by the Windows 
accessory “Media Player.”

Preparing a Song for MIDI File Conversion

This section describes the steps for converting MicroLogic 
sequences into the MIDI file format, using the Tutorial Song as 
an example.

The MIDI FILE format does not recognize MicroLogic 
sequences or playback parameters, but only continuous tracks. 

In order to be able to save the Tutorial Song as a MIDI file you 
must:

• neutralize all playback parameters by editing the data corre-
spondingly

• convert loops into real data 

• merge the sequences on each track into one continuous 
sequence, using the Glue tool.

Saving the Song as a MIDI File
To save a song as a MIDI file, go to the local menu of Arrange 
window; and select Edit > Select All. Next, select File > Export 
Selection as a MIDI File…

Saving Individual Sequences as a MIDI File

You can save individual sequence, or any groups of sequences 
as MIDI files, by selecting only the sequence(s) you wish to 
include before executing the “Export Selection…” command.
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Tip
Transfer Songs onto other Devices or Computers

Saving Songs as SMF Format 0
Standard MIDI Files may be saved in either of two formats, 
Format 0, or format 1. The typical Format is 1, where the file 
contains multiple tracks. Format 0 files store all data on one 
track.

It is necessary to save songs in Format 0, if you want to create 
songs for equipment that does not support Format 1.

MicroLogic Fun creates Format 1 files by default, unless you 
make the following setting:

1. In the menu bar, select Options > Settings > Global 
Preferencesl.

2. Enable ’ Export MIDI File…’ saves single sequences as For-
mat 0.

MicroLogic Fun can only create a Format 0 MIDI file from 
individual sequences. If you want to create a Format 0 file from 
multi track songs, you must first merge the sequences into one 
sequence, with the Glue tool.

Importing MIDI Files

With MicroLogic Fun, you can load MIDI files, play them, edit 
them, print them out as a score, save them again as a MIDI file, 
or save them as a MicroLogic song. To load a MIDI file, select 
File > Import. MIDI files are now displayed. Select one. It is 
then imported, and shown in the Arrange window.

12.3 Transfer Songs onto other 
Devices or Computers

Windows, Macintosh and Atari computers can read DOS-
formatted floppy disks. This also applies to some MIDI work-
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stations. You must bear the following in mind:
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• Many Atari computers and MIDI workstations do not accept 
high-density floppy disks; they only accept double-density 
floppy disks, with 720 KB storage capacity. Format the 
floppy disk on your Windows PC.

• Macintosh computers with older operating systems can only 
read DOS floppy disks with the aid of additional soft-
ware.Either use the system extension that comes with 
System 7.5 or higher, “PC Exchange”, which is available 
separately for older systems—or a utility such as 
“DosMounter”, or “AccessPC.”
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Use of Key 
Commands and 
Mouse, Settings

13.1 Keyboard Command 
Symbols

Windows Explanation Macintosh  

ç Control ç

— Command key C

A Alternate/Option key O

S Shift S

IMJK Cursor keys IMJK

R Return (on the 
alphanumeric keyboard)

R

‰ Enter (on the numeric key-
pad)

E

V Spacebar V

™ Escape ™

D Backspace/deletes to the 
left

D

∂ Delete/deletes to the right L

T Tab T

⁄ Insert —
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Û Pos1 (beginning of line) —

˙ End (end of line) —
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Chapter 13
Use of Key Commands and Mouse, Settings

13.2 Key Commands
You can program your own key commands in the Options > 
Settings > Key Commands window for all MicroLogic AV func-
tions (see the section Key Commands, starting on page 4 - 
100)xref.

Num Lock must be on for the key commands to work correctly. 

The assigned key commands are shown in the Key Commands 
window and also in the menu, next to a function’s name.

13.3 Using the Mouse
The described mouse operations apply to all MicroLogic AV 
windows, with the exception to the Transport window.

U Page up U

N Page down N

› Num Lock ›

∏ Pause —

@—˚ Function keys @—Ì

≠*_‰, 
=—)

Keys on the numeric 
keypad

≠*_E, 
=—)

0—9, a—z, 
,.–+# etc.

Normal keys 0—9, a—z, 
,.–+# etc.

Windows Macintosh 

Mouse Explanation Mouse

Click outside of an 
object + drag

Rubber band: Selects objects 
within the rubber band

Click outside of an 
object + drag

Windows Explanation Macintosh  
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13.4 Settings

Song Settings
Song settings are saved independently with each song, which 
means that different songs can have different song settings. You 
can save all of your standard settings in the Autoload Song, 
which is the default song file that is automatically loaded when 
you boot up MicroLogic (unless you’ve started the program by 
double-clicking on a specific song file, instead of the actual 
program icon). This way, you can start each MicroLogic session 
with your preferred working setup.

To open the Song Settings window, select Options > Settings > 
Recording Options… from the main menu.

ç drag Copies selected objects O drag

Right click on a 
menu

The menu remains open until 
you select a menu item.

Double-click on a 
menu

Windows Macintosh 

Mouse Explanation Mouse
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Click in Record Mode (e)

The metronome click is automatically switched on for record-
ing. This is the same as activating the metronome switch in the 
transport panel during the recording.

Click in Play Mode (p)

The metronome click is automatically switched on for play-
back. This is the same as activating the metronome button in 
the transport panel during playback.

Speaker Click

This sends the metronome click to the computer loudspeaker.

MIDI Click

The metronome click is sent out as a MIDI note.

Transmit MIDI Clock

This activates the transmission of MIDI clock for syncronizing 
other MIDI Sequencers.

Count In

This pull-down menu is where you set the count in that 
precedes a recording.

No count-in the recording begins with no count in.

1-4 Bar count-in1-4 bars of count in.

Global Preferences
Although the settings you make in the Preferences affect the 
way MicroLogic deals with all the songs it opens, you still have 
to open a song before you can alter the Preferences. Y ou can’t 
open the “MicroLogic.PRF” file directly.
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Watch Out!
Settings

Initializing the Preferences…
If you erase the “MicroLogic.PRF ” file in your PC’s Windows 
folder, MicroLogic will create a new Preferences file next time 
you launch. All parameters will then be reset to their default 
values.

When you erase the Preferences file, you also lose all your 
custom key commands.

This page is accessed via Options > Settings > Global Prefer-
ences

Wide Song Position Line

You can widen the song position line to make it easier to grab 
with the mouse. In addition, a wide SPL is more visible, espe-
cially against the stone background. 

’Export MIDI File…’ saves single Sequences as Format 0

If only one sequence is selected when you choose File > Export 
Selection as MIDI File… the contents of the sequence are 
saved in MIDI file format 0.This file format is guaranteed to be 
compatible with every MIDI file player.
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Enable Catch when Sequencer starts

This option enables the Catch function whenever the 
sequencer is put into Play mode.
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Add ’Last Edit Function’ to sequence name

After performing any edit operation (e.g. cutting), the descrip-
tion of the edit operation is added to the name of the arrange 
object (or resulting objects).

Disable safety alert for Undo

This means that no safety alert appears when you call up the 
undo function.

Language

Here you can select the interface language. Default language is 
the interface language of the operating system.
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Chapter 14

Menu Reference

14.1 Apple Menu
About MicroLogic AV opens the information box containing 

information on the program version and authors.

Upgrade Logic Upgrade Information.

14.2 File Menu
New creates a new, blank song and opens an Arrange 

window.

Open… opens a song from the hard disk, or floppy disk.

Close closes current song, after prompting to save.

Save saves the song to the hard disk or floppy disk.

Save As… saves the song with another name, and/or to 
another location.

Revert to Saved replaces the loaded song with the last saved 
version.

Import… loads a standard MIDI file.

Export Selection as a MIDI File… saves the song in standard 
MIDI file format (Windows extension: *.MID).

14.3 Edit Menu
Undo reverses the last command.
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Cut removes the selection from the active window, 
and places it in the Clipboard

Copy copies the selection to the Clipboard.
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Paste places the contents of the Clipboard at the inser-
tion point.

Clear deletes the selection from the active window.

Select All selects all objects in the active window.

14.4 Track Menu in the Arrange 
Window

Create inserts new track below the selected track.

Delete deletes the selected track.

14.5 Options Menu

Settings
Metronome Settings… opens a window used to configure the 

MIDI metronome.

Recording Options… opens Song Settings window, which 
includes the recording settings.

MIDI Interface Communication… opens the menu option 
MIDI/Global in the Preferences.

Global Preferences… opens the Global Preferences window.

Key Commands… opens the Key Command window.

Tempo
Tempo List Editor… opens the Tempo List Editor.

Others
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View Menu in the Sore Editor

Movie as Float… opens a dialog window for importing a 
movie to be opened as a floating window, which 
cannot be covered by other windows.

Movie Settings… opens the Settings for the movie.

Wave Player… opens the Wave Player, which can be used as 
a monophonic Sample Player for WAV files.

Open Keyboard Window… opens a virtual keyboard, which 
can trigger MIDI events with mouse clicks.

Send to MIDI
Maximum Volume sends controller 7 with a value of to all 

MIDI channels.

Reset Controllers resets all controllers to neutral positions 
(zero modulation, releases the sustain pedal, 
zero Pitch Bend, etc.).

In the Score Window
Diatonic Insert inserted notes are automatically forced to 

pitches within the current key.

Score Font… opens the window to select the font for text in 
the Score window.

14.6 View Menu in the Sore 
Editor

Toolbox toggles the Tool Box display on and off.

Parameters hides/Shows the Parameter Area. Hiding it can 
creats more room for the Arrangement field.

White Background displays a white background.
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14.7 Windows Menu
Open Arrange opens the Arrange window of the active song.

Open Event List opens the Event Editor for the selected 
object.

Open Score opens the Score Editor for the selected object.

Open Matrix Edit opens the Matrix Editor.

Open Transport opens the floating Transport window.

Open Mixer opens the Track Mixer.

Larger View increases the zoom.

Smaller View decreases the zoom.

Next Window brings the next window into the foreground.

Zoom Window sets the maximum size of the active windows 
to fit the screen.

Close Window closes active window.

Tile Windows arranges opened windows side by side.

Tile Windows Horizontally arranges opened windows hori-
zontally.

Stack Windows stacks opened windows.

14.8 Help Menu
Explanations On explanations can be displayed for most of 

the objects on the screen.

Help Contents opens the table of contents for online help.

Search Help searches for subjects or terms in the online help.

About MicroLogic AV opens the information box containing 
information on the program version and authors.
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Glossary

After Touch

A type of MIDI data generated by pressure applied to the 
keyboard after the initial depression of a key. This can control 
the vibrato or tone quality of the sound.

Arrange Window

Window in MicroLogic where tracks and sequences are 
displayed and edited.

Bar Ruler

Ruler in MicroLogic Fun windows, that displays the time 
axis—subdivided into measures.This is also where the Cycle 
and Autodrop zones are graphically displayed. Use the mouse 
to control different functions in M.L. (→Locators, →Song 
Position Line).

Catch Function

A mode that keeps the visible section of a window updated 
with the current song position.

Click

Another term for the metronome of a sequencer.

Control Change

Various types of MIDI data that add expressiveness to recorded 
music by controlling standard parameters such as volume, pan, 
portamento, etc.
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Count In

Programmable number of beats before recording actually starts.
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Cycle Mode

Mode in which MicroLogic Fun repeats the passage between 
the left and the right →Locator Position.

Delay

Setting that allows a track to be slipped forward or backward in 
time→Tick Steps.

Display Format Value

Subdivision of quarter notes in MicroLogic’s edit displays. This 
determines the layout of position displays, and the display 
quantization in the Score window, among other things.

Event

MIDI Event

Event List

Editor window in MicroLogic Fun in which events can be 
displayed as text, and edited.

Flip Menu

Also known as a Pop-Up or a Pull-down Menu. This is a list of 
entries that can be opened by clicking and holding the mouse 
button.

Font

File on the system that determines the shape and size of text 
characters. You can choose any font from the system when 
working with text in the Score Editor.

General MIDI

Standard for MIDI tone generators, which among other things, 
prescribes the minimum requirements for sounds, including 
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Emagic
MicroLogic Fun 

patch location, drum kits, and hardware requirements. GM-
compatible songs—like the Tutorial Song—can be played on 



1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

Gl

Ix
Glossary

any GM tone generator, without having to adjust any of the 
settings.

Key Command

Computer key, or combination of keys, used to control a 
function in MicroLogic Fun.

Link Mode

When engaged in an editor window, Link Mode assures that 
this window continually displays the contents of whatever 
sequence is currently selected.

Locator

Position markers in the song that enclose a section (Cycle, 
Autodrop)

Local Menu

Menu within a window, whose influence is limited to that 
specific window.

Loop

Repetition of a sequence within a track.

Matrix Editor

Editor window in MicroLogic Fun, which displays notes as 
horizontal bars. Pitch is determined by the vertical position of 
the note, duration by its length.

Merge

In MicroLogic Fun, the merge function is carried out via the 
Glue tool, which merges all of the selected sequences together.

Meta Events
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A type of event found in the Event List, which represents non-
MIDI events (text in the Note Editor).
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MIDI-Clock

A MIDI synchronization event, which is sent from a generator 
every 1/96 note and advances any slave devices 
correspondingly.

MIDI Driver

Software drivers that control communication between the 
computer and MIDI Interface.

MIDI Event

A complete MIDI Event consists of a status bytes and, if 
needed, one or two data bytes.

MIDI Interface

Device that transfers data between the computer and attached 
MIDI instruments.

Mixed Quantization

A form of quantization, which combines binary and triplet 
values—such as a 1/16 and a 1/24 note.

Path

Folder on a hard drive where a file is stored.

Pitch Bend

MIDI Event type that varies the pitch of notes on a 
channel.Synthesizers typically generate Pitch Bend using a 
wheel or joystick.

Play Parameter

Track parameter that influences the output of the →MIDI 
Events during playback, but does not destructively affect the 
data.
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Quantization

Rhythmic correction of notes in MicroLogic. The time 
positions of the notes are recalculated according to a selectable 
grid. As a result, the timing is perfected.

Score Editor

A MicroLogic window, in which the events, sequences, and 
songs can be displayed as notation, edited, and printed.

Scroll Bar

Bars on the side of a window (in Windows) with a small box 
(Scroll box). To move to another part of the window, drag the 
scroll box with the mouse, or click in the Scroll bar.

Scrub Function

Back and forth movement of the “recording head”. In this case, 
use the mouse to move the →Song Position Line to listen to the 
MIDI events.

Select

Selected objects are displayed in reverse color.

Sequence

Container for MIDI events in MicroLogic that are be displayed 
as horizontal bars in the Arrange window.

Solo tool

Enables the user to listen to an individual track or sequence.

Song Position Line

Vertical line in the Arrange window, Sample editor, Matrix 
Editor andScore editor that displays the current Song Position, 
and can be dragged with the mouse to change position in the 
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Song Position Pointer

This is a MIDI event that indicates the current position in the 
song, calculated from the beginning of the song in sixteenth 
note increments. Song Position Pointer is used along with 
MIDI Clock for synchronization.

Standard MIDI File

A standard file format that allows MIDI songs to be loaded into 
almost any MIDI program, on any computer platform..

Status

The first byte in a MIDI event, displayed in the S column of 
the Event List.

Style

Setting in the Score window that sets the basic score display for 
a sequence, including clef, display transposition, number of 
staves.

Synchronization

Means by which several devices can be run together “in sync”. 
One device acts as the “Clock Master” sending a sync signal, 
such as MIDI Clock, to the other “Slave” devices, which follow 
the clock signal.

Synchronizer

Device used to convert various synchronization formats; it 
monitors and manages the synchronization of various devices 
centrally.

Toggle

Computer jargon for switching back and forth.
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TrueType Fonts

Freely scaleable fonts that can be installed into your system 
and can be used in MicroLogic Fun for the Score Text. These 
have the advantage that they will be displayed the same on the 
computer screen as they will print.

User Interface

All control elements and functions of a piece of softwar, or of a 
device

Velocity

The force with which a note is struck on a keyboard, or 
controller. It is represented by the second data byte (Val) in the 
Event List. Velocity may have a range of 0-127.

Virtual Memory

Storage space on the hard disk, which is used by Windows as a 
“swap file” to enlarge RAM capacity. 

WAV Files

File format for sound files on a Windows PC. WAV files can be 
recorded in various formats (8bit, 16bit, Stereo/Mono,) and 
various sample rates, such as 22 kHz or 44.1 kHz.

Wave Player

Feature that allows sound files in the computer to be triggered 
with MIDI Notes.

Windows

Commonly used operating system for PC compatible 
computers. It offers a graphical user interface.

Zoom
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Optional magnification or reduction of the contents in a 
MicroLogic window.
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A
About MicroLogic AV 15
About This Manual 20
Absolute Value Alteration 126
Adjusting the Sound card 21
Aftertouch Event 131
All channel track 95
Altering Relative Values flexibly 126
Altering Values

absolutely 126
numerically 126
of events 125
relatively 125

Appending a new track 97
Apple QuickTime™

video file format for Macintosh 174
Arithmetical Operations 58
Arrange

inserting events 104
Arrange window

creating a track in 97
deleting a track in 98
layout of 93
moving a track in 97
mute button 98
send maximum volume 111
send Rest controllers 111
tools 94
Track List 94

Arrange window functions
Set Optimal Object Sizes 104

ASCII Input 58
Atari

floppy disk formats recognized by 
177

Autoload 76
Autoload song 27
Automatic Scrolling 67

B
Bank Select 96
Bar Ruler

shuttling on 89
Song Position Line 89
start or stop from 89

C
Catch 67, 71

Enable when SPL is moved 183
switching off automatically 67
switching on automatically 67

Catch mode 38
Changing Display Levels 72
Changing Values

algebraic input 58
Check for MTP 25
Checkboxes 56
Checking 56
Clear 71
Click 182
Clicking 56
Clicking and Holding 56
Clicking On 56
Clipboard 70
Clock tick 81
Content Catch 163
Content Linked 163
Continue 85
Control Change Event 130
Control Output Via MIDI 71
Controller 116
Copy 70
Copying

~ Sequences 99
Cut 70
Cycle

setting locators 90
setting on the Transport window 

81
tutorial 38
zone displayed in Bar Ruler 90

Cycle mode 86
activation of 90
configuration of and uses for 90

Cycle zone
selecting all sequences within 98
setting on the Bar Ruler 88
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cycle diplayed in 90
jump to a position 89
setting Cycle zone on 88
setting the start and end point of the 

song on 87, 88

D
Damaged Song 77



Index

Default Song 76
Delay 107
Delete

and select next object 71
Deselect

all 69
Dialog Boxes 66
Diatonic Insert 148
Disable safety alert for Undo 69
Display Format 101
Display Format value

setting on Transport window 81
Display Parameter Box 157
Display Quantization 159, 160
displayed on the Transport window 82
Double-clicking 56
Dragging 56

E
Edit

MIDI Output 71
Edit Operations 69

clear 71
copy 70
cut 70
paste 70
undo 69

Editor
Event-List 121
Matrix Editor 133
Matrix editor 133
Score Editor Window 139

Enable Catch when Sequencer starts 67
End of song

setting on the Bar Ruler 87, 88
End of song marker

on Transport window 84
Enlarging A Section 64
Enlarging One Part Of The Screen 64
Entering Numbers 57
Eraser 61
Event

poly pressure event 131
Event List

display 122

quantization of events 125
scrolling 123
selecting events 123
special mouse selection techniques 

123
Status column 123

Event Parameter Box 155
Events

adding 124
aftertouch event 131
altering values 125
control change event 130
data byte 127
deleting 71
duplicating 124
inserting 104
length/Info 127
MIDI channel 127
moving 125
note event 128
pasting from the clipboard 125
pitch bend event 130
position 126
position and length in SMPTE units 

127
program change event 129
relative positions 127
types 128

Exchanging songs between a Mac and a PC 
29

F
Fast Forward 85
Fast Speed

setting for MIDI Time Piece 25
File Extensions 23

types of files recognized by 
MicroLogic 23

File Management
Extensions 23

Find 75
Fix Quantize 109
Follow Song (Catch) 67
Free Memory

displayed on the Transport window 
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opening 121
overview of controls 122

82
reorganizing on Transport Window 

83
Full Panic
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activated from Transport window 
84

G
General MIDI

Tone Generator 31
Global Preferences 25
Glossary 189
Glue Tool 61
GM-Mixer

Program 115
Grabbing 56
GS 118
GS Standard 18

H
Hide Unused 75
Hide Used 75
Horizontal Selection 68
HyperDraw

in the Matrix, Score 137

I
Icon

assigning to a track 96
Identical Objects 69
Info Line 146
Installation 21
Instruments

pan 96
program changes 96
setting banks 96
volume 96

K
Key Commands 72

assigning 74
checking 74
concealing 75
defining your own 29

Key Signatures 149
Keyboard

Macintosh 28

L
Launching MicroLogic AV

in Windows 21
in Windows automatically 24
in Windows from a shortcut 24
in Windows from the Start button 

23
on the Macintosh 24
on the Macintosh automatically 27
on the Macintosh with an Autoload 

Song 27
Learn Key 74
Locators 81

selecting all sequences inside 98
setting by objects 71
setting cycle zone 90
setting on the Transport window 

81
Loops 105

stopping loops 106
LSO files 23

M
Macintosh

floppy disk formats recognized by 
177

keyboard tips 28
using the mouse 28

Magnifying Glass 61
Matrix

HyperDraw 137
Matrix Editor 133

changing note lengths 136
changing velocity 137
copying notes 136
creating notes 135
deleting notes 137
duplicating notes 135
moving notes 135
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deleting 74
finding 75
reference list 179
special keys 73
window 73

note display 134
opening 133
selecting notes 137

Maximum volume
sending from Arrange window 111
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Measure position
display of on Transport window 80

Memory reconfigure 83
Metronome 86, 182

setting MIDI parameters 86
MID files 23
MIDI

Check For MTP 25
Click 86
connection on a Macintosh 24
file Standard 23
indicator in Transport 22
Interface Communication window 

(Macintosh) 25
interface with multi client driver 

23
MIDI File Conversion 176
MIDI Time Piece support of 25
MIDI-Out

testing (Macintosh) 26
Out port selection 21
Out switch 71
testing connections 22
testing the connection on the 

Macintosh 26
testing the output in Windows 22

MIDI channel
assigning to a track 95

MIDI Commands
deleting 74

MIDI File 176
MIDI indicator

on Transport window 83
MIDI Interface

Selection of 21
MIDI Metronome

settings 86
MIDI Port 25
MIDI recording 45
MIDI Remote Control

switching on/off 74
MIDI Reset

from Transport window 84
Full Panic 84

MIDI Time Piece
Fast Speed 25

Mixed quantization 110

on Transport window 86
Modem port

selecting for MIDI 25
Mouse 56

as slider 57
Mouse Pointer 60
Moving 56
Multi Client MIDI drivers 23
Multimedia 19
Multitasking with other programs 23
Mute 103, 116
Mute Tool 61
Muting of Tracks 98

N
Names

inputting 58
with numbers 58

New Song 76
No Output track 95
Notation 139

Adapting MIDI Sequences 164
Default Settings (for sequences) 

157
Diatonic input 148
Display Options 144
Display Parameter Box 157
Display Quantization 159
Event Parameter Box 155
Explode Polyphony 140
Full Score Display 163
General Concept 142
hor.pos 155
Key Signatures 149
Muted Objects 164
Page View 140
Partbox 147
Printout 166
Qua 159
Rests 149
Rhythmic Display Options 157
Rhythmic Interpretation 158
Score Styles 144
stave distance 162
Text Styles 151
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basic expalnation of 119
how to automate a mix 119

Mode Buttons

Ties 148
Time Signatures 150
Triplets 160
vert.pos 155
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Note Events 128
Notes

changing lengths 136
changing velocity 137
copying 135, 136
creating 135
deleting 137
moving 135

Num 127
Numbered Names 103
Numerical Input 57
Numerical Value Input 126

O
Odd tuplets

quantizing to 110
Open 76
Option

turning on/off 56

P
Page Up/Down/Left/Right 64
Page View 140
Pan

inserting events 96
Panic Function 84
Panic function 111
Partbox 147
Paste 70

at original position 71
replace 71

Pause 85
Pencil 60
Pitch Bend

event 130
Play 85
Pointer 60
Poly Pressure Event 131
Position

jump to on the Bar Ruler 89
Position Indicators

on Transport window 80
Position Markers 81

Print
tutorial 52

Printer port
selecting for MIDI 25

Printout 166
Program Change

event 129
inserting events 96
variable program change - inserting 

130
Program Change Messages 96
Pull-down menus 56

holding open 57

Q
Qua (Display Quantization) 160
Quantization

explanation of 108
Fix Quantize 109
mixed quantization 110
operation of 108
quantization to odd tuplets 110
sequence parameters 105
setting the value of 108
standard quantization 109
Swing Quantization 110

Quantization of events
in the Event List 125

Quit 77
Quitting the Program 77

R
Record button 85
Recording

from current position 85
Replace mode 86
tutorial 45

Relative Value Alteration 125
Replace mode 86
Reset

Panic 111
Reset controllers

sending from the Arrange window 
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Preferences

communication 182
Global 184
initialising 183

111
Rest Display 149
Rewind 85
Rubber-banding 69
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S
Save 77
Save as… 77
Saving

Tutorial song 47
Scissors 61
Score

HyperDraw 137
Score Display Options 144, 157
Score editor

Arrange level display 52
Display Parameter box 52
Score style 52

Score Layout
Settings Overview 144

Score Printout 166
Score Styles 144, 161

assigning~ 162
Score Window 139

Diatonic Insert 148
Display Parameter Box 157
Editing 155
Elements 140
Event Parameter Box 155
General Appearance 140
Info Line 145, 146, 153
Input Methods 144
Insert Quantization 147, 154
Mouse Input 146
Move, Copy and Paste 152
Open Window 139
Partbox 147
Positioning Grid 153
Real Time Recording 145
View menu 140
VIEW-Menu 140

Scroll Bars 63
Scroll to

selected event 71
SPL 71

Scrolling 64
Selecting

“rubber-banding” 69
all objects 69
alphabetically 68
horizontally 68

Selection 68
assigning an icon to a track 96
toggling 69

Sequence
automatic naming 184
Change dynamics of ~s 107
changing the length of 100
copying 99
creating an empty sequence 99
definition of 99
looping 105
moving along the time axis 99
naming multiple 103
Optimize length of a ~ 104
saving as a MIDI file 176
selecting all in a track 98
selecting inside Locators 98
soloing sequences 103

Sequence Parameter box
MIDITHRU 46

Sequence parameters
delay 107
loop 105
MIDI THRU 104
quantize 105
transpose 106

Sequencer Positions as List 128
Sequences

creating events with clipboard events 
104

cutting 101
cutting at the SPL 102
cutting several times 102
finer grid 101
inserting events 104
joining and mixing 102
multiple naming 103
muting 103
naming 103
transposition of 106

Set Optimal Object Sizes 104
Setting Pan 96
Setting Volume 96
Shortcut

creating to MicroLogic AV program 
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of the window elements 65
Slider Input 57
SMF 176
Solo

tool 103
Solo Tool 61
Song

autoload song 76
default song 76
loading 76
loading MicroLogic songs on other 

systems 177
new 76
preparing a song for MIDI file 

conversion 176
saving as a Format 0 MIDI file 177
saving as a MIDI file 176

Song Position
following automatically (Catch) 67

Song position
tutorial 38

Song Position Line
on Bar Ruler 89

Song Settings 181
Songs

checking/repairing 77
importing settings 77
storing 77

SPL
always visible 67
positioning in the score 145

Standard MIDI file 23
file extension of 23
Format 0 177
importing 177
overview of 176
preparing a MicroLogic song to be 

converted to 176
saving a single sequence as 176
saving a song as 176

Start of song
setting on the Bar Ruler 87, 88

Start or stop
from the Bar Ruler 89

Starting up
on the Macintosh 24

Swing quantization 110

T
Telescopes 64
Tempo

setting on the Transport window 
82

Tempo event
inserting in the Tempo List 82

Tempo List
inserting a tempo event 82
opening 82

Text
Copy~ 152
Edit~ 152

Text Input 58
Text Mark 61
Ties 148
Time signature

setting on the Transport window 
83

Time Signatures 150
Toolbox

tutorial 42
Toolbox (see Tools) 59
Tools 60

effective range 59
eraser 61
glue tool 61
in Arrange window 94
magnifying glass 61
moving to the next 59
mute tool 61
pencil 60
pointer 60
scissors 61
solo tool 61
text mark 61
two at once 59

Track
"All" channel track 95
"No Output" track 95
appending to end of list 97
assigning a MIDI channel 95
Assigning an Icon 96
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Stave Distance 162
Stop 85
Style

tutorial 52
Swing Notation 161

creating 97
deleting 98
deleting contents of 98
MIDI-Channel 95
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moving 97
muting 98
selecting all sequences in 98

Track List
in Arrange window 94

Transport
MIDI monitor 22

Transport window 79
Cycle button 86
cycle button 39
display of free memory on 82
display of free memoryFree memory 

82
display of measure position 80
display options 79
End of song marker 84
Fast Forward 85
floating window 79
layout of 79
Metronome button 86
MIDI Indicator 83
MIDI reset 84
Mode buttons 86
opening (Macintosh) 26
Pause 85
Play 85
position fields and indicators 80
position indicators 80
position slider 80
Record button 85
reorganizing free memory 83
Replace button 86
Rewind 85
setting Display Format value on 81
setting the Cycle zone on 81
setting the Locators on 81
setting the size of 80
setting the tempo on 82
setting the time signature on 83
Stop 85

Transpose 106
Transposing 106

sequences 106
Transposition

tutorial 44
Triplet Notation 160

copies of sequences 43
copying sequences 43
cycle mode 38
dividing sequences 44
entering text in Score 52
GM tone generators 32
inserting Program Changes in the 

Event List 48
launching in Windows 31
loops 41
loops (sequences) 41
MIDI THRU 46
mute program change control 

sequence 32
Non GM tone generators configuring 

for 32
print 52
printing the Score 52
quantization 40
quantizing 40
recording MIDI 45
Saving the song 47
Sequence parameter box 40
song position 38
sounds and MIDI channels used in 

33
start song position 37
starting the song 34
Text input 52
toolbox 42
transposition of sequences 44
undo 43

U
Undo 43, 69

tutorial 43
Unused Blocks 77
Use 19
user interface 19

V
V Tool 137
Val 127
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Tutorial Song 31
Arrange level display in Score 52
Arrange window 35

Variable Program Change 130
Velocity 107

tool 137
Velocity offset 107

Sequence parameters 107
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Video
Apple QuickTime files 174
transport functions on the Macintosh 
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Video file

opening 173, 174
View menu 140
Volume 116

inserting events 96

W
Wave Player 18

assigning a sound file to a MIDI note 
169

deleting wave files in 170
editing events 171
functions of 167
opening window 168
overview of use 167
resetting parameter values 168
setting the view parameters of 169
storing files to be triggered by 172
triggering audio files with MIDI 

notes 171
wave display 169

Window 19
Event-List 121
Matrix Editor-Window 133

Windows
autocatch 67
catch 67
changing the elements present 65
floating windows 79
functions 62
Key Commands 73
Matrix editor window 133
maximizing 63
opening 62
relationships between 67
scrolling 64
selecting the working area 63
selective zoom 64
size 63
types 66
zooming 64

X
X/Y Element 64
XG 118
XG Standard 18

Z
Zoom 64

selective 64
vertical/horizontal 64
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